Introduction

Thank you for purchasing SoftBank 922SH.

® For proper handset use, read this guide beforehand.

® Keep this guide in a convenient place for reference.

® Accessible SoftBank services may vary by service area, subscription, etc.

SoftBank 922SH is compatible with both 3G and GSM network technologies.

Notes

® Copying this guide in whole or part without authorization is prohibited.

® Guide content is subject to change without prior notice.

e Efforts have been made to ensure the accuracy and clarity of this guide. Please contact
Customer Service, General Information (P.14-36) about unclear or missing information.
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Guide Usage Notes

Notes
o

Most operation descriptions are based on default settings with

handset open (P.1-2) in Standby (P.1-11).

Operations and results may differ by handset status.

Sample screenshots, etc. are provided for reference only.

Actual handset windows, menus, etc. may differ in appearance.

®"(Japanese)" appears next to functions or applications which require
Japanese ability to use as intended.
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Accessories
H Battery (SHBBG1) M Headphones (with Microphone) (Black, SHLBG1)

M USB Cable M Utility Software (Japanese)’

<

® For accessory-related information, please contact SoftBank Customer Center, General Information (P.14-36).
® Use specified Charger (sold separately) only.

® |n this guide, Headphones (with Microphone) is referred to as "Headphones."
® Utility Software is designed exclusively for 922SH. Download newest versions via SOFTBANK MOBILE Corp. Website (P.14-19).

‘Complimentary sample.



® Read safety precautions before using handset.

® Observe precautions to avoid injury to self or others, or damage to property.
® SoftBank is not liable for any damages resulting from use of this product.

Before Using Handset

H Symbols
Make sure you thoroughly understand these symbols before reading on. Symbols and their meanings are described below:

& DANG ER Great risk of death or serious injury from improper use
& WARN I NG Risk of death or serious injury from improper use
A CAUTION Risk of injury or damage to property from improper use

O00A® O A

Prohibited Actions Compulsory Actions Attention Required




A DANGER A WARNING

Handset, Battery & Charger

Handset, Battery & Charger

Use specified battery and Charger
only (P.v, P.1-10).

Non-specified equipment use may cause
malfunctions, electric shock or fire due to
battery leakage, overheating or bursting.

Do not insert foreign objects into the
handset or Charger.

Do not insert metal or flammable objects
into handset or Charger; may cause fire or
electric shock. Keep out of children's reach.

%)

Do not short-circuit Charging
Terminals.

Keep metal objects away from Charging
Terminals. Keep handset away from jewelry.
Battery may leak, overheat, burst or ignite
causing injury. Use a case to carry battery.

Battery

Prevent injury from battery leakage,

breakage or fire. Do not:

® Heat or dispose of battery in fire

® Open/modify/disassemble battery

® Damage or solder battery

® Use a damaged or warped battery

® Use non-specified charger (P.1-10)

® Force battery into handset

® Charge battery near fire or sources of
heat; or expose it to extreme heat

® Use battery for other equipment

N

If battery fluid gets in eyes, do not
rub; rinse with water and consult a
doctor immediately.

Eyes may be severely damaged.

o

Keep handset out of rain or extreme
humidity.
Fire or electric shock may result.

Keep handset away from liquid-filled
containers.

Keep the handset and Charger away from
chemicals or liquids; fire or electric shock
may result.

Do not place battery or handset in
ovens, microwave ovens, etc.

Battery or other parts may leak, burst,
overheat or ignite; may cause malfunction,
accident or injury.

Do not disassemble or modify

handset or related hardware.

® Do not open handset or Charger; may
cause electric shock or injury. Contact
SoftBank Customer Center, Customer
Assistance for repairs.

® Do not modify handset or Charger; fire or
electric shock may result.

B O e

: Safety Precautions

I_

faces.

Eyesight may be temporarily affected
leading to accidents.
CAUTION:

Use of controls,
adjustments or
performance of procedure
other than those specified
herein may result in
hazardous radiation exposure. As the
emission level from Mobile Light LED used
in this product is harmful to the eyes, do not
attempt to disassemble the cabinet.
Servicing is limited to qualified servicing
station only.

Do not use Mobile Light near people's ®

EN60825-1:1994 A1:2002 & A2:2001

CLASS 1
LED Product

Mobile Light

CAUTION-CLASS 1M
LED RADIATION WHEN OPEN
DO NOT VIEW DIRECTLY WITH
OPTICAL INSTRUMENTS

H Mobile Light LED Properties
a) Emission Duration: Continuous
b) Wavelength
White: 400 - 700 nm
¢) Maximum Emission Output
White: 210 u W (1.2 mW inside handset)

Vii
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If an abnormality occurs, or water/
foreign matter is inside handset:

If handset emits an unusual sound, smoke
or odor, or if water or foreign matter is inside
it, discontinue use; may cause fire or electric
shock. Turn off handset, remove battery and
unplug AC Charger; contact SoftBank
Customer Center, Customer Assistance.

€

Keep handset off and Charger
disconnected near gas stations or
places with fire/explosion risk.
Handset use near petrochemicals or
other flammables may cause fire/
explosion.

Do not subject handset or Charger to

strong shocks or impacts.

® Avoid strong shocks to AC Charger while
itis plugged into the outlet; may cause
malfunction or injury.

® Strong shocks or impacts to handset or
Charger may cause malfunction or injury.
Should handset be damaged, remove
battery then contact SoftBank Customer
Center, Customer Assistance.
Discontinue handset use; may cause fire,
electric shock or injury.

Handset

Charger

Take measures to prevent accidents.

® Do not use handset (including TV) while
driving; park beforehand. Phone use
while driving is prohibited by the Road
Traffic Law (revised November 1, 2004).

® Do not use Headphones while driving or
cycling. Accidents may result.

® Moderate volume outside, especially near
road/rail crossings, etc. to avoid accidents.

O

Do not swing handset by
Headphones or strap.
May result in injury or breakage.

Turn handset power off before
boarding aircraft.

Using wireless devices aboard aircraft may
cause electronic malfunctions or endanger
aircraft operation.

Do not remove protective film.

Display is protected with safety film;
removing/damaging film may cause injury in
case of Display breakage.

Adjust vibration and ringtone
settings:

Users with a heart condition/pacemaker/
defibrillator should adjust handset settings
accordingly.

During thunderstorms, turn power
off; find cover.

There is a risk of lightning strike or electric
shock.

e & 9 Q0

Use only the specified voltage.
Non-specified voltages may cause fire or
electric shock.
® AC Charger: AC 100V-240V Input
= SoftBank is not liable for problems resulting from
charging battery abroad.

%)

Do not use power adapters.

Using AC Charger with step-up/step-down
transformer may cause fire, electric shock
or damage.

Charger care

® Do not touch with wet hands. Electric
shock may occur.

® Pull AC Charger straight out to unplug it;
may cause malfunction or injury.

® Do not use multiple cords in one outlet;
may cause excess heat/fire.

® Do not bend, twist, pull or set objects on
cord. Exposed wire may cause fire or
electric shock.

Do not short-circuit Charger
terminals.

May cause overheating, fire or electric
shock. Keep metal away from terminals.

Damaged AC Charger cord:
May cause fire or electric shock; discontinue
use and purchase a new Charger.

During thunderstorms:
Unplug AC Charger to avoid damage, fire or
electric shock.

Charger use and children:
May cause electric shock/injury; keep out of
reach.

VS O B O



Battery

Handset Use & Electronic Medical Equipment

® |f battery does not charge properly, stop
trying. Battery may overheat, burst or
ignite.

® At signs of a battery leak, avoid fire
sources. It may catch fire or burst.

o

If there is abnormal odor, excessive heat,
discoloration or distortion, remove battery
from handset.

It may leak, overheat or explode.

o

This section is based on "Guidelines on the Use of
Radio Communications Equipment such as Cellular
Telephones and Safeguards for Electronic Medical
Equipment" (Electromagnetic Compatibility
Conference, April 1997) and "Report of Investigation
of the Effects of Radio Waves on Medical
Equipment, etc." (Association of Radio Industries

Persons with implanted pacemaker/
defibrillator should keep handset
more than 22 cm away.

Radio waves can interfere with implanted
pacemakers or defibrillators causing such
devices to malfunction.

and Businesses, March 2001).

Turn handset off in crowds or trains
where persons with implanted
pacemaker/defibrillator may be near.
Radio waves can interfere with implanted
pacemakers or defibrillators causing such
devices to malfunction.

o

Observe these rules inside medical

facilities:

@ Do not enter an operating room or an
Intensive or Coronary Care Unit while
carrying a handset.

® Keep handset off in hospitals, including
lobbies.

® Obey medical facility rules on mobile
phone use.

o

Consult electronic medical equipment
vendor on radio wave effects.

: Safety Precautions

A CAUTION

Handset, Battery & Charger

Handset care

® Place handset on stable surfaces to avoid A
malfunction or injury.

® Keep handset away from oily smoke or
steam. Fire or accidents may result.

® Cold air from air conditioners may
condense, resulting in leakage or burnout.

® Keep handset away from heat/direct
sunlight (e.g., inside vehicles, etc.).
Warping, discoloration or fire may occur.
Battery shape may be affected.

® Keep handset out of extremely cold
places to avoid malfunction or accidents.

® Keep handset away from fire sources to
avoid malfunction or accidents.

Usage environment

® Excessive dust may prevent heat release A
and cause burnout or fire.

® Avoid using handset on the beach. Sand
may cause malfunction or accidents.

® Keep handset away from credit cards,
telephone cards, etc. to avoid data loss.
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Safety Precautions

Handset

Charger

Battery

Handset temperature

Handset may become hot while in use.
Avoid prolonged contact with skin,
especially at high temperature. May cause
burn injuries.

A\

Avoid leaving handset in extreme
heat (inside vehicles, etc.).
Hot handset may lead to burn injuries.

Volume settings
Moderate handset volume; excessive
volume may damage ears or hearing.

Headphones

® Do not force plugs or pull on cord; may
damage plugs or cord.

® Keep plugs clean to avoid noise and
malfunction.

Inside vehicles
Handset use may cause electronic
equipment to malfunction.

If you experience any skin irritation
associated with handset use,
discontinue handset use and consult
a doctor.

Metal and other materials (P.14-16) may
cause skin irritation, rashes, or itchiness
depending on your physical condition.

e bIPOo

AC Charger cord

® Grasp plug (not cord) to disconnect AC
Charger. May cause fire/electric shock.

® Keep cord away from heaters. Exposed
wire may cause fire or electric shock.

® Stop use if plug is hot or improperly
connected. May cause fire/electric shock.

Always charge handset in a
well-ventilated area.

Avoid covering/wrapping Charger; may
cause damageffire.

During periods of disuse
Always unplug AC Charger after use.

Handset maintenance
Always disconnect AC Charger when
cleaning handset.

aAa O O

Do not throw or abuse battery. Battery may
overheat, burst or ignite.

Do not leave battery in direct sunlight or
inside a closed vehicle; may reduce battery
performance or overheat. An overheated
battery may cause fire.

Do not expose battery to liquids.
Performance may deteriorate.

with clean water immediately.

Do not dispose of an exhausted battery with
ordinary refuse; always tape over battery
terminals before disposal. Take battery to a
SoftBank Shop, or follow the local disposal
regulations.

Keep battery out of children's reach.

® Charge battery in ambient temperatures
between 5°C and 35°C; outside this
range, battery may leak/overheat and
performance may deteriorate.

® |f your child is using handset, explain all
instructions and supervise usage.

® |f there is abnormal odor or excessive
heat, stop using battery and call SoftBank
Customer Center, Customer Assistance.

® Charge battery at least once every
six months; an uncharged battery may
become unusable.

If battery fluid contacts skin or clothes, rinse 0
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General Notes

General Use

® SoftBank is not liable for any damages resulting
from accidental loss/alteration of handset or
Memory Card data. Keep a copy of Phone Book
entries, etc. in a separate place.

® Handset transmissions may be disrupted inside
buildings, tunnels or underground, or when
moving into/out of such places.

® Use handset without disturbing others.

® Handsets are radios as stipulated by the Radio
Law. Under the Radio Law, handsets must be
submitted for inspection upon request.

©® Handset use near landlines, TVs or radios may
cause interference.

© Beware of eavesdropping.
Because this service is completely digital, the

possibility of signal interception is greatly reduced.

However, some transmissions may be overheard.
Eavesdropping

Deliberate/accidental interception of
communications constitutes eavesdropping.

Inside Vehicles

® Never use handset while driving.

® Do not park illegally to use handset.

® Handset use may affect a vehicle's electronic
equipment.

Aboard Aircraft

Never use handset aboard aircraft (keep power off).
Handset use may impair aircraft operation.

Handset Care

® |f handset is left with no battery or an exhausted
one, data may be altered/lost. SoftBank is not
liable for any resulting damages.

® Use handset between 5°C - 35°C (35% - 85%
humidity).

® Avoid extreme temperatures and direct sunlight.

® Exposing lens to direct sunlight may damage color
filter and affect image color.

® Clean handset with dry, soft cloth. Using alcohol,
thinner, etc. may damage it.

® Avoid scratching handset Display.

® When closing handset, keep straps, etc. outside to
avoid damaging the Display.

® Function Usage Limits
These functions are disabled after handset
upgrade/replacement or service cancellation:
Camera; Media Player; S! Applications; TV.
After a period of disuse, these functions may be
unusable; retrieve Network Information (P.13-18)
to restore usability.

® Handset is not water-proof. Avoid exposure to
liquids and high humidity (e.g., precipitation,
perspiration, beach, cold air from air conditioning,
restroom, bath/shower room, etc.).

® Avoid heavy objects or excessive pressure. May
cause malfunction or injury.
® Do not sit on handset in back pants pocket.
= Do not place heavy objects on handset inside

handbags, packs, etc.

® Connect only specified products to Headphone
Port. Other devices may malfunction or cause
damage.

® Always turn off handset before removing battery.

Xi
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Electromagnetic Waves

For body-worn operation, this phone has been
tested and meets RF exposure guidelines when
used with accessories containing no metal, that
position handset a minimum of 15 mm from the
body. Use of other accessories may not ensure
compliance with RF exposure guidelines.

FCC Notice

® This device complies with part 15 of the FCC
Rules. Operation is subject to the following two
conditions:
(1) This device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

® Changes or modifications not expressly approved
by the manufacturer responsible for compliance
could void the user's authority to operate the
equipment.

FCC RF Exposure Information

Your handset is a radio transmitter and receiver. It is
designed and manufactured not to exceed the
emission limits for exposure to radio frequency (RF)
energy set by the Federal Communications
Commission of the U.S. Government.

The guidelines are based on standards that were
developed by independent scientific organizations
through periodic and thorough evaluation of
scientific studies. The standards include a
substantial safety margin designed to assure the
safety of all persons, regardless of age and health.
The exposure standard for wireless handsets
employs a unit of measurement known as the
Specific Absorption Rate, or SAR. The SAR limit set
by the FCC is 1.6 W/ke.

Highest SAR value:

Model FCCID At the Ear | On the Body

922SH | APYHR0O00063 | 0.471 W/kg | 0.598 W/kg

This device was tested for typical body-worn
operations with the back of the handset kept 1.5 cm
from the body. To maintain compliance with FCC RF
exposure requirements, use accessories that
maintain a 1.5 cm separation distance between the
user's body and the back of the handset. The use of
beltclips, holsters and similar accessories should not
contain metallic components in its assembly.

The use of accessories that do not satisfy these
requirements may not comply with FCC RF
exposure requirements, and should be avoided.
The FCC has granted an Equipment Authorization
for this model handset with all reported SAR levels
evaluated as in compliance with the FCC RF
emission guidelines. SAR information on this model
handset is on file with the FCC and can be found
under the Display Grant section of
http://www.fcc.gov/oet/fccid after searching on the
corresponding FCC ID (see table above).

Additional information on Specific Absorption Rates
(SAR) can be found on the Cellular
Telecommunications & Internet Association (CTIA)
Website at http://www.phonefacts.net.

European RF Exposure Information

Your mobile device is a radio transmitter and
receiver. |t is designed not to exceed the limits for
exposure to radio waves recommended by
international guidelines. These guidelines were
developed by the independent scientific organization
ICNIRP and include safety margins designed to
assure the protection of all persons, regardless of
age and health.

The guidelines use a unit of measurement known as
the Specific Absorption Rate, or SAR. The SAR limit
for mobile devices is 2 W/ke.

As mobile devices offer a range of functions, they
can be used in other positions, such as on the body
as described in this user guide’.

Highest SAR value:

Model At the Ear” On the Body

922SH 0.510 W/ke 0.462 W/ke

As SAR is measured utilizing the device's highest
transmitting power the actual SAR of this device
while operating is typically below that indicated
above. This is due to automatic changes to the
power level of the device to ensure it only uses the
minimum level required to reach the Network.

The World Health Organization has stated that
present scientific information does not indicate the
need for any special precautions for the use of
mobile devices. They note that if you want to reduce
your exposure then you can do so by limiting the
length of calls or using a handsfree device to keep
the mobile phone away from the head and body.

‘Please see Electromagnetic Waves on the left for
important notes regarding body-worn operation.
“Measured in accordance with international
guidelines for testing.

Declaration of Conformity

C€0168

Hereby, Sharp Telecommunications of Europe Ltd, declares
that 922SH is in compliance with the essential requirements
and other relevant provisions of Directive 1999/5/EC.

A copy of the original declaration of conformity for each
model can be found at the following Internet address:
http://www.sharp.co.jp/k-tai/




Copyrights

Copyright laws protect sounds, images, computer
programs, databases, other materials and copyright
holders. Duplicated material is limited to private use
only. Use of materials beyond this limit or without
permission of copyright holders may constitute
copyright infringement, and be subject to criminal
punishment. Comply with copyright laws when using
images captured with handset camera.

The software contained in handset is copyrighted
material; copyright, moral right and other related
rights are protected by copyright laws. Do not
copy, modify, alter, disassemble, decompile or
reverse-engineer the software, and do not
separate it from hardware in whole or part.

Licensed by QUALCOMM Incorporated under one or
more of the following United States Patents and/or
their counterparts in other nations:

4,901,307 5,490,165 5,056,109 5,504,773
5,101,501 5,506,865 5,109,390 5,511,073
5,228,054 5,535,239 5,267,261 5,544,196
5,267,262 5,568,483 5,337,338 5,600,754
5,414,796 5,657,420 5,416,797 5,659,569
5,710,784 5,778,338

| Safety Precautions

Video recording and playback are based on MPEG-4.

This product is licensed under the MPEG-4 Visual
Patent Portfolio License for the personal and
non-commercial use of a consumer to (i) encode
video in compliance with the MPEG-4 Video
Standard ("MPEG-4 Video") and/or (ii) decode
MPEG-4 Video that was encoded by a consumer
engaged in a personal and noncommercial activity
and/or was obtained from a licensed video provider.
No license is granted or implied for any other use.
Additional information may be obtained from MPEG
LA.

See http://www.mpegla.com.

This product is licensed under the MPEG-4 Systems
Patent Portfolio License for encoding in compliance
with the MPEG-4 Systems Standard, except that an
additional license and payment of royalties are
necessary for encoding in connection with (i) data
stored or replicated in physical media which is paid
for on a title by title basis and/or (ii) data which is
paid for on a title by title basis and is transmitted to
an end user for permanent storage and/or use. Such
additional license may be obtained from MPEG LA,
LLC.

See http://www.mpegla.com for additional details.

Handset employs RSA® BSAFE™
software developed by RSA Security
Inc.

RSA is a registered trademark of RSA
Security Inc.

BSAFE is a registered trademark of
RSA Security Inc. in the United States
and/or other countries.

This product is equipped
with JBlend™ designed to ((
accelerate the

performance of Java™

Application.

\_/

Powered by JBlend™. Jg\,}[’g JBlend’

Copyright 1997-2008 Aplix

Corporation.

All rights reserved.

JBlend and JBlend-related brands are trademarks or
registered trademarks of Aplix Corporation in Japan
and other countries.

Java and Java-related brands are trademarks or
registered trademarks of Sun Microsystems, Inc. in
the United States and other countries.

NetFront

This product employs NetFront Browser (Internet
browser) and NetFront SMIL Player developed by
ACCESS Co., Ltd.

Copyright© 1996-2008 ACCESS CO., Ltd.
ACCESS and NetFront are trademarks or registered
trademarks of ACCESS Co., Ltd. in Japan or other
countries.

This product includes a module developed by
Independent JPEG Group.

|Cl"0 m.cro i n i
- S,

microSDHC™, microSD™ and miniSD™ are
trademarks of the SD Card Association.

IrSimple™, IrSS™ and IrSimpleShot™ are
trademarks of the Infrared Data Association®.

Xl
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Bluetooth is a registered trademark of the Bluetooth

€ Bluetooth’

The Bluetooth word mark and logos are owned by
the Bluetooth SIG, Inc. and any use of such marks
by SHARP is under license.

The frequency band utilized by handset Bluetooth®

function is shared with industrial, scientific or

medical equipment, including household microwave

ovens, etc., and used by radio stations, amateur

radio stations, etc. (hereafter "other radio stations").

1 Before using Bluetooth®, visually confirm that no
other radio stations sharing the same frequency
band are in use nearby.

2 Should interference occur between handset and
other radio stations, move or cancel Bluetooth®
function immediately.

3 For additional information and support, contact us
at the following number.

SoftBank Customer Center, General Information

From a SoftBank handset, call toll free at 157 for

General Information.

From landlines, see P.14-36 "Customer Service."
This radio station utilizes 2.4 GHz band with FHSS
modulation. Maximum transmission radius is

10 meters (32 feet).

2.4FH1
]

Microsoft, PowerPoint and Excel are registered
trademarks of Microsoft Corporation in the United
States and/or other countries.

SOFTBANK, SoftBank and the SoftBank logo are
trademarks or registered trademarks of SOFTBANK
CORP. in Japan and other countries.

Powered by Mascot Capsule®/Micro3D Edition™.
Mascot Capsule® is a registered trademark of HI
Corporation.

©2002-2008 HI Corporation. All rights reserved.

QR Code is a registered trademark of DENSO

WAVE INCORPORATED.
ADOBE“ﬁ
FLASH®

ENABLED

This product employs Adobe®
Flash® Lite™ technology
developed by Adobe Systems
Incorporated.
Copyright© 1995-2008 Adobe
Macromedia Software LLC. All
rights reserved.
Adobe and Flash are either trademarks or registered
trademarks of Adobe Systems Incorporated in the
United States and/or other countries.

Technologies.

picsel @
Picsel, Picsel Powered,

Picsel Viewer, Picsel File Viewer, Picsel Document
Viewer, Picsel PDF Viewer and the Picsel cube logo
are trademarks or registered trademarks of Picsel
Technologies Ltd.

Document Viewer is
enabled by Picsel

Chaku-Uta and Chaku-Uta Full are registered
trademarks of Sony Music Entertainment (Japan)
Inc.

BookSurfing® is a registered trademark of CELSYS
Inc., Voyager Japan, Inc. and INFOCITY Inc.

Solo Traveling Photo® is a registered trademark of
Information System Products Co., Ltd.

Yahoo! and the Yahoo! and Y! logos are trademarks
or registered trademarks of Yahoo! Inc.

CP8 PATENT

Video Call, S! Application, Customized Screen,
Movie Sha-mail, Sha-mail, 3D Pictogram, Input
Memory, Near Chat, Multi Job, S! Mail, Graphic Mail,
Feeling Mail, S! Information Channel, S! Town,

S! Loop, PC Site Browser, Weather Indicator,

S! Quick News, S! Addressbook Back-up, S! Circle
Talk, S! Friend's Status, PC Mail, S! Music Connect
and Secure Remote Lock are trademarks or
registered trademarks of SOFTBANK MOBILE Corp.

Other company and product names mentioned
herein are trademarks or registered trademarks of
their respective owners.



922SH meets the government's requirements
for exposure to radio waves.

These requirements are based on scientific basis to
assure that radio waves emitted from mobile phones
and other handheld wireless devices do not affect
human health. They require that the Specific
Absorption Rate (SAR), which is the unit of
measurement for the amount of radiofrequency
absorbed by the body, shall not exceed 2 W/ke'. This
limit includes a substantial safety margin designed to
assure the safety of all persons, regardless of age or
health, and meets the international standard set by
International Commission on Non-lonizing Radiation
Protection (ICNIRP) in cooperation with World
Health Organization (WHO).

All mobile phones, prior to product launch, must be
certified as compliant with government requirements
as stipulated by the Radio Law. 922SH has been
granted Technical Regulations Conformity
Certification by TELECOM ENGINEERING
CENTER. Its highest SAR value is 0.298 W/kg. This
value was obtained by TELECOM ENGINEERING
CENTER as part of the certification process. SAR
tests were conducted with handset transmitting at its
highest certified power level in accordance with
testing methods set by the government. While there
may be differences between the SAR levels for
various handsets, they all meet the governmental
requirements for safe exposure. The actual SAR
level of the handset while operating can be well
below the highest value. This is because the
handset is designed to operate at multiple power
levels so as to use only the power required to reach
the Network.

Safety Precautions

Additional information on SAR can be obtained on
the following Websites.

Ministry of Internal Affairs and Communications
http://www.tele.soumu.go.jp/e/ele/index.htm
Association of Radio Industries and Businesses (ARIB)
http://www.arib-emf.org/initiation/sar.html (Japanese)

"Requirements are stipulated in Radio Law
(Ordinance Regulating Radio Equipment, Article
14-2).
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Handset Parts

o=
)
)
=2

pauels bumen

1-2

I Light Sensor

F Internal Camera

H Display

Speakers

H Earpiece

[ Infrared Port

Ed Small Light

H External Display

El Sensor Key

Il Memory Card Slot (with Slot Cover)
I External Device Port (with Port Cover)
[F Microphone

[H Headphone Port (with Port Cover)
[l Strap Eyelet

[H Antenna (for TV reception)

@ Internal Antenna Location

[l Battery Cover

[H Charging Terminals

[E] Portrait/Macro Selector

fT] External Camera (lens cover)

Al Mobile Light

® Do not cover or place stickers, etc. over
Light Sensor, Sensor Key or Internal
Antenna area.

® Replace Port/Slot Cover after Port/Slot use.

® Avoid metallic straps; Antenna sensitivity
may be affected.

Display Positions

. Handset Closed

Keep handset closed when not in use.
. Handset Open

Open handset to enter text, etc.



Handset Keys (Handset Open)

Descriptions are based on handset in Standby.
Keys are indicated in this guide as shown.

[S)
]

B BE EEEEEE B BBREAN

K Mail Key
Open Messaging menu. Long Press to
open S! Mail Composition window.

F1 Page Up Key
Increase volume. Long Press to open
Change Menu window.

H Multi Job/Manner Key
Select handset mode. Long Press to
activate/cancel Manner mode.

[ Power On/Off Key
Toggle Standby display. Long Press to
turn handset power off.

H Start Key
Open All Calls.

[ Number Keys -

Enter numbers to place calls or access
functions (Quick Operations). Long Press
to access assigned functions.

Multi Selector (left)

Open Received Msg. folder. Long Press to
activate/cancel Bluetooth®.

E Center Key (u]

Open Main Menu. Long Press to activate/
cancel Keypad Lock.

E1 Multi Selector (up) 2]

Open Standby Window.

[l Multi Selector (right)

Open S! Mail Composition window.
Long Press to activate/cancel infrared.

[ Yahoo! Keitai Key
Open Yahoo! Keitai portal. Long Press to
open Yahoo! Keitai menu.

[Hl Clear/Back Key
Play Answer Phone messages. Long
Press to activate/cancel Answer Phone.

[H Line Break Key

[ Punctuation Key

[H Space & Conversion Key

[ Memo & A/a Key
Open Scratch Pad. Long Press to open
Notepad.

[l Dictionary & Pictogram/Symbol Key
Open Dictionary.

[H Camera & Alphanumerics Key
Activate mobile camera. Long Press to
open Data Folder.

[fl TV & Hiragana/Katakana Key (&

Activate TV. Long Press to open Video List.

Handset Parts

M Shift Key ]
Al Function Key
¥ Page Down Key
Decrease volume.
PH Shortcuts & Help Key
Open Shortcuts menu.
Il Multi Selector (down)
Open Phone Book. Long Press to create
new Phone Book entries.
fH Backspace Key
0 Letter Keys -
Function Key
® Use together with keys with blue
print to enter target characters, or
execute functions/operations below,
without opening Options menu:
Function Key Operations
® Press [F | (@ appears) # target key.
® Basic Key Combinations:

[ ]+@%) | Open Help

[ ]+ 7] | Create new entries, folders, etc.
[ J+(z™ | Undo

[Fn J+[x Cut

[F]+ Copy

[+ 7] | Paste

[ ]+E® |Delete

In this guide, Function Key operations are
indicated by [ ]+X]. (X: target key)

pauels bumen
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1.4

Handset Parts :
Handset Keys (Handset Closed)
(o)
e -
= -
«
()]
:
P H—ﬂ (Green)
Q
I —E (Red)

. Front Keys

I Sensor Key
Hl Start Key (1)

Open Dialed Frequency/illuminate Sensor Key
H End Key [

Long Press to turn handset power on/off.

. Side Keys

L1 S! Circle Talk Key

Use S! Circle Talk.
H Volume Up Key (<]

Long Press to activate/cancel Keypad Lock.
[ Volume Down Key [~

Long Press to illuminate Mobile Light.
Menu & Manner Key

Long Press to activate/cancel Manner mode.

. Sensor Key Sensor Key lllumination

® |lluminate Sensor Key first to use it.
Press (1 to turn illumination on, or (iJ
to turn illumination off.

Use Sensor Key to place/answer calls,
etc. with handset closed. llluminated
areas function as Multi Selector and
(m], and Clear/Back Key [F&7).

In this guide, Sensor Key operations
are indicated as follows:




Display Indicators M Function Status M Notifications
! . " o 1(2]3]4] 112341506/
Indicator size/position varies with display L[] L L
content, size or orientation, etc. REEG ‘ EIAS H8
M Basic Status
[1]2)] H A | Active S! Application B4 | Unread mail
%DH.L é (2 | Paused S! Application BX | Unread Delivery Report
‘ ‘ €9 | Bluetooth® Notification & Unread S! Friend's Status
H | 2 | Music playback in progress " | notification (green outline)
i | Til | Signal strength’ B | TV recording in progress (handset) % | Unread S! Information Channel info
[ | Packet transmission available (3G) ing i H | B | Software Update result
2] B2 TV recording in progress
[ | Packet transmission available (GSM) = (Memory Card) %, | Unread S! Quick News info
Battery strength ({(EEE] may Memory Card in use Answer Phone active & message
H| 8 -4
appear instead.) H | & | Memory Card formatting 4] recorded
"The more bars the better. ta | TV Timer/TV Recording Timer set = Answer Phone canceled &
- - - - message recorded
& | Multiple functions (Multi Job) active B @ [New vor ;
Function Key active — ew Voicema -
- - - [ | 75 | Contents Key received
a, Music playback in progress (via
Bluetooth®)

Display

b

pauels bumen
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—I Display

M Warnings M Transmissions M Settings
o [ 1 I 2| H OHE O 1 (1IN 20N314151617/8(9110
@ = ke -
= I E] ©RE Y8 z DO % Prdeie) §
a
@
2 H | = | Mail memory low ® Waiting/packet transmission in H | A | Offline Mode active
g A Memory Card unusable/ progress (3G) H | i | Keypad Lock active
misinserted @ Waiting/packet transmission in @ [ Manner mode active
H | 0R | Message delivery failure progress (GSM) H | @ | Drive mode active
i | @ | SSL browsing in progress — _
® Packet transmission protocol Original mode active
ready (3G) [ | @ | Answer Phone active
@ Packet transmission protocol s Al Call Forwarding or Voicemail active
ready (GSM) (forwarding condition: Always)
Receiving mail [ | ¢ | Hour Minder active
£g | Sending mail A | Alarm set
Bl | & | S! Friend's Status online (red outline) Ik | f8 | Schedule (Alarm set)
= | S! Friend's Status registration B | Schedule (Alarm unset)
=l A
request received - a @ | Show Secret Data active
H % Software Update in progress B | Function Lock active
USB Cable c.or!neclted % | Ringtone (Silent)
¢, | USB transmission in progress = - -
— [l | & | Ringtone (Increasing Volume)
72 | Infrared transmission in progress " " -
5 — B | Vibration active
Bluetooth® transmission ready AUto A = o Monit
B | @ | Bluetooth® transmission in progress 10] acl:Jti?/e nswer or remote Monitor
& | Bluetooth® talk in progress
o S! Addressbook Back-up
transmission in progress
PC Site Browser in use
H RSS-compatible site
[ | 2 | Infrared transmission ready
© | Weather Indicator

1-6




Display

External Display Indicators B Notifications W Warnings

M Basic Status

pauels bumen

H | &2 | Message delivery failure

#) | Missed Calls | | - | S! Information Channel info
#® | Answer Phone message recorded reception failure

i | Yal | Signal strength’

:HD Missed Call Notification B Handset Status
w | New Voicemail

F1 | @i | Battery strength

"“The more bars the better.

lolleoliNflofloilaffelolf—|
K

New mail (¢ appears for PC Mail) H
Bl | New Delivery Report
»? | Contents Key received
@ | Unread S! Information Channel info 2]
%) | Weather Indicator update
7]
Alarm
Schedule Alarm
Task Alarm

Bluetooth® Notification

TV Alarm (watch)

TV Alarm (record)

Nooomea
0o 2|8 b

Unread S! Friend's Status notification




Display I

pauels bumen !

Viewing Displ

Standby

Handset powers on and enters Standby.

Menu Navigation

Select an item and press [®] to open it; press to

return.
Indicators (signal strength, i SEUESI | N
h Phone Settings que‘Settlngs
=, Connectivity isplay
battery strength, etc.) siCall/Video Call Customized Screen
appeatr. iNetwork Settings  [Sounds & Mlerts
Set Key Light
EEUR
x User Dictionary
e etc. included.
I
Missed Calls,
new mail, etc.
Received Msg.
O Mail Mai | 1/ 1
£ Folder 1
<Gl & Folder 2
Information Window ) Information  Folder3

JHow's it going?
IXK/XX 15:05

W1’ ve just finished my work.

How about you? I" 11 be at the

Information window opens at

the bottom.

o Information label and count
appear in Information window.

® Select an item and press (w] to
open it.

Softkeys

Functions/operations assigned
to (@], (] and appear at the
bottom.



Display Saving & Backlight
® Display goes dark after Display Saving

time elapses. Press any key to activate it.

® Display must be visible to use handset
functions. Press any key to illuminate it.
For Information List
[m] & (54 Phone » [m] & (34 Information
» [x]
Clearing Information List
[Information List] » Reset » [u]
» (3] Yes » [u]

Display

I_

Yal n =N ) Phone Book
Enter Number

Play Messages
XX/ XX XXX 15:05 Speed Dial

Missed Calls,
new mail, etc.

Tal @ XXX
pCall:1 a

) 409392XXXX1 Calling...

afKondo Koichi

090392XXXX1
Information label appears and
Small Light illuminates (it goes out
after all items are opened).

Toggle
records

(Received Calls) Yulim
409392XXXX1

)afKondo Koichi

o

pauels bumen
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Charging Battery
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%

Battery must be inserted in handset to

charge it.

® Use specified AC Charger ZTDAA1 (sold
separately) only. In this guide, ZTDAAT is
referred to as "AC Charger."

® Handset and AC Charger may warm during
charging.

Small Light

External Device
Release Port
Tabs

AC 100V Outlet

Blades

Charger Connector

((
7

Arrows

AC Charger

Important AC Charger Usage Notes
® Fold back blades after charging.
® Do not pull, bend or twist the cord.

Open Port Cover as shown

&

Connect AC Charger
® With arrows up, insert connector until
it clicks.

Extend blades

Plug AC Charger into AC

outlet

® Small Light illuminates red while
charging.

® When charging completes Small
Light goes out.

Unplug AC Charger

® Pull AC Charger straight out.

Disconnect handset
® Squeeze release tabs to remove
connector.

Fold back blades and
replace Port Cover

When Small Light Flashes

® Battery is unchargeable; may be defective
or simply at the end of its life; replace it.

USB Charge

® Connect handset (with power on) to PC
via USB Cable to charge battery.

Charging Battery Overseas

® SoftBank is not liable for problems
resulting from charging battery abroad.

I Disabling USB Charge (P.13-18)



Power O

Handset Power Oo/oft ...

[}
Entor lastname » (=) [ Reviovng Network nformaton 5
Follow these steps when powering on Enter first na,me » E Handset initiates Network Information a
P P 9 ® Change Menu display option . ar )
922SH for the first time. confirmation appears. retrieval when (=], (=] or is pressed &
L for the first time. =
< | (Long) Yes or No » [u] : e

® When handset is closed, Long Press [i). Retrieve N _Info

® After Power On Graphic, follow the e 15058

RES > L] XERES >

steps below. < m w\ )
Ll 0L RO 8 ﬁ e

Language % (8] ® [J] English »
(a] » (Long) » (Long) »
Change Menu window opens ® Choose Yes and press [u].
. Standby ® Retrieve Network Information to use
Select option » E ® Choose No to enter Standby Network-related services and TV; retrieval

Guide descriptions are based on
Standard Menu.

immediately after powering on. automatically sets Clock.

When USIM Card is Not Installed Power Off

® Insert USIM Card appears; insert the

card to use handset. (Long)
Editing My Details ® After Power Off Graphic, handset
(=] » » ® (] Select item shuts down.

» (=] » Edit » [*]

ElOptions [ Done [ Cance|Ed

® My Details setup starts.

4 ©Date & Time (P.13-2) ©Network (P.13-18)
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Keypad Lock

Lock handset keys and prevent accidental
operation/function activation.

(=] (Long)

When handset is closed, Long Press (<.

pauels bumen

Confirm 1

< Keypad “ag# 1 ocked

® Keypad Lock activates.

When Keypad Lock is Active
® Incoming calls temporarily cancel
Keypad Lock. To answer a call, press
or (1. Keypad lock reactivates after
the call.
L4 or [ does not turn off handset power.
Canceling Keypad Lock
(=] (Long) or (<] (Long)

112



# Unsaved
$ <Add New Entry>

® Handset phone number and the

name entered at initial setup appear.

Opening My Details with Handset Closed
(1 (Long) » H My Details » B
Clearing My Details
After 0, » (2] Reset My Details
» (m]  [J] Yes » (]

My Details

pauels bumen
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Scratch Pad

Jot down text in Standby or while using Other Scratch Pad Usage

functions. Save text as a Notepad entry.
Usage Operation

Add Standby Save as Sticky Note
Window Tag | # [u]
® Text entry window opens. Enter Mail

Saving Text to Notepad

pauels bumen

Create Message %
(=] » [2] Select mail

Enter text ® [u]

Scratch Pad T° 15058

Save to Notepad
F1Save as Sticky Note
ElCreate Message
[Save to Calendar
HSave to Tasks
[ASave to Phone Book
EdSave as Text File
EIWeb Search

Message Text

type » [u]

Enter Schedule
Subject/Details

Save to Calendar
» (=]

Enter Task
Subject/Details

Save to Tasks » (u]

Add Last Name
to Phone Book

Save to Phone
Book » (=]

® Reading is not entered.
Save as Text File »
(=] ® Enter name »
[m] & (5 Save here

» (s

[ [e=]
Save to Notepad » (1]
(m] & (3] Tools » [m]
Doc./Rec. Tools » (u]

Notepad » [u] »
Select entry » [u]

Save Text File

m Saved to Data Folder
(Other Documents).

Web Search » [u]

Search Internet | » Select browser

» [n]

® For more, see corresponding function
description or follow onscreen instructions.

1.14



Mobile Manners

Please use your handset responsibly. Use

these basic tips as a guide. Inappropriate

handset use can be both dangerous and

bothersome. Please take care not to

disturb others when using your handset.

Adjust handset use according to your

surroundings.

® Turn it off in theaters, museums and other
places where silence is the norm.

® Refrain from using it in restaurants, hotel
lobbies, elevators, etc.

® Observe signs and instructions regarding
handset use aboard trains, etc.

® Refrain from use that interrupts the flow of
pedestrian or vehicle traffic.

Manner Mode

Mutes most handset function sounds.

(Long)
When handset is closed, Long Press [#].
" ® 2]

< Mann€¥” mode
selected

i
I 0K

® Manner mode is set.

When Manner Mode is Active
® Ringtones and other sounds are muted.
® 922SH vibrates for transmissions/alerts.
® Shutter click still sounds at fixed volume.
Canceling Manner Mode

(Long) or [*] (Long)

Offline Mode

Temporarily suspends all transmissions.

(m] » (5] Settings » [u] »
Network Settings » (]

Offline Mode » [u]
Onw» (u]

Offline Mode

O0n
QOoff

Offliife Mode
enabled

I 0K I
® Offline Mode is set.

Canceling Offline Mode
In &), (3] Off » [u]

I Selecting a handset mode

Customizing handset modes (P.13-2)

Mobile Man

pauels bumen
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Security Codes
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Security Codes

These codes are required for handset use.

® Write down Security Codes.

® Do not reveal Security Codes. SoftBank is
not liable for misuse or damages.

Handset 9999 by default; use or
Code change some functions

4-digit code selected at
g:g:;; contract; access Optional

Services via landlines or
Code -
change contract details

Changing Handset Code

(m] & (3] Settings » (u]

T

Mode Settings

&, Connectivity Display
siCall/Video Call Customized Screen
ANetwork Settings | Sounds & Alerts

Date & Time
Set Key Light
Eeny

San
User Dictionary
etc. included.

4-digit code selected at
contract; restrict incoming/
outgoing calls (Call Barring)

Network
Password

[ o T

Change Network Password as needed.

Incorrect Code Entry

® Handset code is incorrect! appears; try
again.

® |f Network Password is incorrectly
entered three times consecutively, Call
Barring settings are locked. To resolve,
Network Password and Center Access
Code must be changed.

Phone Settings % (u] »
Locks » [u]

Locks Ti® 15058

Change PIN2

Face Recognition Off

Function Lock Off

IP Service Setting On

Application Lock Off

History Lock Off

Show Secret Data Of f

= 1
Chng Handset Code » [u]

Chg. Handset Code

Enter Current Code:

Cancel

Enter current Handset Code
» (=]

Che. Handset Code I ] NN 7 |
Enter New Code

[ [ Cance|F2

Retype Code

Re-enter new Handset Code

» [u]
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Menu Operations

Handset Menus

In Standby, access functions from Main Menu or via Quick Operations/Shortcuts.

w Inthis guide, most operations start from Main Menu.
1
g. 7 ~\ e Y
(o]
°
ol
2 Press (®] to open Main Enter numbers to access
% . = A Menu (gateway to functions.
,"”‘ *© T B | functions). o To activate functions, press the
e ~— corresponding key.
E Y ® Select an item and press [®] to P 9 ey
Dasfol open Sub Menus.
[ExCustomize =
. J \. J
x 7Y
1o X D :
Long Press - to :
access assigned functions. B BEPhone Book : L9 :
Sty BRI ﬁ :
®Press to view shortcuts. Benter Number  EI@AIarms — | :
[lf3Received Msg. E18Bluetooth T :
 Change shortcuts as needed. EGmetr (=] )ﬁ( :
[E3E3Ca l endar — ‘ E & = :
T I 3 P CECEEEEE .
(s o 9 ) e e A0 eI
(23 S 5 U PO O T ) P

- — —




Multi Job

Toggling Active Functi

Access a function in Shortcuts menu
while another is active. (Multi Job)

Multi Job may not be activated from some
menus/windows (e.g., when selecting
ringtone/ringvideo, etc.).

In a function window,
In dial window, Long Press @9).

El(ZReceived Msg.
F1=¥Create Message

<Enter Text>

Ll

@:Stamp
EOptions View [ Switchid
® Menu/window opens.

To toggle active windows,

@:Stamp

XXXX/XX/XX

<Enter Text>

@:Stamp

EOptions ] View Swi tchi

® Multi Job ends

® \When a confirmation appears, follow
onscreen prompts.

Using Current Function in Full Screen

[(F]+(=#)]

suoneladQ odiseg

é@ Customizing Shortcuts (P.2-25)




suonesadQ diseg

Activate Simple Menu to reduce available
handset functions and simplify menus.

Messaging

Received Msg.

Create Message

Drafts

Templates

Sent Messages

Unsent Messages

Create New SMS

Phone

Phone Book

Add New Entry

Play Messages

Answer Phone

Call Voicemail

My Details

Speed Dial/Mail

Camera

Convenient Tool

Calendar

Alarms

Calculator

Assignment

Dictionary

Notepad

S! Friend's Status

S! Circle Talk

Change Menu

Data Folder

TV

Activating Simple Menu
(Long)

TiF (]|

Change Menu
O Simple Menu

®
O Large Font Menu
I = I

Simple Menu w» (=]

While Simple Menu is Active

® Fonts are enlarged and appear in bold.

® Clock is enlarged (Calendar is hidden).

While Using Functions Not Available in

Simple Menu

® Simple Menu activation is disabled. End
the function and retry.

. Key Assignments

(Long) | Open Video List

(Long) | Turn handset on/off
Use Yahoo! Keitai

Open Messaging menu
(Long) | Create S! Mail message

Open All Calls

Open Received Msg. folder

Create S! Mail message

Open Calendar

Open Phone Book

Create Phone Book entry

Activate/cancel Manner mode

Activate/cancel Keypad Lock

Play Answer Phone messages

Activate/cancel Answer Phone

Standard Menu » (=]



Changing.Font Si

Enlarging All Fonts

Activate Large Font Menu to enlarge fonts
for menus, text entry, etc. as follows:

Messaging
Received Msg.
=Create Message

s%Retrieve New

f2Chat Folder
@Server Mail B..
Create New SMS
=Settings
@Memory Status

Change Menu
O Simple Menu
(O] Standard Menu |8
O Large Font Menu
=] I

Large Font Menu » (]

Canceling Large Font Menu
In &, (8] Standard Menu » [u]

Customizing Font Sizes

(] & (3] Settings » (=] »
Phone Settings » (1]

Display » (u]
Font Settings » [u]

Font Settings
Font Size
Font Weight Normal
J———

Font Settings Menu

Font Size » [u] B
Select item » (=]

Select size » (u]

Changing Font Size in Function Windows

® Press [ ]+[£9/[Z )] to change font size
in text entry/message windows, etc. Font
Size setting changes accordingly.

Changing Font Weight

In Font Settings menu,
Font Weight » [u]

Font Weight

OThin

[OlNormal
OBold
Sample

Select weight » [u]

o
I
@,
(1]
]
]
(]
=
I
=3
o
>
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Standby Window

Standby Window (Japanese)

In Standby, view S! Quick News or Select item » [u] M News Panel
w Calendar, access shortcut icons, and more. ) 0
2 » Standby Window o -
g closes <=
3 w B Standby Window Panels - o
o =
S ﬂ M Shortcut Panel =5
=2
@ T® 2 5058 Ellptions
” <\§l H Hl Member Panel
L 4
E0ptions = . Swi tchid \ oFe e 2 1505
Standby Window OBl & |
™~ <A
Eoptions. = SwitchEd
T505E]
S Mo Tue Wed Thu Fri Sat. . CalendarlTag Panel
) TP 5058
%l:j S Won Tue Wed Thu Fri Sat Selecting Panel Items
=8 - ] 5 [Shortcut Panel}/[Calendar/Tag Panel]
~ , E E—
~|  — » (3] Select ltem » [u] »
g ] Select item » [u] (CI/V]) »
® Press to togale panels. m To the left is an example of Shortcut
ggre p Boptions = v\\ Switchid Panel with all items checked (V).

(Long Press to toggle panels in
reverse.)

g @ Changing Display Option (P.2-25)




Panel Selection

In Standby Window, »
Standby Window W [u]

Standby Window [l 15058
Display Window Swi tch by Key
Display Panel
[ (=]

Standby Window Menu

Display Panel w [u] »

Select panel ®» (=] (/)

>

® Panels with ] (checked) appear in
Standby Window.

(VEILCRET ]

In Calendar/Tag Panel,
(select row with (J) » [u]

Enter text ® (]
T FE

Sun Mon Tue Wed Thu Fri Sat

Checking/Unchecking Tags
» (] Select tag » »
Check Note or Uncheck » [u]

m Checked tag (with M) turns gray.

Deleting Tag Notes
» (] Select tag » »
Delete Note #» [u]

® To delete all checked tags, follow these steps.
(5] » » (2] Delete Checked
Note » (]

Standby Window

I_

I.Display & Key Settings (P.13-3 - 13-4)
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Wallpaper

suonesadQ diseg

b

Some files may not be usable.

(m] B (5] Settings » =] »
Phone Settings »(u]

Display % (u]
Wallpaper » [u]

Wal Ipaper Ti® 08
Choose from preset
Pictures pictures.
Flash®
Slide W paper
Other Documents
Blank
[ =

Wallpaper Menu

Preset Pictures » [u] %
Select image » [u]

Using Data Folder Images
In ©), [2] (select folder) » [u] B 3]
Select image » (] » [u]
® For images smaller or larger than

Display, follow these steps.

Select option » [u] » (=]
Selecting Images with Limited Usage Period
® A confirmation appears. Choose Yes and

press [m] to proceed.

Slide Show Wallpaper

Set Slide Show to appear in Standby.
Some images may not appear.

In Wallpaper menu, (2] Slide
W paper & [u]

Folder Setting Pictures

=
Folder Setting » [u]
Pictures or DCIM » [u]

Select sub folder » (=]
» (3] Set this folder % [u]

® Omit steps for sub folder if none.

If There is No Image in Set Folder
® Preset images appear.
Using Preset Images
In ©, [2] Preset Pictures » [u]
Changing Pattern
In 3, [2] Pattern Setting % (u] »
Select pattern » [u]



Customized Screen (Japanese)

Downloading Customized Screen

Follow these steps to download a
Customized Screen using handset.
Read information (price, etc.) on
Customized Screen download page.

(w] & (34 Data Folder » [u] »
Customized Screen W [u]

CustomizedScreen [&] I (2
E=oCIM XXXXXXXXXX
E3Ring Songs-To...
TAS! Appli an
@Music
C2Videos
@Books
Customized Sc...
@Status Templa... I
[E0ptions | View [ CheckEa

Customized Screen Menu

Download Customized
Screen » (u]

® Handset connects to the Internet and
source site list appears. Follow
onscreen instructions.

. Purchasing Contents Keys

Contents Key may be required to use
fee-based Customized Screen.

In Customized Screen
menu, 3] (select
Customized Screen) »

CustomizedScreen [2] IRF
[=DEI

EARing Songs-To...
fRS! Appli

Activate
Move >>

® Select one with 6.

Activate » (u]
Yes » [u]

® Read through terms of service and
follow onscreen instructions.

Customized Screen Setup

Selecting a preloaded Customized Screen
initiates updated file download, installing
the most recent version of selected file.

In Customized Screen
menu, 3] (select
Customized Screen) » [u]

CUSEGiZeasereeHn I -

® Select one without 9.

(] > [u]

When Selected Customized Screen is Active
® Cancellation confirmation appears after
Applying Preset Customized Screen
(] » (5] Settings » [u] » (3] Phone
Settings » [u] » (3] Customized
Screenw (u] & (3] Preset Screens #»
(=] » [£] Select pattern » [=] » [=]

Customized Screen

suoneladQ odiseg

é@ Canceling Customized Screen

Accessing Source Sites (P.2-25)




Handset Responses

suonesadQ diseg

Customizing Handset B

(] & (3] Settings » (=] »
Phone Settings » [(u]

Sounds & Alerts » [u]
Sounds & Alerts

Vo |ume

Ringtone/videos

System Sounds

Vibration

Event Light

Status Light

Any Key Answer Off

Surround Link to Sound
=

Sounds & Alerts Menu

Ringtone/videos » [u]

Ringtone/videos
For Voice Call XXXX
For Video Call XXXX
For New Message XXXX
For New PC Mail XXXX
S! Friends Status XXXX
S! Circle Talk XXX
[ Missed Calls XXXX
S! Appli Notif. XXXX
[———

Ringtone/videos Menu

Select item » (u]

For For New Message, etc., select
Assign Tone and press [u].

Select folder » (u]
Select tone/file B (]

Playing Video for Incoming Transmissions
In &, (3] Videos » (=] ® (3] Select
file » [u]

If Portion of File Content is Specifiable

® Start point selection window opens.

Follow these steps to proceed.

After (), (2] (select start point) » (=]
Selecting Files with Limited Usage Period
® A confirmation appears. Choose Yes and

press [m] to proceed.

In Sounds & Alerts menu,
Vibration » [u]

Select item » (=] B
Switch On/Off % [u]

For Incoming Call

Switch On/0ff O0n

Vibration Pattern CLink to Sound
[O0FT

[ —

(5] On W [=]

Vibration Pattern #» (]
®» (3] Select pattern » [u]

® To check vibration patterns, select
one and press [2].

Setting Ringtones to Control Vibration
In &), [¢] Link to Sound % [u]
Precaution
® Cancel Vibration when charging battery
to help avoid accidents.

2-10

é Setting Ring Time for Incoming Mail, etc. (P.2-25)

1 Ringtone & Sound Settings (P.13-5)



Basics
In text entry windows, use Letter
Keys to enter characters.

Wessage:
4| :Dict X/XXK
|

Text Entry Window
e Use romaji to enter hiragana or katakana.
Convert hiragana to kanji or double-byte
katakana as needed.
e7To enter single-byte katakana or alpha-
numerics, select appropriate entry mode

or enter hiragana and convert characters.

Hiragana Mode & Suggestion List

:
-
0 &3 '3 NEKO 6 neko

133 4 Neko 7 neko
2 NEKO 5 Neko
E<Range | = [
Suggestions for Katakana/
Alphanumerics Conversion
®Press [f ] then target key to enter
numbers or symbols printed in blue.

Toggling Entry Modes

Press [&] or

Current —m

Entry Mode
5 Hiragana 1 [Single-byte number
7 |Double-byte katakana| | | a |Single-byte alphabet
7 |Single-byte katakana a [Double-byte alphabet

®Press to toggle upper/lower case
roman letters or standard/small kana.

Key Assignments

Enter Pictograms and Symbols.

(4 Toggle upper/lower case roman
letters or specify text block.

[): Enter punctuation marks (. .,.).

El: Enter symbols/numbers printed
in blue (upper right of each key).

: Convert characters
mid-entry or enter spaces.

Enter conversions/line breaks.

: Delete characters or cancel
conversion.

e To learn when/how to use other keys
for text entry, read the following pages.

e Unless noted otherwise, text entry
descriptions are for text entry windows.

o
I
@,
(1]
]
]
(]
=
I
=3
o
>
”n
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Text Entry :
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Entering Characters

Follow these steps to enter & 7# in
hiragana mode.
See P.14-9 for romaji input.

s Ju7 (3 23T (F)
kX0 5 (&)

X/XXCandidates

12857K 098
1185 7R BT
10R X+

08$HARZ 05HARE A
073K A % [04ShAKDIBZS
No Conv

Text Entry Window

Convert 7 F to 4.

Enter 3" and press
or

Message:

X/XXCandidates

® |n hiragana mode, word suggestions
change as hiragana is entered.

(Predictive)

Fio

® To exit suggestion list, press
or (&1

(=] or

® Alternatively, use Keypad to enter
words/phrases from suggestion list.

® Words likely to follow the entry
appear based on previous entries.
(Previous Usage)

When Target Word is Not Listed
® Press or to segment hiragana to
convert separately.
Phonetic Conversion
Enter reading in hiragana %
Selecting Multiple Converted Words
[ 0+(m]]

. One-Hiragana Conversion

Enter the first hiragana to access
previously selected words.

Example: £ was previously selected
after conversion.

©7) () % (s or [2]

X/XXCanddates
TBRR—Y

Select word/phrase » [u]

@ Inserting Line Breaks © Inserting Spaces
Clearing Conversion Log (P.2-26)

Using Character Codes

1 Disabling suggestions based on entered characters
suggestions based on entered words

Disabling
Using Keypad to enter words/

phrases from suggestion list (P.13-6)



Follow these steps to change entry mode
from hiragana to double-byte katakana
and enter a2 .

Message :

Cance |

Message :

Symbols & Pictograms

May be unavailable depending on entry
mode.

® Symbol/Pictogram History appears.

or » List toggles

® To check cross-carrier Pictograms,
press in Pictogram List.

Select Symbol/Pictogram
» [u]

® Pictograms are double-byte even in
single-byte modes.

or » List closes

Using Function Key to Enter Symbols
o Alternatively, press [ ] then the target
Symbol key (symbol printed in blue).

: Text Entry

[ )+(&7]

[ o ]

Select emoticon » (=]

Alternative Emoticon Entry Method

® In hiragana mode, enter 2¢5 or a
descriptive word such as —¢Vor 3 —A),
then convert the entry.

EmoticonWordLink

® [mmediately after inserting a descriptive
word such as &L ¢Vor L (),
corresponding emoticons may appear in
the suggestion list.

suoneladQ odiseg

é@ Inserting Phone Book Entry ltems
Deleted Characters

Undo Conversion or Recover
Changing Font Size (P.2-26)

I Hiding emoticons in suggestion list
suggestion list (P.13-6)

Lowering type priorities in

2-13
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Mail & Web Extensions

Enter .co.jp, http:/, etc., easily.

Quick Address List
@sof thank. ne. jp
[H@ezweb. ne. jp
[Bedocomo. ne. jp
[ed. vodafone. ne. jp
[Henh. vodafone. ne. jp
[Het. vodafone. ne. jp
[Hac. vodafone. ne. jp
[Hek. vodafone. ne. jp
I o I

Select extension » [u]

® Extensions are single-byte even in
double-byte entry modes.

GIEGERER N €1ELELET
Alphanumeric Conversion

Enter katakana and alphanumerics in
hiragana mode.

Example: To enter PTA

Use key inscriptions.

X/XCandidates

Select word/phrase » (1]



: Text Entry I—
Deleting & Editing Select target location ®» [ ]+67] or [ J+[c ™)

Enter characters Press [ ]+ 7] to cut or [ J+[c 7]

o
Follow these steps to correct &, HEF to copy. &
OLET 0 ELHALBILET p
H-0 BN LET _g
Place cursor after , 5
(character to delete) 2
S
Message : 7]
£ XX/XXK
£z, BEOLET
Recovering Deleted Characters
® Press [[F ]+[z*]] to recover characters
deleted with ] or (7. Select target location ®
Deleting All Characters before Cursor [E' +]
[Le+29) ® Text is entered
Deleting All Characters after Cursor ’
[C]+F2) Pasting Previously Cut/Copied Text
ssage: B Select target location » »
EeBmOLET ] Copy/Cut & Paste Paste » [u] ® [2] Select text » [u]
. ® Available when Paste List appears.
Select start point »
While pressing 4], use ¢ to
highlight text range
® The character before cursor is deleted.
® Press to delete character after
Ccursor.
® To cancel and start over, press [(¥]. g

2-15



User Dictionary

suonesadQ diseg
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Saving Frequently Used Words

Saving Words (Japanese)

Saved words appear among suggestions.

(m] ® (3] Settings » (u] »
Phone Settings » [u] »
User Dictionary # [a]

User Dictionary
Save words/phrases
to User

Dictionary.

Saved Word List
Acquire Dictionary

[ [=]

User Dictionary Menu

New Entry w» [u] » Enter
word » [u]

Enter reading #» [u]

922SH Download Dictionary
(Japanese)

Download specialized 922SH Download
Dictionaries from SH-web Mobile Internet
site. Activate dictionaries to improve
handset character conversion. Dictionary
words appear among suggestions.

Some dictionary files may not be usable.

In User Dictionary menu,
Acquire Dictionary % (u]

Acquire Dictionary
Dictionary 1
Dictionary 2
Dictionary 3
Dictionary 4
Dictionary 5
[=]

Select number » (1] B
Select dictionary » [u]

® Existing dictionary is replaced.

Canceling Dictionary
In &), [2] (select dictionary) » »
Cancel » (u]

Viewing Dictionary Information
In &, [2] (select dictionary) » »
Info » [u]

é? Editing Entries

Deleting Entries (P.2-26)



Phone Book

ing,Phone Book Entri

Enter a name, phone number and mail Add Phone Number: % Category: » (u] »
address (enter at least one of these items) (m] ®» Enter phone number Select Category » (m] o
and classify the entry. » (=] B [3] Select icon » (=] New Entry B [/ 5
Reading—FirstName: Mikio
E » Phone » E » New Entry 8 | Tel 1 B090392XXXX1 -8
Last Name: Ued: Phone Number : ]
Add New Entry » E’ FTfst :a:c: M?k?o b B aabb@xxx. yyy R
Reading-Last Name: Ueda =
New Entry 8 Reading=Firstame:  Mikio *QFriends g
Last Name: Tel 1: B090392XXXX1 »
First Name: Add Phone Number :
Reading-Last Name: Add Email Address:
ZZT&ZiQZ‘LEﬂZTe e I SCN.O falusry Saverd Phone Book Entry Window
Add Email Address: .
Category Qo Category ® To save additional phone numbers,
Address: repeat .
I = I ® Entry is saved to Phone Book.
Add Email Address: » 1 in lls while Creating Entr
Last Name: ® (=] » X ncoming Calls while Creating Entry
Enter last » 1] (w] ®» Enter mail address » ® Contents are temporarily saved. End the
nter last name .
) » [J] Select icon » call to return.
» First Name: % ‘EI E] . EI Phone Book Memory Status
®» Enter first name » [u] SFERRETT e (8] » £ Phone » [s] ® [ Manage
Reading-Last Name:  Ueda Entries » [u] ® (3] Memory Status
New Entry 8 | Reading-FirstName:  Mikio » (u]
Tel 1: B090392XXXX1
Mikio Add Phone Number :
Reading-Last Name: Email 1: B aabb@xxx. yyy
Reading—FirstName: Mikio
Add Phone Number :
Add Email Address: I \ 8‘:N,0 Cate\gory Saverd
Category: LNo Category
Address: ® To save additional mail addresses,
[ = | SaveEd repeat
® Characters entered for names
(reading for kaniji) appear.
(% Saving Other Information (P.2-27) g
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Personal Ringtone

Set tone for calls from saved numbers.

In Phone Book entry
window, (2] (select item,
e.g., Tone-Voice Call:) » [u]

For Voice Call [/ 15058
Assign Tone
Se 1t
Video
J—=—

Assign Tone » [u] »
Select folder » (u]

Select tone/file » [m]

Saving Secret Entries

Restrict access to Phone Book entries by
saving them as Secret entries.

In Phone Book entry
window, (] Secret: » [u]

Secret Ti® 5058
Oon
O0ff
=
On» (u]

Accessing Secret Entries
» ® (3] Unlock Temporarily
» (=] » Enter Handset Code » [u]

Saving Numbers After Calls

After a call, save number to Phone Book.

Call Ended

Save thf$ number
to youk Phone

Book?

X:XX: XX

When confirmation appears,

(8] Yes » [m]

Confirm

Save this number
Rhone

Save to Phone Book XXX XN
As New Entry

As New Detail

[ & T

As New Entry » (=] »
Complete other fields »
Saving to an Existing Entry
In &, (3] As New Detail » [u] »

Select entry » (1] » Complete other
fields »

@ Assigning Images to Phone Book Entries for Incoming Transmissions
Setting Incoming Mail Ring

Customizing Response by Category (P.2-27)

Changing Light Color/Vibration Pattern
Time

1 Changing default storage media for new entries ¢ Hiding confirmation
after calls with unsaved numbers (P.13-6)



| Phone Book I—
Dialing via Phone Book Using Other Options Changing Search Method Temporarily

. After ), [u] » [J] Select option ®» (=] [Entry Search Window] (press @
» Specify katakana row repeatedly to toggle search methods) 73
. Changing Search Method o
AEC T Opening from Other Functions 9
i °
Ko T e T T T L In entry search window, ]
KKondo Koichi 03123XX0X2 ®» (2] Ph.Book Settings » (m]  Example: Enter a recipient via Phone o
., Book when sending a message. S
Sort Entries » [u] 2
SelectiRecipienti T
Phone Book R Phone Book
gselect Gmﬁp
: g Speed Dial Mail
Entry Search Window (By a-ka-sa-ta-na) Usca Mikio 09039240001 B Enter Nomber
Select entl’y » ‘E’ OBy Reading @Enter Address
OBy Category
Phone Book
Kondo Koichi I = [ RcvdMse. K
03123XXXX2 : — : Select Recipient Window
8 090392XXXX3
gazzgx;x. yéyt Select method » |E| Phone Book » E »
< ew Entry> .
® Phone Book Search Methods: Select entry » E
Shows entries that
By Reading | start with specified Select phone number or
Entry Details Reading mail address » (=]
Select phone number By Category | OPens entriesin the ® Recipient is entered.
specified Category ® Omit & if only one number or
Shows entries with address is saved.
©® Handset dials the number; close By a-ka-sa-ta-na Rgadmgsthat s_tart
handset and put Earpiece to an ear. with katakana in
’ the specified row
éi Messaging via Phone Book " Editing Phone Book Entries © Deleting I Switching reference Phone Book ' Prioritizing mail address display in g
Phone Book Entries ¢ Renaming Categories * Moving Categories (P.2-28) entry search window (P.13-6)
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Data Folder

b
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Handset files are organized in folders by file format.

H Preset Folders

Contents

Pictures’

Still images

DCIM

Large still images on Memory Card (images
captured with save location set to SD(DCIM))

Ring Songs-Tones’

Downloaded melodies and other sound files

S! Appli* S! Applications

Music’ Downloaded Chaku-Uta Full® files
Videos' Video images

Books" Downloaded e-Books, etc.

Customized Screen’

Downloaded Customized Screen files

Status Templates

Combinations of Status Icon and Status
Label for S! Friend's Status

Flash®

Downloaded Flash® (animation) files

Other Documents

Other files (Dictionary files, etc.)

2-20

"Contains corresponding Yahoo! Keitai menu shortcut.

Memory Status

® Delete messages/files when memory is low. Handset performance
may be affected when memory is full.
(] » (34 Data Folder % [u] ® (3] Memory Status » [u] »
Phone Memory or Memory Card » (]




: Data Folder I—
(w] & () Data Folder » [u] Select file » [u] m

Data Folder

Pictures Wy Pictograms All images in Pictures or DCIM folder
@i = appear sequentially.

EBRing Songs-To... | bownload

G5! Aol ' In file list, (2] (select file)
i »

Date:-—/~—/— —:—

suonesadQ diseg

Pictures

Pictures
® Unselectable files/folders appear in ® The content plays or appears. £ancii

gray. ® To return to file list, press [&7.
® To show/hide sub folders, select a S! Mail Attachments

folder and press [3]. After ), (5] (select file) » » sates K X6kt
Select folder » (] Send» [u] » [J] As Message » [u] =

To open a sub folder, select it and = When a size list appears, select
attachment size and press [1].

File Options Menu

press (3], Copy Protected Files (=0 or %0) Slide Show » E’
i BLWE 505 O i i : i
Pféf::;:s 6] M‘ym; — Some functions may not be available e Slide Show starts.

£a0C 1M
E2Ring Songs-To...
EAS! Appli

@Music

(=] » Slide Show stops

Changing Interval
| e In =, (=] ® (7] Speed » [a] »
Open Select speed » (u]

o Viewing Images at Manual Speed

File List (m/&€9) (advance frames) or

(reverse frames)

[ZCustomized Sc...
ElOptions |

é@ Switching File List View  Using Files as Wallpaper ¢ Using Files as g
Ringtones (P.2-29)
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Managing Files, & Fold

Adding Folders

(] & 34 Data Folder & [m]
» (3] Select folder » [u]

» (2] Manage ltems » [u]
121 -

My Pictograms

Pictures
Pictures
£&DCIM
EARing Songs-To...
Manage |tems

Create Folder
Change List View >>

Check All Dates—r/mnfm —ime

Size:—KB

| =

Manage ltems Menu

Create Folder w» (u] »
Enter name » (=]

Renaming Folders
After (), (3] (select folder) » »
(2] Manage Items » [u] » (]
Rename % [m] ® Enter name » [u]
® Assign different names to folders within a
layer.

Moving Files

Some files may not be moved.

In file list, (3 (select file)
»

Move » [(u] & (3] Phone
or Memory Card » (]

Select folder » [u]
Move here » [u]
Copying Files

[File List] £5] Select file ® [[F]+[c =]
» (3] Copy here » [u]

. Selecting Multiple Files

In file list, (2] (select file)
»

® Repeat () as needed. (To uncheck,
select a file with & and press [37].)

Hiding Folders

Restrict access to created folders.
Only handset folders can be hidden.

In file list, 34 (select folder)
»

Set Secret ® (u] ® Enter
Handset Code » (u]
Accessing Secret Folders
[File List] » (3] Unlock

Temporarily » [u] » Enter Handset
Code » [u]

2-22

@ Renaming Files
& Folders (P.2-29)

Sorting Files

Canceling Secret

Deleting Files



Use microSD™/microSDHC™ Memory
Card (hereafter "Memory Card") to save
and organize files for use on 922SH.
Use recommended Memory Cards only.
For details, see P.14-19 "microSD™
Memory Card Compatibility.”

Precautions

® Do not force Memory Card into or out of
handset.

® When inserting/removing Memory Card,
do not touch terminals or expose them to
metal objects.

® microSD™ Memory Card has no write
protect switch. Files may be accidentally
erased or overwritten.

® SoftBank is not liable for any damages
resulting from accidental loss/alteration
of information. Keep a copy of Phone
Book entries, etc. in a separate place.

Important Memory Card Usage Note

® Never remove Memory Card or battery
while files are being accessed.

Turn handset power off first.

Open cover

® Rotate to open cover.

Insert card

® With terminal side up, insert card
until it clicks.

® Do not insert other objects into
Memory Card Slot.

Close cover

® Rotate to replace cover.

o |f Bl appears after powering on
handset, Memory Card may not be
inserted properly; reinsert the card.

Removing Memory Card
® Gently push in card and release it; card
pops out. Pull card straight out gently.

Memory Card

suoneladQ odiseg
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Memory Card :
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Format Card

When using a new Memory Card for the
first time, format it on the handset before
trying to save files, etc. Format Card
deletes all Memory Card files, even those
created on other devices.

(m] & (2] Settings » (u] B
Connectivity » [u] »
Memory Card % [u]

e 15058
Num. of Copies
Settings
Check Settings
Reset Settings
are included.

Memory Card

SD Local Contents
Format Card
Memory Status

I (=]

Format Card % (u] »
Yes » (u]

Enter Handset Code » [u]
» ] Yes » (u]

Format Card
Enter Hand

I 0K I
® To cancel, choose No and press [w].

Precaution
® Never remove Memory Card or battery
while formatting; may cause damage.

Opening Memory Card Files

(] & 3] Data Folder » (u]
» (3] Select folder » [u]

®» (3] Change to
MemoryCard » [u]
Returning to Handset Data Folder

After ), ® (5] Change to Phone
» (1]



5 Display & Sounds

Additional Functions

[Standby Window Menu] P.2-7 [Customized Screen Menu] P.2-9 [Ringtone/videos Menu] P.2-10

Customizing Shortcuts Changing Display Option

Canceling Customized Screen

H Changing Default Shortcuts
» (] Select item » » (5]
Assign w [u] ® 3] Select menu item
» (n] B [J] Select new item ® [m]
H Changing Iltem Order
» (7] Select item » » (3]
Move » [u] » [3] Select target

H Showing Always
[Standby Window Menu] (2]
Display Window » [u] »
Always On » [u]

M Disabling Always
[Standby Window Menu] (2]
Display Window » [u] »
Always Off % (u]

® Pressing (2] in Standby opens Calendar.

(] » (3] Settings » [u] »
Phone Settings » (u] » (]
Customized Screen» (=] » (3] Off
» (5] B [I] Yes » [u]

Accessing Source Sites

suoneladQ odiseg

[Customized Screen Menu]
Select Customized Screen »
» (3] Web Access » [u]

® Follow onscreen instructions.
Ringtones

Setting Ring Time for Incoming Mail,
etc.

[Ringtone/videos Menu] (2] Select
item » (8] & (3] Duration » (u] »
Enter time » (=]
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—I Additional Functions :

& Text Entry

[Text Entry Window] P.2-12 [User Dictionary Menu] P.2-16

User Dictionary

Inserting Phone Book Entry Items

suonesadQ diseg

Inserting Line Breaks

Il At the End of Text

[Text Entry Window] [2] or

E Mid-Entry

[Text Entry Window]

Inserting Spaces

[Text Entry Window] (=] or

Using Character Codes

[Text Entry Window] » (3]
Change Character Code » [u] »
(] Character Code » [u] » Enter
four digits (P.14-10)

Clearing Conversion Log

2-26

[Text Entry Window] (=] »
Input/Conversion % (=] » [J] Reset
History % (=] ® (7] Yes » [u]

[Text Entry Window] [[F J+[&a ] (Long)]
» ({4 Select entry or My Details % [u]
» ] Select item » [m]

Editing Entries

Undo Conversion or Recover
Deleted Characters

[Text Entry Window] [(F )+Zz™]]

[User Dictionary Menu] || Saved
Word List » [u] » [J] Select word
» (=] » Edit » (] & Edit reading
> (5] B [J] Yes » [u]

Changing Font Size

Deleting Entries

[Text Entry Window] [[F ]+[= 9] or
[(]+E9)

[User Dictionary Menu] Saved
Word List % (=] ® (3] Select word
» » (2] Yes » (u]



% Phone Book Entry Items

Phone Book Entry

Assigning Images to Phone Book
Entries for Incoming Transmissions

Saving Other Information

| Additional Functions I—

[Phone Book Entry Window] P.2-17

Setting Incoming Mail Ring Time

[Phone Book Entry Window]
Picture: » [u] » (3] Assign Picture
» (=] B (] Select image » (=]

Changing Light Color/Vibration
Pattern

M Light Color

[Phone Book Entry Window]
Select item, e.g., Light-Voice Call: »
[w] & [3] Switch On/Off » (u] »
Select option » [u] ® (3] Light
Color » [u] » [3] Select color » (=]

® To return to Phone Book entry window,
press [&7.

H Vibration Pattern

[Phone Book Entry Window]
Select item, e.g., Vibration-Message:
» [x] » (2] Switch On/Off » [u] »
Select option » [u] B
Vibration Pattern » [u] ® 3] Select
pattern » [u]

® To return to Phone Book entry window,
press [%&7.

H Address

[Phone Book Entry Window]
Address: » (] ®» ] Select item »
(=] » Complete fields » (=] »

[l Office
[Phone Book Entry Window]
Office: » [m] » [{] Select item »
(=] & Enter text » (=] »

Ml Homepage
[Phone Book Entry Window]
Homepage: % (=] ® Enter URL »
(=] » [§] Select type » [u]

M Note
[Phone Book Entry Window]
Note: ® [u] » Enter text » [u]

M Birthday
[Phone Book Entry Window]
Birthday: » [u] » Enter date » [u]

[Phone Book Entry Window]
Tone-New Message: % (u] »
Duration » (=] & Enter time #» (=]

® Available for compatible ringtones.

Customizing Response by Category

(w] & (3] Phone » (=] » [
Category Control » [u] » 3] Select
Category » » (] Select item
» (=] » [C] Select item » [n] »
Customize responses #»

® Customize responses in the same way
as Phone Book entries.

® Available for Categories on handset.

® Handset response settings for Phone
Book entries take priority.

suoneladQ odiseg
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Additional Functions I
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k& Phone Book Entries
| Using Entries |

Messaging via Phone Book

B Phone Numbers

[Entry Details] [2] Select number
» (n] & [3] Create Message » [u]
» (2] S! Mail or SMS » (=] »
Complete message »

M Mail Addresses

[Entry Details] 2] Select address
» (=] » Complete message »

Managing Entries

Editing Phone Book Entries

[Entry Search Window] & Select entry
» (=] & (] Edit » [=] # [{] Select
item ® [m] B Edit » (=] » ]

® Edit Reading after editing names.

[Entry Details] P.2-19 [Entry Search Window] P.2-19

Deleting Phone Book Entries

Moving Categories

H One Entry
[Entry Search Window] (34 Select
entry » » (3] Delete » (u] »
(2] Yes » [u]

H All Entries
(=] » (5] Phone » [u] » |34
Manage Entries % [u] » (3] Delete
All» [u] » [J] Select entry type »
[m] ® (3] Yes » (=] & Enter
Handset Code » (u]

Renaming Categories

(m] » (5 Phone » [m] » [
Category Control % (] » [
Select Category » (=] » 3] Edit
Name » (=] » Enter name » (]
® To edit Categories on USIM Card, press
before selecting a Category then
select Change to USIM and press (u].

(m] & (3] Phone » (=] » (5]
Category Control % (] »
Select Category » »
Select target location » [u]

® View for By Category Phone Book
search changes accordingly.

® To edit Categories on USIM Card, press
before selecting a Category then
select Change to USIM and press [u].



L& Data Folder Contents

Handling Files

Switching File List View

[Manage Items Menu] Change
List View » (] & (2] Select option
» [u]

Using Files as Wallpaper

[File Options Menu] [&] Set as
Wallpaper » (=] » [u]

® For images smaller or larger than
Display, select an option and press [m].

® When a confirmation appears, follow
onscreen instructions.

| Additional Functions

I_

[Manage Items Menu] P.2-22 [File Options Menu] P.2-21 [File List] P.2-21

Using Files as Ringtones

Sorting Files

[File Options Menu] (2] Set as
Ringtone » [u] ® [] Select item
» [u]
® For For New Message and For New
PC Mail, enter ring time and press [u].
® When a confirmation appears, follow
onscreen instructions.

Managing Files/Folders

Renaming Files

[File Options Menu] |¢] Manage
Items » (1] ® [] Rename » [u] »
Enter name ®» (=]

[Manage Items Menu] (2] Sort »
(=] » [2] Select method » (=]

® To reverse the order, sort by the same
method again.

Canceling Secret

Unlock Secret folders temporarily
and 3] (select Secret folder) »
» (2] Unset Secret » [u] »
Enter Handset Code » [u]

Deleting Files & Folders

M Single Files

[File Options Menu] (2] Delete %
[w] & [3] Yes » [u]

H Folder & All Created Files

[File List] 3] Select folder » »
Delete ® (=] % Enter Handset
Code » [u] » [J] Yes » (u]

suoneladQ odiseg
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Handset Closed
Placing a Call Answering a Call Entering Phone Numbers

Follow these steps to place a Voice Call @ to accept the call Use Sensor Key to enter digits with
9 from a Dialed Frequency record. ® Call connects. handset closed; place a call or send touch
= t i 1.
3 @ @ ® Call ends ones during a cal
. [ve] or (9 (Lon
{Dialed Freaq. ) Yalon Earpiece Volume m @ ( g)
M1]09392XXXX1 During a call, (<] or (=] H Enter Number » B

[2lKondo Koichi Call Operations
® Press when a call arrives or during a
call; select an item and press B.

Dialed Frequency
® Dialed Frequency opens; use & to
open Received Calls, etc.

H Select record » [1)

® Handset dials the number.

H Select digit » B
o Press @ to correct entry.
® Repeat ©) to add digits.

() » call ends

Dialing via Phone Book
or (1) (Long) » H Phone Book
» B0 » 2B Selectentry» B » H
Select phone number » (1]
® Omit step for phone number if only
one number is saved.

ﬁ -r Hiding caller's number/name ¢ Changing number entry view (P.13-4)




Placing a Voice Call

Enter phone number with
area code

Enter Number

BCall
Rlkd:Video Call
[@:Calculator
[@: Int’ | Call

03123XXXX1

Dial Window

In—Cal |

Call Time X:XX

03123XXXX1

ElOptions o] [
Voice Call Window

©® Handset dials the number; close
handset and put Earpiece to an ear.

or (i) ® Call ends

Correcting Numbers
In €, (=] (place cursor under the digit)
»

m Press [[F ]+[%7] to delete the digits

above and after the cursor.

Earpiece Volume
During a call, or

After Calls with Unsaved Numbers

® Save to Phone Book confirmation appears.

Placing an International Call

Apply for International Call Service
beforehand.

Enter phone number with
area code »

Int'l Call & [u]

Int’ | Call T

[B4% Y2 (GBR)
[B4597 (ITA)
[WA4A (CHE)
[HA" 4 (ESP)
M+ 17 (OEV)
[E+ Wi b (PRT)
I = I

Country Code List
Select country » (=] »

©® Handset dials the number; close
handset and put Earpiece to an ear.

®» Call ends

Calling Unlisted Countries
In ©), (8] Enter Code » [u] ® Enter
country code » [u] »

(43 Dialing from Call Log Records
Adjusting Earpiece Volume
Microphone
-3-13)

Recording Caller Voice

Sending/Blocking Caller ID
Switching Sound Output
Using Speaker Phone (P.3-12

Muting

1 Setting handset to beep once each minute during Voice Calls
Showing Call Cost after each call

Activating auto Voice Call answer when handset is closed (P.13-7)

Hiding Call Time during calls

Voice Calli

Voice Calli

Buyjed




Voice Calling :

Buijed

Placing Calls while Abroad

See below to place a call to Japan from
abroad.

Apply for Global Roaming beforehand.
http://mb.softbank.jp/mb/en/global_service/

Enter phone number with
area code »

Enter Number fll®

B:Call
Bfd:Video Call

Call Options
Call

Video Call
Call S! Circle Talk

Save to Phone Book >> 3123XXXX1
T =

Int'l Call» (=] » 3] A%

(JPN) » (2] »

©® Handset dials the number; close
handset and put Earpiece to an ear.

® Call ends

Calling SoftBank Handsets

® In ), always select (] A% (JPN).

Calling Landlines & Mobiles within the

Same Country

® Perform steps in "Placing a Voice Call"
on P.3-3.

Calls Overseas

® Calling may not be possible outside Japan.
Connections depend on available network,
signal strength, and handset settings.

Answering a Voice Call

Incoming Call window opens for a call.

Voice Call... il

C«

EOptions [

090392XXXX2

Answer |

Incoming Voice Call Window

to accept the call
® Close handset and put Earpiece to
an ear.

®» Call ends

Muting Ringer Temporarily

@ Rejecting Calls
Headphones

Placing Calls on Hold

Answering with
Recording Caller Messages (Answer Phone) (P.3-12)



Record caller messages on handset.
Answer Phone cannot be used when
handset is off or out-of-range. Use
Voicemail to record caller messages when
Answer Phone is not available.

(Long)

i [E]|

0K [
® Answer Phone is set.

Canceling Answer Phone
(Long)
H When Answer Phone is Active
For unanswered calls, outgoing message
plays and recording starts.
If the call is answered during recording,
no message will be saved.

. Playing Messages

|__Play Messages [ B58
No. 1 Playback
XXXX/XX/XX 15:05

XXsec

090392XXXX2

e lete Next

® Playback starts; close handset and
put Earpiece to an ear.

® Playback ends automatically after all
messages have played.

® Playback Operations:

Volume Control | (2 Q)/[C S or (< ]/[>]
Replay/Skip =)

Backward

Stop

ilc::-':vard (= or

Delete » (2] Yesw [u]

: Voice Calling

Playing Messages with Handset Closed
(1 (Long) » H Play Messages » B
m Playback Operations:

Volume Control | (<]/[>]

Stop 0]

Skip Forward

Delete » HvYes» B

Buyjed




Video Calling
Answering a Video Call

View the other party's image or send an
Outgoing Image to compatible handsets.

Video Call

Buijed

MuteEd
L Outgoing
Image

Incoming -
Image
® Press (] to toggle image view.
Important Video Call Usage Notes
® |f both parties are not using the same
Video Call system, call may be
interrupted. (Video Call charges apply.)
® Video Calls cannot be placed while TV is

active.

Placing a Video Call

Enter number » (Long)  Incoming Call window opens for a call.

Video Call 15:058)

XX: XX B 090392XXXX1
Video Call Window
® Call is accepted and image appears.

® Call ends

After Calls with Unsaved Numbers

® Save to Phone Book confirmation appears.

Muting Microphone
[Video Call Window]

= To cancel, press [].

Incoming VideoCal | B[ N ]

(&

[ Answer |

090392XXXX2

ElOptions
Incoming Video Call Window

to accept the call
» Call ends

Answering without Camera Image
[Incoming Video Call Window] [u] »
Yes » (u]

m Video Call charges apply to the caller.

When Handset is Closed

® Open handset and press [£].

Toggling Outgoing Images
After (),

é? Rejecting Calls © Placing Calls on Hold
Headphones

Sound Output

Answering with
Answering Video Calls Automatically
Canceling Speaker Output (P.3-12 - 3-13)

Switching
Images

I Showing Call Cost after each call
Changing quality of Incoming Images
Canceling Loudspeaker for Video Calls (P.13-7)

Hiding Call Time during calls
Changing quality of Outgoing



Speed Dial
) Select phone number (¢

® Select mail address prompt appears.
- (entry number)

Save phone numbers to Speed Dial/Mail

list for easy dialing. Do not Assign » [u] » o
To save mail address instead, select . : 2
» 2] Phone » ® Handset dials the number; close =
EI . E] one and press [=]. handset and put Earpiece to an ear. a=:’
Speed Dial/Mail » (=] ® To place Video Calls, Long Press [(2].
STECaIE A | S . - ® To save additional phone numbers, Dialing with Handset Closed
e repeat ) - (i (Long) » H Speed Dial » B »

El <Empty>
M <Empty> Using Headphones for Speed Dial H Selectentry % (]

%zgx”:yi ® Save a phone number to [1]. BT LG e _
4 o |n Standby, Long Press Call Button until a

[E <Empty> .
M <Empty> double beep sounds; handset dials the
B <Empty> number saved in [1. To end the call, Long

=
S Press Call Button until a beep sounds.
Speed Dial/Mail List

Select number » [u] »
Select entry » [u]

é@ Canceling Speed Dial Entries (P.3-13)



Open recent dialed/received call records.

(@] All Calls Ti® 5058
- B 8

= 090392XXXX1 XX/XX/XX 15:05

‘g £ BKondo Koichi XX/XX/XX 12:00

£ B 090392XXXX3 XX/XX/XX 10:45

| View |
Call Log Window
® All Calls opens; press |7 to open
Dialed Numbers, Dialed Frequency
and then Received Calls.

Select record » [m]

When the Same Number is Dialed More

Than Once
® Only the last record appears. (All records
appear for S! Circle Talk.)

m @9 Sending Messages ¢ Saving Phone Book Entries © Deleting Call Log
Records (P.3-13)




Call Time & Call Cost

Call Time

Check estimated time of the most recent

call and all calls.

Dialed Calls or Received

Calls » (u]

(m] & (3] Settings » (=] »

Call/Video Call » (u]

Call Time & Cost W [u]
T

Call Time & Cost
Call Timers
Data Counter
Call Costs

Dialed Calls
Received Calls

Call Time & Cost Menu
Call Timers » [u]

Call Timers
Dialed Calls
Received Calls
Clear Timers

View the estimated
call time of
dialed call(s).

Call Timers Menu

Call Cost

Check estimated call charges for the most

recent call and all calls.
Call Costs (including M

ax Cost) may be

unavailable depending on subscription

status.

In Call Time & Cost menu,

Call Costs

Call Costs
Show Call Cost
Cost Units

Max Cost/Residual

» (u]

Check estimated
call charge of the
most recent call
or all calls.

Call Costs
Show Call

Menu

Cost» [u]

Buyjed

ééi Resetting Call Timers

Resetting Call Costs (P.3-14)

I Checking the most recent packet transmission volume © Checking all

packet transmission volume (P.13-7)




Optional Services

Buijed

Call Forwarding and Voicemail can only

be set simultaneously when Call
Forwarding is set to Video Calls.

Automatically divert all or all

Initiating Call Forwarding

Follow these steps to divert calls to a
phone number saved in Phone Book after

ggll’lwarding unanswered incoming calls to selected ring time (No Answer set).
another preset phone number E » Settings » E »
Redirect all or unanswered ;

Voicemail calls to Voicemail Center; Call/Video Call % ‘E
access messages from ; PG
handset/touchtone phones Voicemail/Divert % ‘EI

Call Answer incoming calls or Voicemail/Divert F(H ] 5058

Waiting open another line during a call D Aetivate il
Switch between open lines Cancel All Delete jcon .

Conference | ' nnect multiple lines at Status

Call -
once for teleconferencing

n Restrict incoming/outgoing
Call Barring calls depending on conditions ] = ]
Caller ID Show or hide your own Voicemail/Divert Menu

number when placing calls

"A separate contract is required.

Diverts » [u] »
Select call type » [u]

No Answer » [u]

Phone Book ®» (=] »
Select entry » (=]

Select phone number » [u]

® Omit (&) if only one number is saved.

(m]
Select ring time » (]

Diverting Calls without Handset Response
In @), [§] Always & [u] & () -

Entering Forwarding Number Directly
In &, (3] Enter Number » (=] »
Enter phone number » [u] »
Select ring time » [u]

Initiating Voicemail
Follow these steps to divert calls to
Voicemail Center after selected ring time

(No Answer set).

In Voicemail/Divert menu,
Voicemail % [u] »
Activate » [u]

No Answer » [u]| »
Select ring time » (]

Diverting Calls without Handset Response
In &, [£] Always » [u]

3-10
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| . N
| Optional Services I—

. Missed Call Notification . Playing Messages Canceling Call Forwarding/Voicemail

Activate this function for records of calls In Call/Video Call menu, In Voicemail/Divert menu,

missed while handset is off/out-of-range Voicemail/Divert » |E| Cancel All » E’
and Voicemail is active.

Voicemail/Divert B[4 _ 15058 Voicemail/Divert RS -]
(m] » Settings » (=] » Diverts netvate il Yoicenail Stop Voicenail and o
Call/Video Call % (u] Cancel Al are” incluged. 5
Status «Q
Call/Video Call
Call Timers
R iy
%g?égﬁméélfmvert are included. [ =1 [ = [
%°mi@§e§“?§?13 Voicemail/Divert Menu Yes E
, : . . es
Hoten. Time/e ‘ Voicemail # [a]
=
Call/Video Call Menu Call Voicemail % (=]
® Follow the voice guidance for further
st Missed Calls » E" E| operations.
° FoIIow‘the voice guidance for further Hiding New Voicemail Message Indicator
operations. In &), (2] Delete Icon » (=] ® (&] Yes
» [u]
(&' [Call Waiting (Separate Contract Required)] [Call Barring]
Activating Call Waiting © Placing Line 1 on Hold to Answer Line 2 Rejecting Calls by Number ¢ Rejecting Calls without Designating
(P.3-14) Numbers ¢ Changing Network Password (P.3-15)
[Conference Call (Separate Contract Required)] [Caller ID]
Opening Another Line during a Call ¢ Switching Between Two Open Showing/Hiding Caller ID (P.3-15) m
Lines (Swap Calls) © Talking on Multiple Lines Simultaneously (P.3-14)
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Additional Functions

k& Additional Functions

Buijen

[Dial Window] P.3-3 [Incoming Call Window] Voice Call: P.3-4, Video Call: P.3-6 [Call/Video Call Menu] P.3-11

Placing a Voice Call/Video Call Receiving a Voice Call/Video Call

Dialing from Call Log Records

Rejecting Calls

Answering Video Calls Automatically

» [ Select record ®»

® To place Video Calls, Long Press (2.

[Incoming Call Window] »
Reject % [u]

Sending/Blocking Caller ID

[Dial Window] » (3] Hide My
ID or Show My ID » [u]

Placing Calls on Hold

Adjusting Earpiece Volume

[Incoming Call Window] @
when handset is closed)

® Press or [9) to answer the call on hold.

3-12

(m] » 5] Settings » [u] »
Phone Settings » (u] » [§]
Earpiece Volume » (u] »
Adjust level » (=]

Answering with Headphones

[Incoming Call Window] Long
Press Call Button

® To end the call, Long Press Call Button
until a beep sounds.

Recording Caller Messages
(Answer Phone)

[Incoming Voice Call Window]
» (3] Record Message » [u]

[l Saving Numbers to Auto Answer List

[Call/Video Call Menu] Video
Call % (] » [3] Remote Monitor
» (u] » Enter Handset Code » (u]
» (3] Auto Answer List % (=] »
<Empty> % » (2] Change »
(=] & [3] From Phone Book or
From Call Log ® (] & 34 Select
entry » (=] ® [J] Select phone
number » (u]

® For From Call Log, omit steps for

Phone Book entry.

® To enter a phone number directly,

select <Empty> and press [u].

H Activating Remote Monitor

[Call/Video Call Menu] [¥] Video
Call % [u] & (3] Remote Monitor
» (=] ® Enter Handset Code ®» [u]
» (3] Switch On/Off % [u] » (3]
Onw (] » [u]

® A tone sounds for calls answered via

Remote Monitor. (Tone and volume are
fixed.)

® Remote Monitor is effective only when

handset is open.



| Additional Functions I—

% Additional Functions
[Call Window] Voice Call: P.3-3, Video Call: P.3-6 [Speed Dial/Mail List] P.3-7 [Call Log Window] P.3-8

Call Window Operations Using Speaker Phone Call Log

Switching Sound Output

Sending Messages

(¢
[Voice Call Window] (=] » (=] s
® To cancel, press [m]. a=_:’
[Call Window] » Transfer . Video Call [Call Log Window] [¢] Select record
Audio ® (] & [2] To Phone or To » » (3] Create Message » [u]
Bluetooth » [u] Canceling Speaker Output » (2] S! Mail or SMS » [u] »
- Complete message »
. Voice Call
- - [Video Call Window] » Saving Phone Book Entries
Muting Microphone Loudspeaker Off % [a]
® To activate Speakers, select [Call Log Window] | 2] Select
[Voice Call Window] » Loudspeaker On. record » ® [3] Save to Phone
Mute Microphone # (u] Speed Dial Book % (] & (2] As New Entry %
e To cancel, select Unmute Mic.. [=] » Complete other fields »
Recording Caller Voice Canceling Speed Dial Entries ® To add to an existing entry, select As
New Detail.
[Voice Call Window] (=] » [Speed Dial/Mail List] &4 Select Deleting Call Log Records
Record Caller Voice % [u] » entry % » (2] Remove
Recording starts ® [a] Selected » (] » [3] Yes » [u] H One Record
Recording ends [Call Log Window] [£] Select
® To play recorded messages, see P.3-5 record » » (5] Delete » [u]
"Playing Messages." » (0] Yes » [u]
M All Records
[Call Log Window] »
Delete All % (=] ® Enter Handset
Code » (8] B [J] Yes » [u] m

3-13
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k& Additional Functions

[Call Timers Menu] P.3-9 [Call Costs Menu] P.3-9 [Call/Video Call Menu] P.3-11 [Voice Call Window] P.3-3

Resetting Call Timers

. Service Status

Call Time & Call Cost Optional Services [l conference Call (Contract Required)

[Call Timers Menu] (2] Clear
Timers » (1] ® Enter Handset
Code » [u] & (3] Yes » [u]

Checking Service Status

Opening Another Line during a Call

Resetting Call Costs

3-14

[Call Costs Menu] [&] Show Call
Costw [a] » » Enter PIN2 »
(m] » (5] Yes » [u]

[Call/Video Call Menu] (¢] Select
service ® (] & (3] Status » [u]
® For Call Barring, select restriction and
press [m].

. Call Waiting (Contract Required)

[Voice Call Window] Enter phone
number »
® Press (4] to select a number from
Phone Book or Long Press to
select from Call Log records.

Switching Between Two Open Lines
(Swap Calls)

Activating Call Waiting

[Voice Call Window]
® Press to switch between two lines.

[Call/Video Call Menu] (2] Call
Waiting » (=] » [2] On » (u]

Talking on Multiple Lines
Simultaneously

Placing Line 1 on Hold to Answer
Line 2

[Voice Call Window] A tone

sounds during a call »

to switch between two lines.

® Press to end active line and
re-engage the party on hold.

[Voice Call Window] While
switching between lines, »
Multi Party » [u] & (3] Conference
All » [u]



& Additional Functions

. Call Barring

Rejecting Calls by Number

[l Saving Phone Numbers

[Call/Video Call Menu] (2] Call
Barring ® (u] ® [3] Rejected
Numbers » (8] & [J] Black List %
(=] » (2] Set Reject Number » [u]
» [J] <Empty> % (=] & Enter
phone number » (=]
® Activate Black List to reject calls from
saved phone numbers.
M Activating Black List

[Call/Video Call Menu] (2] Call
Barring % (=] ® (2] Rejected
Numbers » (8] & [J] Black List %
(=] ® [2] Switch On/Off % [=] »
On » (=]

Rejecting Calls without Designating
Numbers

| Additional Functions I—

[Call/Video Call Menu] P.3-11

Changing Network Password

H Calls from Unsaved Numbers

[Call/Video Call Menu] [2] Call
Barring % (u] ® [J] Rejected
Numbers % (1] » (3] Unknown »
(m] » [3] On» (u]

M Calls without Caller ID

[Call/Video Call Menu] (2] Call
Barring % (] ® (2] Rejected
Numbers » (=] » (3] Withheld »
(=] » (5] On » [u]

M Calls from Public Phones

[Call/Video Call Menu] Call
Barring % (] ® (3] Rejected
Numbers % (8] & (3] Payphone »
(=] » (5] On » [u]

H Calls with Undisplayable Caller ID

[Call/Video Call Menu] [2] Call
Barring % (u] ® [J] Rejected
Numbers % (8] ® (3] Unavailable
» (8] (3] On » [u]

[Call/Video Call Menu] |¢] Call Barring
» (u] » (5] Change NW Password %
[=] ® Enter current Network
Password ® (u] » Enter new Network
Password ® (=] ® Re-enter new
Network Password » [u]

Il caterip

Showing/Hiding Caller ID

[Call/Video Call Menu] (2] Show My
Number ™ [u] % (2] On or Off » (u]

Bujes
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Emergency Calls
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Emergency Calls

I Handset Restrictions &

Your location is automatically reported to
the corresponding agency (police, etc.)
when you place emergency calls (110, 119
or 118) with SoftBank 3G handsets.
(Emergency Location Report)
922SH reports Location Information based
on positioning signals from radio stations.
® Registration/transmission fees do not apply.
® Positioning accuracy is affected by
location/signal conditions. Always provide
your location and purpose on the phone.
® Location Information is not reported when
emergency calls are placed without Caller
ID (such as when the number is prefixed
with 184). However, the corresponding
agency may obtain your Location
Information in a life threatening situation.
® Not available during international roaming.

Emergency Calls

Emergency calls are possible even while
some handset restrictions are active.

Active Restriction

Emergency Calls

Max Cost

Function Lock (P.11-2)

Outgoing Calls

Possible

Offline Mode (P.1-15)

Keypad Lock (P.1-12)

PIN Entry (P.11-2)

Restricted
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Messaging
Use the following messaging services.

_m H Available Entry Items

Exchange up to 160 alphanumerics Becipient| RSubiscty [Messagel [
with SoftBank handsets. SMS | Available’ | N/A | Available | N/A

S! Mail | Available | Available | Available | Available

=

8 PC Mail | Available | Available | Available | Available

] .

D m SoftBank handset numbers only.

Q ) )

3 Exchange up to 30,000 characters ® A separate contract is required to use
with e-mail compatible handsets, S! Mail and receive e-mail from PCs, etc.

PCs, etc; attach media files, etc. ® For more information, see SOFTBANK

MOBILE Corp. Website (P.14-19).

Send Graphic Mail; set Feeling
Setting in subject field when

messaging SoftBank handsets. Auto Retry Function

If recipient's handset is off/out-of-range, a

m sent message is saved in Server Mail Box
Receive or reply to PC mail account and delivery attempted at regular intervals.
messages. Use 922SH to handle PC (Undeliverable messages are deleted.)

Mail messages like SMS or S! Mail.
Auto Resend

When Auto Resend is active, handset
automatically resends unsent messages up
to two times. Cancel to disable (P.13-8).




Messaging

Change alphanumerics before @ of the
default handset mail address.

For more information, see SOFTBANK
MOBILE Corp. Website (P.14-19).

Changing Address

» ] Settings » (u]

Settings
Address Settings
General Settings
S! Mail Settings
PC Mail Settings
SMS Settings
Speed Dial/Mail
Set Mail Group

i

Connect to My
SoftBank menu page
and customize your
mail address as
your choice.

=

I

Settings Menu
Address Settings » [u]

® Handset connects to the Internet.
Select English and press [m], then
follow onscreen instructions.

Saving Address

When handset address is changed, SoftBank
sends new address confirmation via S! Mail.

Information

[ I

Cancel I

0

To save new address to My Details, follow
these steps. (New address is effective
even if not saved.)

Message » [u]

Received Msg.
o Mail
© Folder 1
& Folder 2
B Folder 3

Unread 1

®Kimura Tetsuya

EDXXXXXXXXXXXXXXX
EBXX/XX 15:05
TBIXXXXXXXXXXXXXXXXXXXXXXXXXXXX
XXXXXXXXXXXXXXXXXX

Checki

Information » [m]

Received Msg.
o Mail

The information
which nofifies
your Maid Address
is included in
this message.

Yes

Unread 1

o= 5|

2/ 2

KXXXXXXKXXXXX

(@] Yes » [m]

Edit Entry
Last Name:

First Name:
Reading-Last Name:
Reading—FirstName:

Add Email Address:

Tel 1: B8 090392XXXX5
Add Phone Number :
Email 1: B ccc@xxx. yyy

= SaveEd

Buibessayy




Sending Messages

Follow these steps to send S! Mail to a
number/address saved in Phone Book.

When a PC Mail Account exists, select
S! Mail and press [u].

B Bhttach

<Enter Text>

Buibessapy

El0ptions. | Edit

S! Mail Composition Window

Select recipient field » (=]

Select Recipient [/ 15058

@Select Group
B Speed Dial/Mail
B Enter Number
@Enter Address

Phone Book % (u]
Select recipient ® (1]

Select number or mail

address » [u]

® Omit & if only one number or
address is saved.

® \When a mail address is entered, do
not use single-byte katakana in
message text or subject.

Select subject field » (=]
®» Enter subject » [u]

<Enter Text> » (u]

Text Entry Window

Enter message » [u]

QlUeda Mikio
B Wedding

ElOptions
S! Mail Composition Window

®» Transmission starts
® To cancel, press during
transmission.

Incoming Calls while Creating Message
® Content is saved temporarily. End the call
to return.
Previewing Outgoing Message
After ), » (0] Preview Message
» [u]
Checking Cross-Carrier Pictograms
After ¢, » (3] Pict Setting W (u]
» (2] Select carrier » [u]
m Pictogram appearance may differ by
carrier.

é’ Using Other Recipient Entry Methods © Adding Recipients
Inserting Signature Automatically © Speed Dial/Mail List ¢ Saving
without Sending © Auto Send when Signal Returns © Designating
Send Date/Time (within one week) © Canceling Sent S! Mail
Requesting Delivery Confirmation (P.4-8 - 4-9)

I Hiding progress bar while sending messages © Disabling automatic
resend of unsent messages (P.13-8)



Attaching Files

Follow these steps to attach images to S! Mail.
Send attachments to compatible handsets.

In S! Mail Composition
window after composing
message, (0] 4 Attach

5 e

R Ueda Mikio XXXB

B Medding [Ere )

?j Attach File

ElOptions | =] [ SendEd

Attach File & [u]

Attach File Yi® 058

Picture

Sound

Video

Flash®

Phone Book Entry
Calendar/Tasks

Notepad
Templates

[ © [
Picture W [u] »

Select folder » [m]

Select file » (=]

When a size list appears, select
attachment size and press [m].

525! Mail T 5
L |Ueda Mikio
B Wedding

Attach File

. ImageXXX. jpg

|E=0pt ions [ (=] |

Attach File Window
® Repeat &) - ©) to attach more files.

® Transmission starts

Attaching Non-Image Files

®n

, select a folder other than Picture

and press (], then select a file.

: Sending Messages

I_

Sending Feeling Mail

In S! Mail Composition window
after composing message,

» (0] Feeling Settings » [m]

Feeling Settings
Happy/Glad

©0K/Good

€9Sad/Sorry

QNG/Bad

Z Imp. /Notice

[ o T

Select category, e.g.,
Happy/Glad » [u]

Select item, e.g., / Love

You w» (u]
K Ueda Mikio XXXB
B[/ Wedding BT (2

Please bring a camera and a tripod to Mr.
Yamamoto and Miss Kawahashi’s wedding next

Sunday. | will bring a camcorder.

ElOptions [ Edit [ SendEa
® Transmission starts

Canceling Feeling Mail

[S! Mail Composition Window]

Select subject field # (=] ® (=] Select

Pictogram, e.g., 7 » » (=

Buibessayy

é@ Set Auto Play File (P.4-9)
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Buibessayy

Sending Graphic Mail

Follow these steps to:

® Change font size and background color
® |nsert images and My Pictograms

® Scroll text

In text entry window,

[ )+(2]]

:Dict

(B8 | ¥0F S B e e B

B S N
Font Color: %]
[ [ =] [ P )

Graphic Mail Window
Font Size: % [u]

Select size » [u] »
Enter text

:Dict

Good morning!k

» (3] BG Color: » [u]
» (3] Select color » (=]

Message :

|l &) £ Dict  XKK/KKK

» (3 Picture w» (u] »
Select folder » (u] »
Select file » [u]

Select location » (=]

»

O] W b3 yPlctogram »
(m] B - . Select file
» (=]

:Dict XXX/XXK

EOptions I Done: Add ArtEa

» (] Effect » (u]
Scrolling » [u]

:Dict XXX/XXK

EA’
Good morning!l

58l 0se Menu

Select direction » (=] B
Enter text

(m] » ®» Transmission
starts

Canceling Last Action
[Graphic Mail Window] 5 Undo » (=]

Canceling All Graphic Mail Settings
[Graphic Mail Window] (34 Cancel »
(w] B [2] Yes » [u]

Saving as Templates
After (), (u] B » (2] Save as
Template % (8] » Enter name » [u]
» (] Save here » (]

m Only the message text is saved.

@ Creating Graphic Mail from Templates
Effect (P.4-9)

Changing Text Color, Size &



: Sending Messages I—
Follow these steps to send SMS to a Select recipient » [u] ®» Transmission starts
number saved in Phone Book.

Select number » (=] Incoming Calls while Creating Message
®» (] Create New SMS o _ e Contentis saved temporarily. End the call
» E ® Omit © if only one number is saved. 6 EUTL
- Select message text field When Message Text Exceeds Limit =
2 AG Rec (plent » (1) ® A confirmation appears. To convert SMS ]
Enter Text to S! Mail, follow these steps. 3
Yes » (u] ‘g
@
[=0ptions I Edit I
SMS Composition Window
. . i D Cance K
Select recipient field #» (=] Eootions Do Goeel@
Text Entry Window
Select Recipient
% Select Croup Enter message » [u]
B Speed Dial/Mail =
B Enter Number SRASMS ‘. T BE
L Ueda Mikio
See you at the meeting today!
| = | Rcvdsg. B2
Phone Book ’ E] |E0pt ions | Edit ] Senda|
SMS Composition Window
é? Using Other Recipient Entry Methods © Adding Recipients  Speed I Hiding progress bar while sending messages * Requesting Delivery
Dial/Mail List © Saving without Sending © Auto Send when Signal Report for all messages  Disabling automatic resend of unsent messages
Returns ¢ Designating Send Date/Time (within one week) Changing Server sent message storage limit (P.13-8, P.13-10)

Requesting Delivery Confirmation (P.4-8 - 4-9)




Additional Functions

& Messaging

Buibessay

Using Other Recipient Entry Methods

[Composition Window] [&] Select
recipient field ® (=] ® [3] Select
method ® (=] » Select/enter
number/address » (1]

Adding Recipients

[Composition Window] [&] Select
recipient field ® (=] ® [3] Add
Recipient » [u] ® [3] Select
method » [u] » Select/enter
number/address » [u]

Inserting Signature Automatically

» (3] Settings » [u] »

S! Mail Settings % (u] » [3]
Signature Settings W (] » [3] Edit
» (u] & Enter signature » (u] »
Auto Insert® (u] » (3] On » (=]
® Signature is inserted above message

text when forwarding messages or

quoting original message text in replies.
® Not available for SMS.

Speed Dial/Mail List

[Composition Window] S! Mail: P.4-4, SMS: P.4-7

Sending Messages

l Saving Recipients

» ({] Settings » (] B
Speed Dial/Mail » (=] »
<Empty> " [u] ® [ Select Phone
Book entry » (=] & [J] Select
number/address ® (=] ® (3] Do
not Assign » [u] »

H Creating Messages

In Standby, - (Speed
Dial/Mail entry number) »
® \When messaging to SoftBank handset
numbers, select S! Mail or SMS and
press [m].

Saving without Sending

[Composition Window] »
Save to Drafts » (u]

Auto Send when Signal Returns

[Composition Window] »
Send Reservation » [u] » [ Within
the Network » [u] & [3] Yes » [u]

Designating Send Date/Time (within
one week)

[Composition Window] »
Send Reservation % [u] ® (§] Date
& Time % [u] & Enter date/time »
(=] » (5] Yes » (m]

Canceling Sent S! Mail

» (0] Sent Messages » [u] »
(2] Select folder » (=] » [J] Select
message » » (3] Set Sent
Cancel » [u] » [J] Yes » [u]
® Available for messages sent to
SoftBank handsets.



| Additional Functions

5 Messaging

[Composition Window] S! Mail: P.4-4, SMS: P.4-7 [Attach File Window] P.4-5 [S! Mail Composition Window] P.4-4 [Graphic Mail Window] P.4-6

. Y Mai
Requesting Delivery Confirmation M W Opening Templates from S! Mail

[Composition Window] »
Messaging Settings » (=] » [3]
Delivery Report® (u] & (3] On w (]
® Delivery Report arrives when message
is delivered.
® Not available for PC Mail.

Set Auto Play File

[Attach File Window] (] Select file

» » [3] Set Auto Play File %
(=] » (3] Switch On/Off % [u] »
On » (u] » [3] Enter Message »

Composition Window

[S! Mail Composition Window]
®» (2] Launch Template » [u] »
Select template ® (=] » Complete
message »

® Open a template before entering
message text.

[w] & Enter comment » (=]
® Not available for PC Mail.

Graphic Mail

Changing Text Color, Size & Effect

Creating Graphic Mail from
Templates

M Opening Templates from
Messaging Menu
» (] Templates » [u] »
Select template » (=] » Complete
message »

® Template size may change when used
for creating messages.

[Graphic Mail Window] »
Specify text & [u] » (5] Font
Color:, Font Size: or Effect % [u]
» Set» (1] »

Buibessayy




Incoming Messages

Opening & Replyi

Opening New Messages

Information window opens for new mail.
® See P.4-21 to receive PC Mail.

[FiFe= [0

Information

1 Message

Buibessapy

| (=] Cancel

® By default, complete S! Mail messages
including attachments are retrieved;
transmission fees apply depending on the
price plan.

Delivery Report
® [nformation window opens for Delivery
Report. Follow these steps to open it.
Delivery Report » (u] » [J] Select
message with report » [u] »

Message » [u]

Receiving Feeling Mail
® Small Light, Vibration and ringtone
respond according to settings.
Corresponding Pictogram (3, etc.)
appears on External Display.
Attached Images
® Attached images open automatically.
Messages with Quiz
Enter or select answer » (1]
m Message cannot be opened until the
correct answer is entered or selected.
Animation View
® When a specific Pictogram is included in
subject or message text, corresponding

Received Msg.
i Mail Mail 3/ 3
O Folder 1
& Folder 2 SdUeda Mikio
© Folder 3 ®Kimura Tetsuya

[BlHov' s it going?

EXX/XK 15:05

Bl ve just finished my work.
e How about you? I' 11 be at the

Message List

Select message » (u]

3D Pictogram Ti®

I’ ve just finished my work. How a
bout you animation appears in message window
? background.

I o] I StopEad

® Message text appears in 3D
animation (3D Pictogram).

Select 3D Pictogram
option » [u]

@ Viewing New Messages on External Display ¢ Opening New Mail Out
of Standby  Retrieving New S! Mail Manually
g List ¢ Reporting Unsolicited Message Sources as Spammers Saving

Attachments to Data Folder (P.4-12)

4-10

Retrieving Server Mail

I Feeling Mail © 3D Pictogram ¢ Disabling Animation View
Disabling automatic S! Mail retrieval in Japan ¢ Enabling automatic
S! Mail retrieval abroad ¢ Disabling image auto-resize ¢ Disabling
image auto-open ¢ Enabling sound auto-play (P.13-8 - 13-10)



: Incoming Messages I—

Checking Messages

» (] Received Msg.
» [u]

® When a folder is highlighted, corresponding
message list appears on the right.
Use [0 to toggle folder/message list.

® When a PC Mail Account exists,
folder with the name specified in
Account Name appears.

Select folder » [u] »
Select message » [u]

Received Msg. 0001 [ 15058

RKimura Tetsuya

ElLater

TXX/XX 15:05

See you at the meeting today!

Message Window

Window Description

. Message List

Received Msg.
o
& Folder 1
& Folder 2
© Folder 3

| ®Kimura Tetsuya=y

[BHow s it going?
fEBXX/XX 15:05
I 1" ve just finished my fork

about

Eloptions | View CheckiEd

1
Message Text
Sender or Recipient
Message Type/Status (see below)

H Message Type/Status

| Mail Notice
| Unread &4| (remaining

portion exists)

& | Read B Léggzi? Delivery
&4 | Sent B8 | Attachments
=4 | Failed @ | Protected
# | Replied 0 | Priority (High)
& | Forwarded © | Priority (Low)
& ggggrvation set fl S Card SMS

sus or pc appears for SMS/PC Mail messages
(53, &%, etc.).

. Message Window

ow about yqu
afound 8 pm.

e just finished my
I"11 be at the place a

ElOptions dent

Message Text
Received or Sent Date & Time
Subject (except for SMS)

Sender or Recipient

Buibessayy

Opening Next or Previous Message
[CFJ+(2]] (next) or [[F2 J+[2]] (previous)
Changing Font Size
[(=]+E9] (enlarge) or [[(F]+E9]

(reduce)

Replying to Messages

In message window,
Complete message »

Replying to Messages Addressed to
Multiple Recipients
After @, (2] To Sender or Reply All
»E»

(GV Using Linked Info ¢ Saving to Phone Book
Opening Received Message for Reference
Message Text
Messages Automatically (P.4-12 - 4-13)

Replying Quickly Using Fixed Text

Copying Text
Quoting Original
Replying to

message list view

-l' Showing complete sent/received message addresses
Changing message window scroll unit (P.13-8)

Changing

4-11



Additional Functions

& Handling Incoming Messages

Receiving/Opening Messages

[Message Window] P.4-11

Linked Info

Reporting Unsolicited Message

Buibessapy

Viewing New Messages on External
Display

L] > H»> B

o Use H to scroll.
® Press to use Quick Reply.

Opening New Mail Out of Standby

(Long)

Retrieving New S! Mail Manually

»

® When a PC Mail Account exists, select
8! Mail and press (m].

® Retrieve messages missed while
handset is out-of-range.

Retrieving Server Mail List

4-12

» (3 Server Mail Box » (=] »
(2] Mail List % [u] » [2] Yes » [u]

Sources as Spammers

[Message Window] »
Report Spam » (u] »
® Signature is not inserted automatically.
® Not available for PC Mail.

Using Linked Info

Saving Attachments to Data Folder

[Message Window] (2] Select file
» » (2] Save to Data Folder
» (=] & Enter name » (8] B
Save here » [u]

H Dialing Numbers

[Message Window] (3] Select
number ® (8] & (3] Call or Video
Call » (=]

M Sending Messages

[Message Window] ¢34 Select
number or mail address ®» (u] B
(2] Create Message » (] » (2]
S! Mail or SMS % [u] » Complete
message »
® For mail addresses, omit steps for mail
type.

H Accessing Internet Sites
[Message Window] (%] Select URL
> (5] B [J] Yes » [u]

® Select PC Site Br. to connect via PC
Site Browser.



% Handling Incoming Messages

Saving to Phone Book

l Saving Sender's Address

[Message Window] » (3] save
Address » [m] ® 3] Select
number or mail address » [u] »
As New Entry » (=] »
Complete other fields »

® To add to an existing entry, select As

New Detail.
W Saving Linked Info

[Message Window] 24 Select number
or mail address » (=] ® (2] Save to
Phone Book or Save Address » [u]
» (3] As New Entry » [u] »
Complete other fields »

® To add to an existing entry, select As
New Detail.

Copying Text

Replying to Messages

Opening Received Message for
Reference

[Message Window] » (2] Rep.
with View » [u] & [J] Select option
» (u] » Complete message »

Quoting Original Message Text

[Message Window] »
Reply » [u] » [{] Select mail type
with (History) ® (=] & Complete
message »

Replying Quickly Using Fixed Text

H Sender/Recipient Number/Address

[Message Window] »
Copy » (u] ® (3] Address » (u] »
Select number/address » [u]
H Subject or Message Text
[Message Window] » (2] Copy
» (u] » (3] Subject or Message Text
» (=] B [ Select first character #»
(=] » 54 Highlight text range ®» (=]

M Editing Quick Reply Text
[Settings Menu] |&] General Settings
» (u] & (3] Send/Compose » (=]
» (] Set Quick Reply » (u] »
Select text ® [u] B Edit text » [u]

H Using Quick Reply
[Message Window] (Long) »
Select text » [u]

H Using Quick Reply with Handset Closed
While message appears, » H
Select text » B » (1)

| Additional Functions I—

[Message Window] P.4-11 [Settings Menu] P.4-3

Replying to Messages Automatically

l Saving Recipients

[Settings Menu] 2| General Settings
» (u] » (3] Send/Compose » [u]
» (0] Auto Reply » [u] »
Address Setting % [u] » (2] Select
blank entry ® (=] ® Select/enter
recipient ® [2] Select mode » (u]
/0) » ) »

® Select saved recipient and press (1] to
edit number/address.

® Auto Reply is not available for PC Mail.

M Editing Reply Text

[Settings Menu] | &| General Settings
» (=] » [J] Send/Compose » [u] »
Auto Reply % (u] » (2] Reply
Message » (u] ® [] Select mode
» (=] B Enter text » (u]

® Edit text for each mode.
® Signature is not inserted automatically.
H Activating Auto Reply

[Settings Menu] |&| General Settings
» (u] » (3] Send/Compose » [u]
» (3] Auto Reply » (=] »
Switch On/Off » (u] & (] On » (u]

® Replies are sent via S! Mail.

® Replies are sent to the same sender
only once after each time Auto Reply is
activated.

® Auto Reply is only available in Japan.

Buibessayy
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Handling Messages
| Select older  |x]

Messages are organized in folders by type. » Received Msg. or & ;:Cie'i”d Hse
i : Sent Messages % [u] D rorder 1 Naveca Hikio

(#Received Msg @Serverilait-Bo

© Folder 3 ®Kimura Tetsuya

= FCreate Message cACreate New SMS Received Msg.
) ¥Retrieve New Msg. =iSettings o Mail EMHow' s it going?
® T —— v Loi2 1ty wark
o Ve just finished my work.
g ®Ueda Mikio Unread 0 How about you? I |1 be at the
Q Coent e @Kinura Tetsuya Checkid
=1 =Unsent Messa
How' s it ? f

@ Egzetn Eljo\der‘ - ‘ §x§7xi 1 ghg Message List

|—_ i s LIS ® Cursor appears in message list; use

Failed Messages i = Collap. i@ to toggle folder/message list.

Sent Messages

Incomplete/Unsent Messages

Received Messages

Auto Delete
® Oldest received/sent messages are

Folder List Select message » (1]

® When a PC Mail Account exists,
folder with the name specified in
Account Name appears.

® Select a folder and press to
hide/show sub folders. Hide sub

Received Msg. 0003
RUeda Mikio

EHow s it going?

BIXX/XX 15:05

I”ve just finished my work. How about you?

deleted automatically to save new ones
when memory is full. Protect important
messages to avoid unintentional deletion.

"Il be at the place at around 8 pm.
folders to open full message list.

El0ptions ]

Message Window

I Canceling automatic deletion of oldest received messages
Canceling automatic deletion of oldest sent messages ¢ Changing
view for Received Msg. folder " Changing view for Sent Messages
folder (P.13-8)

é“f Deleting Messages © Selecting Multiple Messages © Color-Tagging
Messages  Sorting Messages © Opening Sender/Recipient Details
g Forwarding Messages ¢ Sending from Drafts ¢ Sending Unsent
Messages © Using Sent Messages (P.4-22 - 4-23)
4-14




: Handling Messages I—

Protecting Messages Searching Messages Hiding Folders

In message list, (select Search messages by message text, Messages appear in Chat Folders even if
message) » » sender/recipient address, etc. source messages are sorted into Secret
Manage Msg. % (u] ® i Received Msg.or  °'ders
Lock » [u] Sent Messages % (u] In folder list, 2] (select
folder) » =
Canceling Protection » Search % E\ — 2
ecelve IS8.
EReckad[ Search All Msg. % (=] AT é
3
Select method » [u] » @
Select/enter address or text Create New Folder _
» (=] Setsecrar e, cand v
Searching within Mail Folder ——
In &), (8] Search Folder » (] »
Searching Message Text Set Secret » ‘E » Enter
® Follow these steps to find specific words/ Handset Code # [u] # [u]
phrases; limit search by character type. Accessing Secret Folders
[Message Window] (=] # [{] Search [Folder List] (=] ® [Z] Unlock
Text ® (8] » Enter text » (1] Temporarily % (u] » Enter Handset
= Press or to jump to next/ Code » [u]

previous search result.

i
(% (> Searching Messages within Specified Folder © Saving Messages with I Muting ringer, etc. for messages sorted into Secret folders (P.13-8) g
Schedules to Calendar ¢ Canceling Secret (P.4-23)

4-15
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Buibessapy

Sort by Sender/Recipient » Saved

Alternatively, sort by partially matching Sort by Partially Matching Text

text in sender/recipient address, subject In ©, (4] Sender(Inciude),
or SMS message text. Recipient(Include) or Subject % [u]

» Enter text » (=] B

» (3] Received Msg. or
Sent essages »

Select target folder » Follow these steps to filter messages from
handset numbers/addresses not saved in

Ig/(,:]il: Eggs’:nzylg’ TEI Phone Book into Spam Folder.
» (3] Settings » (u] »

Auto Sort Keys
Sender (nclude) General Settings % (=]
Subject .
Anti Spam Measures » (1]
Enter Handset Code » (=]
I — Anti Spam Measures
MUnregistered(Mobile)
OuUnregistered Entry (PC Mail)
Sender(EXact) or E;ndiyidua\é{;omrggn) )
Reci ient Exact ’ ermitted List (Common.
p ( ) \El Recognize incoming S! Mail and SMS not saved in Phone
Select method » (] » S el
Select/enter number/ -
address % E Anti Spam Measures Menu

Unregistered(Mobile) »
(=] (V)
Anti Spam Measures IN{HINNNEEG -

NMUnregistered(Mobile)
OUnregistered Entry (PC Mail)
Olndividual (Common)
CPermitted List(Common)

Recognize incoming S! Mail and SMS not saved in Phone
Book as Spam.

[ Uncheck | Confirmea

=) » (1]

Exempting Messages from Filtering
After ), 2] Permitted List(Common)
» » (] Select blank entry »
(m] » (3] Select key » (u] » Select/
enter number/address/subject » (1]
» » (=] (V) »

When a PC Mail Account Exists

® Filter PC Mail messages from numbers/

addresses not saved in Phone Book.

@ Renaming Folders ¢ Deleting Folders ¢ Adding Folders
Re-sorting Messages ¢ Moving Messages Manually © Sorting Spam

by Setting Keys (P.4-23 - 4-24)
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Chat Folder

Using Chat Folders

Organize messages exchanged between Add New Member » E| Changing Members
handset and Chat members' handsets. Register Nenber R o In ©), [Z] (select member) » »
To hide messages, set Chat Folder to Secret. [1] Change Member % (] % From
Savi Memb % Deleting Members
o in®), 2] (sslect member) # (] #
[5]
® (] Chat Folder » (=] (6] Delete ® (1] » [1] Yes » [u] §
[7] 7]
TR e ——— Opening Chat Folders ‘g.
BGrow® Select blank entry » [a] ® (3] Chat Folder % (8] @&
elect blank entry » (3] Select folder » [u]
® Select saved member to edit number/
address Chat Folder "
) Group()
Ueda Miki XX/XX XX: XX
BOptions | 3 | Select method » IE » LR .
. =] :
Chat Folder List Select/enter number/ g;l;fxg(xxxxxxxxxxxxxxxx IR
ddl’ess ’ ‘E’ gg:ffxxhim;xxxxxxxxxxx o
seIeCt fOIder » a =0wner XX/XX XK:XX
Register Member XX “t)()()( OO0, ‘t?()(
s [Sootions [ View |
[2]
L2 Select message » (u]
Opti
Add New Iﬁemlboenrs [5]
Rename [6]
Create New Folder [7]
Delete Folder [8]
T = [E0ptions | Edit | Confirmm
® Repeat ©) - 5) to add members.
é@ Renaming Folders ¢ Adding Folders ¢ Re-sorting Messages
Deleting Folders © Deleting All Messages * Resetting Chat Folders g
(P.4-23 - 4-24)
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Creating.G for Broadcast Mail

Create Mail Groups to send messages to
multiple recipients at one time.

» 3] Settings » [u]
Set Mail Group % [u]
Mail Groups

<Add New Group>

Buibessapy

[ & 1

Mail Group Entry Window

<Add New Group> » (1]
® Enter name » (=]

Select Group » (1]

XXX T B0

<Assign New Entry>

<Assign New Entry> W [u]
» (] Select entry » [u]

SEICCENERERYIN 1
Ueda Mikio
= I

090392XXXX1
B aabb@xxx. yyy

Select number or mail

address » (=]
XXXX
<Assign New Entry>
Ueda Mikio B 090392XXXX1
I =] I Confirmia

® Omit ) if only one number or
address is saved.
® Repeat (=) - (5) to add members.

Changing Mail Group Members (P.4-24)

4-18
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PC Mail

Receive or reply to PC mail account messages.

Save PC mail account information to handset:
e User Name e Incoming Mail Server
® Password o Outgoing Mail Server

o Mail Address

4" SBM
«.. | Server

.. Yahoo!
> Japan

Retrieve mail delivered to
ISP or Yahoo! accounts.

o Alternatively, use automatic
message retrieval option.

account addresses.

Received Mse. I/ =T ]
@ Mail XXXX 2/ 2
© Folder 1

© Folder 2 &ito Jun

PC Mail

From Ueda
O Folder 1 iXX/XH 15:05

verything yesterday. | might n

in Options menu.)

Messages are saved in unique folders; reply to/send messages via PC mail

(B Nail
© Folder 1
D Folder 2
© Folder 3
=

E’ © Folder 1
Folder |o Foider 2 e e Tt s i B Folder 2

e Handle meésages (sort, etc.) like S! Mail or SMS. (Uhavailable functions do not appear

Important PC Mail Usage Notes

® Receiving PC Mail for the first time after
PC Mail Account setup may incur high
charges due to large-volume packet
transmissions.

® Setting handset to retrieve PC Mail
automatically may incur high charges;
remember this, especially when using
handset outside Japan.

® Other functions may slow while handset
is checking for new messages.

® Checking for new messages may incur
transmission fees even when none exists.

® Single-byte katakana and Pictograms are
not supported.

® When messages sent from handset to PC
mail account are retrieved by handset,
included Pictograms may not appear or
may appear as different characters.

Buibessayy
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PC Mail f

Buibessay

4-20

PC Mail Account Setup

® Proceed with setup according to
information supplied by ISP.

® PC Mail services may not be available
depending on the services, settings or
contract details for your PC mail account.
Confirm compatibility with POP/SMTP
message retrieval/transmission via e-mail
software beforehand.

M Mandatory Items for Retrieval

Required to connect to

incoming mail server

User Name

» [3] Settings W [u] »
PC Mail Settings » [u]

TP

Modify PC mail
account setting.
Available to
create up to 3
accounts.

[ o ]

Required to connect to

Passwor X . :
eS| incoming mail server

Incoming mail server

ReceivingServer
9 address

H Mandatory Items for Transmission

PC Mail Account % [u]
e ls@!

[2]<Empty>

[3]1<Empty>

¥iSet Quick Yahoo! Mail

Mail Address Address to use PC Mail

[ Install |

Outgoing mail server

Sender Server address

Follow onscreen instructions for other
items. Edit information as needed.

PC Mail Account Window
<Empty>w» [u]

Account Name » [u] »
Enter name ®» (=]

Set Receiving W [u] »
Select item » (=] B Select/
enter item » (=] B

® User Name, Password and
ReceivingServer are mandatory.

Set Sending » (=] »
Select item » (=] ®» Select/

enter item » [u]
® Mail Address and Sender Server are
mandatory.

» (o] [u]
® \When a confirmation appears, follow
onscreen instructions.

Using Yahoo! Mail Addresses
In ), (2] Set Quick Yahoo! Mail % (=]
» (2] Yes or No » [u]
m Choose No to create a new account.
® Follow onscreen instructions.
Editing Accounts
In &), [¢] (select account) ® (=] B ) -
Deleting Accounts
In ), [2] (select account) » »
Yes » (u]
Saving User ID & Password for Transmission
® |f User Name and Password are unset Set
Receiving items are automatically used for
SMTP authentication. Follow these steps
if ISP requires User Name and Password:
In &, [2] Set Sending » (=] »
Sender Auth. » (u] & [3] SMTP
Auth. » ®» (3] User Name » (]
® Enter name » (8] & (3] Password
» (=] » Enter Password ® (=] B
» ()%



{ PC Mail

Retrieving New PC Mail

Retrieve new messages from created
accounts. If message count is high, some
may not be received on the first attempt.

»
® To retrieve messages by account,
select one and press [1].

Select folder ® (u] B
Select message » (u]

Received Mse. 0001 [/d 5058

I would like to have a meeting with you ar
ound next week to discuss the next project
. Could you tell me your schedule? | have
a rough idea about what to do with it. Sti
I'l need to think

to be co nued> XKB

|Ii0miuns [
Message Window
® Press to retrieve remaining
portions.
® Message window is similar to that of
S! Mail.

Deleting Messages
[Message List] |¢] Select message
» (2] » [2] Delete » [u] » [3]
Select option » (5] » (3] Yes » (u]
When Handset is Set to Retrieve
Messages Automatically
® Messages are received after set
intervals. (Information window opens.)

Checking Received PC Mail

» (3] Received Msg. »
(] » (2] Select folder » [u]

® Message list appears. Message list is
similar to that of S! Mail.

Select message » (u]

® Message window opens.
Replying to PC Mail

In message window,
® PC Mail Composition Window opens.

Complete message »

I_

Quoting Original Message Text in Replies
[Message Window] » (3] Reply
» (u] » [3] Quoted Reply » (=] »
Complete message »
® HTML messages are converted to plain

text when quoted.
Changing Account while Creating Messages

[PC Mail Composition Window] (2]
Select recipient field ®» [u] & [3] From:
» (] » [J] Select account » (m]

Sending PC Mail

Follow these steps to create and send PC Mail.

Select PC Mail Account
» (=]

Complete message »

Converting PC Mail to S! Mail

After ), » (3] Change to S! Mail
> (2] B [I] Yes » [u]
Note

® Single-byte katakana and Pictograms are
not supported.

0
7 - Saving without Sending

Auto Send when Signal Returns (P.4-8)

-l' Disabling automatic resend of unsent messages
complete PC Mail messages
Changing interval between automatic message retrieval

Retrieving
Retrieving new messages automatically
Disabling

automatic word wrap (P.13-8, P.13-10)

Buibessayy
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s Managing Messages

Managing Messages

Deleting Messages

H One Message

[Message List] 2| Select message
» (@] & [J] Delete » [m] » [3]
Yes » (u]
® Alternatively, delete an open message.
H All Unprotected Messages

[Message List] » (3] Manage
Msg. » (u] » (3] Delete All » [u]
» (3] Except Locked Msg. » (u] »
Enter Handset Code » [u]

H All Messages

[Message List] » (3] Manage
Msg. » (u] » (3] Delete All » [u]
» (3] Delete All » (=] » Enter
Handset Code #» (u]

M All Messages in Drafts or Unsent
Messages

[Message List (Drafts or Unsent
Messages)] » (2] Delete All %
[w] & Enter Handset Code ®» (=]

Selecting Multiple Messages

[Message List] P.4-14 [Message Window] P.4-11

Opening Sender/Recipient Details

M Selecting

[Message List] |&| Select message
»

Hl Selecting Up to 50 Messages at Once

[Message List] » (3] Manage Msg.
» (5] & [J] Check in Block % [u]
o Alternatively, press [[Fo]+[a @]].
l Unchecking
[Message List] 2| Select message
»
l Unchecking All
[Message List] » (3] Unselect
Al (u]

Color-Tagging Messages

[Message List] Select message
» » (2] View Mail Address »
(=] » [2] Select sender or recipient
» (=]

Using Messages

Forwarding Messages

[Message List] |&] Select message
» » (3] Manage Msg. » [u] »
Color Label % [u] » [3] Select
color » [u]

Sorting Messages

[Message Window] »
Forward » (] ® (2] Select
recipient field » [u] ® [J] Select
method ®» [u] » Select/enter
number/address » [u] B

® Attached files are forwarded.

® To forward SMS messages, select
S! Mail or SMS and press [u].

Sending from Drafts

[Message List] » (3] View
Settings » [u] » (2] Sort » (=] B
Select option » [u]

» (3] Drafts w [u] ® (7] Select
message % (8] » Complete
message »



| Additional Functions I—

% Managing Messages

[Message List] P.4-14 [Folder List] P.4-14 [Chat Folder List] P4-17

Sending Unsent Messages

Saving Messages with Schedules to
Calendar

Adding Folders

H Sending without Editing

[Message List (Unsent Messages)]
Select message » »
Resend » [u]

M Edit & Send

[Message List (Unsent Messages)]
Select message » »
Edit % [=] » Complete message
»

[Message List] |¢] Select message
» ®» (3] Manage Msg. » (u] »
Save to Calendar % (m] % Enter
subject ® (] ® Enter start/end
date/time » (u] B

Renaming Folders

Using Sent Messages

[Message List (Sent Messages)]
Select message » »
Edit & Send % [u] » Complete
message »

[Folder List]/[Chat Folder List]
Select folder » » (3] Rename
» (=] » Enter name » [u]

Deleting Folders

Searching Messages within
Specified Folder

[Folder List] (%] Select folder »
(=] & (3] Search » [u] » (3]
Search Folder % (] » (5] Select
method ® (=] ® Select/enter
number/address/subject/text string

» 1]

[Folder List] [2] Select folder »
®» (3] Delete » [u] » Enter
Handset Code » (=]

® Empty folder before deleting it.

[Folder List]/[Chat Folder List]
®» (2] Create New Folder % [u] »
Enter name » [u]

Canceling Secret

Unlock Secret folders temporarily
and [{] (select Secret folder) »
®» (2] Unset Secret » (u] »
Enter Handset Code » (1]

Sorting into Folders

Re-sorting Messages

[Folder List]/[Chat Folder List]

Select folder » » (] Classify

» [u]

Buibessayy
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& Managing Messages

[Message List] P.4-14 [Anti Spam Measures Menu] P.4-16 [Chat Folder List] P.4-17 [Mail Group Entry Window] P.4-18

Moving Messages Manually Deleting All Messages Deleting Mail Groups/Group
Members
[Message List] [2] Select message [Chat Folder List] [2] Select folder B Mail Groups
= » » (3] Manage Msg. » (u] » »(n» » (3] Manage Msg. » [Mail Group Entry Window] (]
2 Move to Folder » (u] » [(w] » [3] Delete All % (m] ® [3] Yes Select Group » » (3] Delete
4 Select folder » [u] » (=] » (=] & 3] Yes » [u] & Enter
Q ok Handset Code » (=]
5 ® When sort messages confirmation :
a appears, choose Yes # []: Resetting Chat Folders B Group Members
messages sent to/received from the [Mail Group Entry Window]
address will be sorted into selected A
folder automatically. [Chat Folder List] ® (2] Reset Select Group ® (=] ® 2] Select
—— » [u] » Enter Handset Code » (=] TETEER LS ® (3] Remove
Filtering Spam » (J] Yes » [u]

Entry » (u] ® [3] Yes » [u]

even after deleting members.

Renaming Mail Groups Changing Mail Group Members

[Anti Spam Measures Menu]

Individual(Common) % [u] () »

» [3] Select blank entry » (=] B [Mail Group Entry Window] [Mail Group Entry Window]

(2] Select key » (=] » Select/enter Select Group » » (0] Edit Select Group » (=] ® [3] Select

number/address/subject » [u] B Name % (=] & Enter name ®» [u] member » » (3] Re-assign
» (§] Yes » (=] Entry % [u] & Select entry » (u]

Chat Folders » (5] Yes » [m]

Deleting Folders

[Chat Folder List] (2] Select folder
> » (3] Delete Folder » [u] »

g (2] Yes » [u]

424
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Internet Services

Access the Mobile Internet via Yahoo! Keitai, or view PC Internet sites via PC Site Browser.

® Service requires a separate contract; retrieve Network Information to use these services.
® For more about Yahoo! Keitai, see SOFTBANK MOBILE Corp. Website (P.14-19).

Transmission/Information Fees Security Secure Pages

Some page content may automatically Electronic certificates are saved on ® A confirmation appears before entering
activate Internet connection incurring handset to support SSL (encryption and exiting secure pages.
transmission fees. Information fees may protocol for Internet transmissions of ® When a security notice appears,

also apply. important/sensitive information). subscribers must decide for themselves

whether or not to open the page.
Opening secure pages constitutes
agreement to the terms of usage.
SoftBank, VeriSign Japan, Cybertrust,
Entrust Japan, GlobalSign, RSA Security
and SECOM Trust Systems cannot be
held liable for any damages associated
with the use of SSL.

19smo.g SHS Od B Iella)] jooyeA

G I Clearing cookies  Clearing authentication information (P.13-11)




Opening Main Menu

Internet pages may not open depending
on connection/Server status, etc.

®» Connection starts

Cursor
Yahoo! Keitai [Rf7) 5058

YaHoO!
[]

JAPAN

||l0mions [

Internet Page

® Yahoo! Keitai Main Menu appears.
® To disconnect, press [(¥].

Highlight menu item » [u]

® Corresponding page opens.
® Repeat &) to open additional links.

(] % (2] Yes» [m] & Page
closes

Returning to Previous Page
[Internet Page]
= To return to the initial page, press x 7.
Returning to Yahoo! Keitai Main Menu
[Internet Page] » (3] Yahoo!
Keitai % [u]
User Authentication
Enter user ID or password » [u] »
Streaming
® Enjoy audiovisual media while it downloads.
® Packet transmission fees apply even
while stream is paused.

Using History

(w] & 3] Yahoo! Keitai W [m]

History » [m]

@ XXXXXXXXXXXXXXXXXX
@ XXXXXXXXXXXXXXXXXX

History List

Select item » (=] B
Connection starts

® Corresponding page opens.

» (3] Yes » (=] ®» Page
closes

Entering URLs Directly

(w] & [3] Yahoo! Keitai % [u]
®» (3] Enter URL W [u]

Enter URL » (=] »
Connection starts

® Corresponding page opens.

» (0] Yes » [u] » Page
closes

Yahoo! Keitai

Using Yahoo! Keitai

18SMOIg BUS Dd *® 1BUSY jOOYEA

(47 Switching Browsers  Deleting History © Using Previously Entered

URLs (P.5-9)

I Resetting browser settings and stored information (Bookmarks, Saved

Pages, etc.) © Restoring default handset settings (P.13-11)




PC Site Browser

19smo.g SHS Od B Iella)] jooyeA

Using PC.Site B

Open PC sites from Yahoo! JAPAN

(preset home page).

® Internet pages may not open depending on
connection/Server status, etc.

® Browsing PC sites may incur higher charges.

(m] & [3] Yahoo! Keitai # [u]
® (3] PC Site Browser » [u]

PC Site Browser [/ 5058
o You can connect to
the home page.

S, Bookmarks

@ Saved Pages

S Enter URL

G History

RSS Feed

¥/ Yahoo! Keitai

© PC Site Browser Set...
| = Ead v

Homepage » [u] »
Connection starts

Returning to Previous Page
[Internet Page]
®m To return to the initial page, press [x 7.
Returning to Yahoo! JAPAN Home
[Internet Page] » (2] Homepage
» (u]
User Authentication
Enter user ID or password » [u] B
Using History
In &, (2] History » [u] ® [{{ Select
item » [u]
Internet Page Entering URLs Directly
® Yahoo! JAPAN Home opens. In &, [2] Enter URL % [u] ® Enter
® \WWhen a message appears, follow URL » (=]
onscreen prompts.
® To disconnect, press [(¥].

Highlight menu item » [u]

® Corresponding page opens.

Pointer
YaHoO!

JAPAN

Yahoo! JAPAN

|[S0ptions | I

® Repeat ©) to open additional links.
» (3] Yes » (=] ®» Page
closes

é] Switching Browsers
URLs (P.5-9)

Deleting History

Using Previously Entered

I Resetting browser settings and stored information (Bookmarks, Saved
Pages, etc.) ¢ Restoring default handset settings © Hiding PC Site
Browser activation/change confirmation (P.13-11)



Page Browsing

. Scrolling Pages

If page content continues beyond view, use
to scroll pages. (Scroll bar appears.)
Long Press 24 to scroll continuously. On
PC sites, use Page Navigation to confirm
current page position.

. Switching Frames

On framed pages, press to select
other frames.
When pointer navigation is active, point to
a frame and press (®] to select it.
Viewing Single Frame
Select frame » »
Convenient Functions » (u] »
Frame In » (=]
® To return, press [&7].

. Tabbed Browsing

Open another page in a new tab and
switch between tabs.

On a page, [¥7 (select menu
item) » [[F ]+ )]

Tab
=1 —2(#E)
EER )
(G740
FTAYATREESNE, HEBIBEAST
BANSSIMDRIES AhREEE,
EKA@E%mmmﬁomTéhux

DRE,
Eﬁé/uﬂ)iﬁ!TEXXXXTli ZDREICKEE
Y EDY DBF

EOptions \

» (] Select tab » [u]

® \When pointer navigation is active,
point to a tab and press (®] to open it.

Closing Tabs
[seeces= =] # (2 Select tab » [u] B
» (2] Tab Menu » (=] ® 3] Close
Tab or Close All Other Tabs » [u]

éﬁ Switching View © Zooming on Pages (Zoom Factor)

Specific Locations © Zooming Specific Areas
Sending URLs via Mail

Copying Text
Searching Current Page (P.5-9 - 5-10)

Jumping to
navigation

(P.13-11)

I Changing character size ¢ Changing scroll unit © Activating pointer
Changing pointer speed " Disabling automatic image
download " Disabling automatic sound playback © Hiding navigation
map for continuous scroll

Changing scroll unit (PC Site Browser)

Basic Operati
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Browsing :
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Selecting Text

Activate pointer navigation and Long Press
(m] to enable text selection (Drag Mode).
Select text to copy or search via Web Search.
. Searching Text via Web Search
On a page, (2] (select first
character) » (8] (Long) »
Highlight text range » [u]

[ ]+ w =] W [u]

® Search starts.
Copying Text

In &, [+ 7]
Pasting Text to Scratch Pad
In &, &=

m Scratch Pad opens with text inserted.

Text Entry

On a page, [ (select text
entry field) » [u]

Enter text » (]
® Internet page returns.

Using Entered Text (Input Memory)
[Internet page] k5] Select text entry
field » (=] » » (3] Insert/ Font
Size » (u] & 2] Input Memory » (]
» (5] Select text » [u]

Pull-down Menu Item Selection

On a page, [¥7 (select menu
list field) » [m]

Select item » [u]

When Multiple Selection is Supported
® Select items as needed and press [&].

Page Item Indicators

. Selection Items
Buttons O or boxes [] appear.

On a page, 54 (select button
or box) » [u]

BB AN
(&% 7]
(1511
©%8 Ox
[RE T2
I = I
e O/0J changes to ®/] .

. Execution ltems
Execute the assigned command.

On a page, [ (select
command) » [u]

ézf Using Web Search ¢ Saving Files to Data Folder © Using Linked Info
Playing Media Streams (P.5-10)

Jumping to Page Top/Bottom

l Clearing cache (temporarily saved information)
Card as primary download storage (P.13-11)

Using Memory



Bookmarks & Saved Pages
Select title # BT

® Corresponding page opens. .
Bookmark sites for quick access. E » Yahoo! Keitai » IE

Opening Bookmarks Online
. Saving Bookmarks [Internet Page] [(F)+[e )] » [&] » Saved Pages » (1]
i &
Ona page, [\E’+] Select title » =] Saved Pages Y7 [ 7 I T

Enter/edit title » [u] Saved Pages

Save page content; handset opens saved

. ERenhaleeaRINATS pages without connecting to the Internet.

E] Yihoo;’( Ke»itaé » (=] [l saving Pages Ewtos T &
OOKMarks On a page, [+ 1] Saved Pages List

Enter/edit title » [u] Select page #» (=]

® Corresponding page opens.

@-_1—2X
@URETEH Opening Saved Pages Online
[Internet Page] [[F2 ]+ =] »

Select page » [u]

18SMOIg BUS Dd *® 1BUSY jOOYEA
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Bookmarks List

(% Deleting Titles/Pages  Editing Titles © Editing Bookmarked URLs
Sending Bookmarked URLs via Mail (P.5-11)




RSS Feed
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%

Register RSS-compatible sites; view content
updates without opening source sites.
Transmission fees apply.

Subscribing to RSS Feeds

Available for PC Site Browser only.
. Via RSS-Compatible Sites
appears for RSS-compatible sites.

RSS Indicator
XA
On a page, »
Register In RSS Feed » [u]

Select feed ®» [®] (/)
» Complete selection »

Save » (]

® Choose Yes to update immediately
or No and press [u].

. Via RSS Icons

Use RSS/RDF/XML icons on
RSS-compatible sites.

On a page, ¢ (select icon)
» [u]

Yes» (] ® (3] Save » [u]

Checking Updates

Follow these steps to update all feeds.
(m] & (34 Yahoo! Keitai » [u]

(m] & [3] PC Site Browser »
(m] & (] RSS Feed » [u]

RSS Feed List fll® 15:058
=
E5AD=a2—..
B OOmAHR
Reload all RSS feed list
s.
ElOptions. I =] I

RSS Feed List

Reload All » [u]

Select feed » (u]

SReload All

8
8 OOmH:R

XXXX/XX/XX_15:05Re oad
=

ElOptions

Title List

Select title » (=]

® Information appears.

Updating Single RSS Feeds
[RSS Feed List] (2] Select feed »
» (5] Reload » [u]
Disabling/Enabling Updates
[RSS Feed List] [2] Select feed »
» (3] Manage RSS Feed » [u]
» (] Restrict Update or Accept
Update » [u]
Accessing Source Sites
[Title List] [2] Select title » [u] »
Select linked title » [u]

\@ Deleting RSS Feeds (P.5-11)

1 Deleting all RSS feeds (P.13-11)



Additional Functions

[Internet Page] P.5-3, P.5-4 [History List] P.5-3

& Additional Functions

Connecting/Browsing

Using Previously Entered URLs Zooming Specific Areas

Switching Browsers

[Internet Page] »
Convenient Functions » [u] » [3]
Change to PC Browser or Switch
Browser % (8] & (3] This Page or
Linked Page » (u] » [u] ®» (3] Yes
or Now» [u]

Deleting History

H One Entry

[History List] (3] Select item »
» (0] Delete » (] ® (3] Yes » (]

M All Entries

[History List] » (3] Delete All
» (=] » Enter Handset Code » [u]
» [J] Yes » (=]

[w] » (34 Yahoo! Keitai » [u] »
Enter URL % [u] » » (5] URL
Entry Log % (m] ® [] Select URL
» (5] (u]

PC Site Browser

Switching View

[Internet Page] 4 Point to area »
[ +2™]

® Pointed area is enlarged and shown in
the lower half of Display. Press
[ J+z™]] to toggle Zoom Area options
(Small, Large and Off).

Handling Information

[Internet Page] » (3] PC
Screen or Small Screen » (]

® |In Small Screen view, PC sites are
redesigned to fit Display.

Copying Text

Zooming on Pages (Zoom Factor)

[Internet Page] [(F~J+[c =] » (34
Select first character » (=] B
Highlight text range » [u]

[Internet Page] [[~ ]+ ] (enlarge)
or [[( ]+ 9] (reduce)

Sending URLs via Mail

Jumping to Specific Locations

[Internet Page] [[(F]+(a 1]] % Quick
Movement map appears »
Select location » (u]

[Internet Page] »
Convenient Functions % (=] »
Send URL » [u] » (3] S! Mail or
SMS » (=] » Complete message
»

® S! Mail Composition window opens
automatically depending on character
count.

18SMOIg BUS Dd *® 1BUSY jOOYEA
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k& Additional Functions

[Internet Page] P.5-3, P.5-4

Page Operations

l Background Images

Using Web Search
[Internet Page] » (] Save

[Internet Page] [[F~ ]+wZ]] » Enter
search text » [u]

Searching Current Page

Items » (u] ® (2] Save
Background Image » [u] »
Save ® [u] » Enter name » (u] »
Save here » (]

Jumping to Page Top/Bottom

[Internet Page] [(F J+(¢ °]] » Enter
search text » [u]

® Press [m] to jump to next search result,
if any.

Using Linked Info

[Internet Page] [[F~]+[2]] or [(FJ+[2]]

M Dialing Numbers

[Internet Page] F24 Highlight
number ® (=] & [&] Call or Video

Playing Media Streams

[Internet Page] ¢34 Select file » (u]
® Downloaded content cannot be saved.

Saving Files to Data Folder Call » [u]
M Sending Messages

[Internet Page] [ Highlight
number or mail address » [u] »
Create Message » [u] »
S! Mail or SMS % (=] » Complete
message »

M Files on Page

[Internet Page] » [J] Save
Items » (u] ® (3] Select file » (]
» (2] Save » (m] » Enter name »
(m] » (3 Save here » (m]

® Some files are saved automatically.

® End memory-consuming operations
(TV recording, etc.) beforehand.

® Confirm signal is strong, battery is
adequately charged and there is
enough free memory beforehand.

19smo.g SHS Od B Iella)] jooyeA
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Bookmarks & Saved Pages

[List] Bookmarks: P.5-7, Saved Pages: P.5-7 [RSS Feed List] P.5-8

Deleting Titles/Pages

Editing Bookmarked URLs

| Additional Functions

RSS Feed

[l One Title/Page

[Bookmarks List])/[Saved Pages
List] (2] Select item » » (3]
Delete » (m] ® (3] Yes » [u]

M All Titles/Pages

[Bookmarks List])/[Saved Pages
List] » (2] Delete All » [u] »
Enter Handset Code » [a] »
Yes » (u]

[Bookmarks List] (&9 Select title ®
(=] » (3] Edit® (] » [3] URL: »
(=] » Edit » [u] »

Deleting RSS Feeds

Sending Bookmarked URLs via Mail

Editing Titles

M Bookmarks
[Bookmarks List] (54 Select title ®
» (3] Edit » (=] » (5] Title: »
(=] & Enter title » (=] »

M Saved Pages
[Saved Pages List] |2 Select page

» (2] » (2] Rename » (u] »
Enter title » [u]

[Bookmarks List] ¢4 Select title ®
(=] » [{] Send » [m] & [3] As
Message » (] ® (3] S! Mail or
SMS » (=] » Complete message
»

® S! Mail Composition window opens
automatically depending on character
count.

H One Entry

[RSS Feed List] [¥] Select feed »
» (2] Delete ®» (u] » 2] Yes
» [u]

M All Entries

[RSS Feed List] » (3] Manage
RSS Feed » [u] » (3] Delete All %
[=] » Enter Handset Code » (=] »
Yes » (u]

18SMOIg BUS Dd *® 1BUSY jOOYEA
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Digital TV
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922SH supports One Seg terrestrial digital television broadcast services developed for mobile devices in Japan.

Watch Live Television

Set up a channel list for your service area to
access available programming. Capture
screenshots while watching TV.

Multi Job

Watch TV in one half of Display using the
other to access messaging functions, browse
the Internet or open Phone Book/Call Log.

Access TV Listing (EPG)

Access TV Listing (EPG) to find program
channels and times; set Reservations by
date and time to record shows or activate TV.

View Data Broadcasts

In addition to audio and visuals, enjoy text,
program-related information and interactive
services.

Record Shows/Time Shift

Record current program for later viewing on
handset; if interrupted by incoming calls
while watching TV, record it temporarily for
delayed playback.

Reserve TV Programs

Record a show or activate TV at a specified
time; enter dates & times manually or

reference TV Listing electronic program guide.

Precautions

® 922SH TV is exclusively for use in Japan.
® Do not use TV while driving or riding a
bicycle. Accidents may result. Mobile
phone use while driving is prohibited by the
Road Traffic Law (revised November 1,
2004). When walking, always pay attention
to your surroundings, especially near road/
rail crossings, etc.
® When using TV while charging battery,
separate AC Charger and Antenna to avoid
interference.
® Call transmissions, incoming messages or
mobile phone use in the immediate vicinity
may affect audiovisual quality.
® Programming may not be viewable or
record properly when:
= Too far from or too close to broadcasting
stations
® [n mountainous areas or near tall buildings
® Aboard trains or in moving vehicles
= Near high-voltage lines, neon lights or
wireless base stations
® Near railroad tracks or highways
= Anywhere a jamming signal is broadcast/
reception is unstable



{ Digital TV I

b

Follqw th.ese steps when activating TV for Select prefecture » (=] Digital TV Antenna
the first time. Set up channels by area. » [J] Select locality » (] @ Pull Antenna by top bead until it clicks;
— ' fold/rotate Antenna to find best reception.
oca I 7 ] e :
Tokve 23 Wards. (Unless transmission source is near,
TiF T5058] extend it for better reception.)
Tayfo
< Chi‘g‘(“f i( ;‘fls‘”- Tokyo j:l Wards
No I 0K I =]
I ] ] b} ® After setup, channel list appears. %
® Setup confirmation appears. E :|
<
Yes » [a] “"'C“‘ ® After use, gently retract Antenna. Do not
Select Region FAChanne| carry handset with Antenna extended;
Hokka i do/Tohoku HChannel
Hokur iku/Koshin' etsu EChannel Saved Yokyo 23 damage_ may result. .
Kanto Hchannel | Wards in Area ® Use optional TV Antenna Connection
Tokai [AChannel Cable as needed.
Kansai EdChannel
Chugoku EChannel 8
Shikoku I 0K I
KYUSh“/Ok'"a‘Ta = ® To watch TV, select Digital TV and
press (m].
Select region # (=] Watching TV without Completing Area
Setup

In ©), [2] Other Region » [u]

é@ Adding Reception Areas ¢ Switching Reception Areas (P.6-11) I Renaming Areas © Updating all channels in the Area  Assigning
key function to = " Reassigning channels to other keys " Deleting
channels (P.13-13)




Digital TV
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Follow these steps after completing Area
setup.

]
o]

IODti} 0508 W“%BOS faeim
TV Window

® Press to switch to Data
Broadcast view.

Use Keypad to select a

channel

® Use 4 to switch channels one by
one; Long Press to find channel with
stable signal automatically.

Incoming Calls

® Press to answer calls.

® When S! Circle Talk request arrives,
press to start S! Circle Talk.

When Memory Card is Inserted

® |f an incoming Voice Call interrupts a
program, it is temporarily recorded to
Memory Card for Time Shift playback.

Incoming Messages

® Double beep sounds and New Message
notice appears. Long Press to open
messages.

Key Assignments

Open Options menu
Toggle Panel on/off
Activate TV/Change Area
Volume up or cancel mute

Volume down (Long Press: mute)

<] &>
1) 2 e

Panel Description

1=

2 J0pTTon

Data Broadcast View

Station name | H | Program name

1]
» Yesw (m] » TV Exit TV Kl | Area name [ | Signal strength’
ends K | Channel key Volume
[ | Channel H | Sound Language
“The more bars the better.
Indicator position varies with display size.
m @ Saving Current Channel ¢ Changing Audiovisual Setting © Using 1 Image © Selecting sound option ¢ Showing calls or S! Circle Talk

Wireless Headphones

Enlarging Specific Image Portion (P.6-11)

requests while watching TV © Additional TV Settings (P.13-12 - 13-13)



ta adcast (Japanese)

In TV window (Full Screen), press to
view Data Broadcast information.

TV Image Data Broadcast

Data Broadcast Window
Panel (Guide)
Use [Z] to select an item and press [®] to
access program-related information and
interactive services.
Press to show program description
on Panel; press or to scroll.

Data Broadcast Fees

® Data Broadcast information viewing is
free, however, using data links/related
services incurs Internet connection fees.

® A confirmation appears the first time a
fee-based Network connection is
established from a channel; if accepted,
further Network connections are
established without confirmation until the
channel is changed.

TV Listing (Japanese)

In TV window, (Long)

® EPG application starts; refer to the
application's help menu for
operational instructions.

® When using EPG application for the
first time, a confirmation appears.
Follow onscreen instructions.

{ Digital TV

I_

Program Info

In TV window, =]

Program Info.
XK:XX = XX:XX

Program Info Window

Select program » [u]
® To return, press twice.
In Data Broadcast View
® [TV Window] » (3] Program Info.
L 0N 2

ééi Returning to Initial Window (P.6-12)

1 Selecting subtitle display option (P.13-12)

AL 1enbia
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Capturing Screenshots

Capture screenshots while watching TV.
(May not be available if TV was activated
by TV Timer.)

Saved images cannot be forwarded,
edited, set as Wallpaper or attached to
messages.

In TV window,
(]

® Image is saved.

. Opening Saved Images
(m] > (5] TV [u]
TV-Image Folder » [u]

IVITEEESI T N 5|
TVXXX. stve

Select image » [u]

Opening Images while Watching TV
[TV Window] » (] TV-Image
Folder » [u]

Multi Job

In TV window,
Select function » (=]

sear
0 Y

@® Web Search
O Mail Search

® To toggle function windows, press [=#].

®» Function window
closes



Record clips on handset or Memory Card
while watching TV.

Precautions

® Saved files cannot be copied/forwarded
or attached to messages.
Files once moved to Memory Card
cannot be moved back to handset.

® 922SH encryption technology prevents
unauthorized copying or playback of
Memory Card files through data
encryption and authentication.
Files copied from Memory Card to other
cards on PC are unplayable.

® Copyright laws limit duplicated material
to private use only, and prohibit
unauthorized reproduction/other use.

® SoftBank is not liable for any damages
resulting from accidental loss or
alteration of recorded content.

In TV window, (=] (Long) »
Recording starts

Q

=00t im\( m

® Changing volume, etc. does not
affect recordings.

(=] (Long) ®» Recording
ends

® Clip is saved to handset (or Memory
Card, if inserted).

In Data Broadcast View
[TV Window] (Long) »
Recording starts » (Long) »
Recording ends
Memory/Battery Runs Low or Video
Call/S! Circle Talk Request is Accepted
® Recording stops. (Recorded clip is saved.)
When Small Light llluminates Yellow
® Signal is not received. Move to a place where
Small Light illuminates green (moderate
reception) or blue (strong reception).
Saving Files via the Internet while
Recording
® While recording programs to handset,
confirm there is enough free memory
beforehand.

TV PI

AL 1enbia

I Recording content without text data © Recording programs to

handset (P.13-12 - 13-13)




TV Player |

AL leubia

Playing Recorded Programs

() [ TV (] 3] TV
Player » [u]

WilEoRSTERL:] 1 7
mRS52 XK/XX XX:XK Channel 2
|E0ptions [ Play [

Video List
® Handset Video List appears.
(Memory Card Video List appears if a
card is inserted.)
o i indicates the file is unplayable.

Select file B (=]

Z
oot ion® wusewmuan Pause 08 _Parcii

Playback Window
® Playback starts. (The last played file
plays from where it stopped.)

(Long) ®» Playback
stops

When Target File is Not Listed
® Follow these steps to switch between
Video Lists.
After (), » (3] Change to Phone
or Change to MemoryCard » [u]
Moving Files to Memory Card
Adter O, [£] (select file) » »>
Move to Card » (u]
® Files once moved to Memory Card
cannot be moved back to handset.

. Playback Operations

Adjust volume in the same way as while
watching TV.

Fast Forward

Fast Rewind | (o]’

Skip Forward

Skip Backward

(=]
(3] in Data Broadcast

Pause?

view)
Split File (Long)
Marker

"Long Press to replay. (Available when no
Marker is saved.)
2To advance frames, press while paused.

/
(% ) Checking Memory Status

with Markers
(P.6-12)

Playing Split Files

Playing Files Repeatedly © Playing Files
Renaming Files

Deleting Files



Time Shift Playback

Insert a Memory Card to temporarily record
TV programs interrupted by incoming Voice
Calls for Time Shift playback. (See related
indicators in the screenshot below.)

X

-
BRECORDING
v

S0t iond Fm - 50y B =08 Pancim
Follow these steps to start playback.

(Long) ®» Playback

starts

® Playback stops when Time Shift
playback has caught up to the
real-time program.

® To skip forward/backward or fast
forward during Timer Shift playback,
see P.6-8 "Playback Operations."

TV Player

(Long) » Recording/
playback stops
® Recorded content is deleted.
Stopping Fast Forward to Resume
Playback
Recording Programs Temporarily
[TV Window] (Long)

AL 1enbia

I Disabling Time Shift recording automatic activation (P.13-13)
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IV Timer & TV Timer Recording

LTV u]
Reservation List » (u]

TP 15058

<Empty>

El0ptions

Resul tid|

Reservation List

» (3] New Entry » [u]
Manual & (=] »

Programming or Recording

» [u]

TiE |
B0/ i)/ 6
MM DD

YYyy

[0x] = [

HH MM

0K

# ( Setting Timer via Program Info
Opening/Deleting Timer Log (P.6-13)

Opening/Editing Timer Details

Enter start date/time » [u]
® Enter end date/time » (=]

Channel: » [u] »
Select channel ®» (=] B

® \When a confirmation appears, read
the message and press (m].

Setting Timer via EPG
After &, (8] From TV Listing % (=]

m Refer to the application's help menu for
operational instructions.

. Timer Recording Precautions

® End the current operations.
m Make sure TV reception is good.
m Confirm battery is adequately charged
and there is enough free memory.
When TV is Activated for Timer Recording
® Audio output is redirected to Speakers/
Headphones even if 8 Sound Output is
set to Bluetooth Device. (TV audio is
muted.)

. At Timer Time (TV Alarm Time)

TV and Alarm activate. Alarm ends after
the set duration.

i 0]
Reservation time for recording TV
will come soon.
Finish application.

I 0K I
Recording starts slightly before the Timer
start time and ends a few seconds after
the Timer end time.

While Using Another Function

® Confirmation appears if Timer recording
cannot start in current state; press (]
then end application to enable Timer.

1 Changing TV Alarm Time (P.13-13)



& Additional Functions

Area & Channel TV Window Operations

[TV Window] P.6-4

Adding Reception Areas

Saving Current Channel

Using Wireless Headphones

[TV Window] » (| Set Channels
» (n] & (] Change Area w [u] »
Select Area » » (0] Set Area
Info » (=] » [J] Select region » (=]
» (] Select prefecture » [u] B
Select locality » [u] » [u]

[TV Window] » (3 Set
Channels % (u] % 5] Save Channel
» [u] » (3] Select key » [u]
® To overwrite a saved channel, choose
Yes and press [u].

[TV Window] (Long)

® Pair SCMS-T DRM scheme compliant
Bluetooth® headphones beforehand.

Enlarging Specific Image Portion

Switching Reception Areas

Changing Audiovisual Setting

[TV Window] » (] Select
Area » (u]

[TV Window] [ )+[2 @] »
Select effect » (u]

® TV reception time may be relatively shorter
when High Resolution is selected.

[TV Window (Full Screen)] Long
Press a key (below)

3
Upper left | Upper center | Upper right

Left Center Right
c™]

Lower left |Lower center | Lower right

Additional Functions

AL 1enbia
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k& Additional Functions

[Data Broadcast Window] P.6-5 [Video List] P.6-8 [Playback Window] P.6-8

Data Broadcast Recording/Playback Recorded Programs

Returning to Initial Window Checking Memory Status Renaming Files
[Data Broadcast Window] [Video List] » (3] Memory [Video List] [2] Select file » »
[ 1+(8]] Remaining » (u] [2] Rename » (=] » Enter name
» [u]
Playing Files Repeatedly
Deleting Files

AL leubia

[Video List] » (3] Playback - -
Pattern % (u] & (3] Repeat » [u] M Single Files

[Video List] [2] Select file » »
Delete » [u] » 3] Yes » (]

Playing Files with Markers

— WAl Files

B Skipping bet‘_"’ee“ Markers [Video List] (=] ® (4] Delete All »
[Playback Window] 2] (Long) or (=] & Enter Handset Code » (=] &
(Long) (2] Yes » [u]

M Moving to Specific Markers
[Playback Window] -

Playing Split Files

[Video List] 2] Select split file »
® [C] Select file » (u]

6-12



& Additional Functions

TV Timer/TV Recording Timer

Setting Timer via Program Info

l Watching Programs

[Program Info Window] (] Select
program » » (3] Programming
» (u]

M Recording Programs

[Program Info Window] [] Select
program »

® Timer entries set via Program Info are
updated with program changes
automatically. Program cancellations
cancel corresponding Timer entries.
(Poor signal conditions may inhibit
updates or cancellations.)
H Opening Reservation List

[Program Info Window] »
Reservation List » [u]

Additional Functions I—

[Program Info Window] P.6-5 [Reservation List] P.6-10

Opening/Editing Timer Details

Il Opening Entries
[Reservation List] 2] Select entry
» (=]
M Editing Entries
[Reservation List] 2] Select entry ®
(=] » (5] Edit » [=] & Edit % [*]
M Deleting Entries

[Reservation List] (2] Select entry
» (=] & (3] Delete » [u] » (3]
Yes » (u]

Opening/Deleting Timer Log

H Opening Timer Log
[Reservation List] » (] Select
record » (u]

M Playing Recorded Programs

[Reservation List] » (§] Select
record »

H Deleting Records

[Reservation List] » (3] Select
record » » [J] Yes » (u]

AL 1enbia
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Camera

Buibew| B elawe)

b

Capture still images or record video.

7

Select small sizes to send captured
images/recorded video via S! Mail*;
select larger sizes for higher resolutions.

Set shutter to release after set time.

Apply effect or add frame, capture sequential/
panoramic or scan images. When traveling solo
shoot background and combine with portraits.

Edit captured images or print on a
compatible printer.

*Images/video may not be delivered as sent depending on file size or recipient devices.

Precautions

® Clean dust/smudges from lens cover with
a soft cloth before use.

® Mobile camera is a precision instrument,
however, some pixels may appear
brighter or darker.

® Shooting/saving images while handset is
hot may affect the image quality.

® Subjecting the lens to direct sunlight will
damage the camera's color filter.

Auto Shut-off

® Before image capture/recording, mobile
camera shuts down after a period of
inactivity and handset returns to Standby.

Shutter Click

® Shutter click volume is fixed, and sounds
even in Manner mode.



Internal & External Cameras

Use Internal Camera or External Camera;
unless noted otherwise, operations in this
chapter describe External Camera.

Sizes are limited and shooting modes are
not available for Internal Camera.

Display Indicators

The following indicators appear at the top

of Display.
[l Proto Viewfinder

Capacity

Mobile Light

Picture Size
Background size (Solo Traveling Photo®)

Continuous Shoot
Solo Traveling Photo®

Picture Quality

Exposure

Save to

Self-timer

DENam o = 6E

Scene

: Camera

I_

Il video Viewfinder

Qs XXXCXX XOKKB /XKKB
[=]0ptions —

SEE

Mobile Light

Record Size

Record Time

Video Quality

Exposure

Save to

Naanmn e

Self-timer

Buibew) B elawe)




Photo Camera

Buibew| B elawe)

o} Frame image on Display % (=] Sending Captured Images via S! Mail
(3] A | BOEER ol = FOREE After ©), ®» Complete message
»
m May not be delivered as sent depending
on file size or recipient devices.
Opening Saved Images
After ), » (2] Data Folder » [u]
» (3] Select file » (=]

Eloptions T E0ptions
Photo Viewfinder Image Save Window
® Pre-Image Capture Operations: ® Shutter clicks and the captured
- image appears. (To discard file and
Zoom in/out o]
(5)(=] (23] maximum/off) start over, press [&7.)
Toggle mode E
Adjust image brightness ® Image is saved. (Viewfinder returns
E ' g .
e (darker/brighter) for another shot.)
Change image size ® Open saved images from Data Folder.
Toggle Mobile Light mode
99 3 ®» Camera shuts down
Toggle between Internal
Camera and External Camera
@E Activating Mobile Light " Adjusting Focus Quickly for Close-up Shots 1 Changing save location © Activating automatic saving © Selecting
Sending Images Wirelessly  Switching Active Camera © Changing image quality © Changing shutter click sound © Disabling remote
Image Size ¢ Changing Mode According to Lighting or Subject (P.7-13) shutter control via Bluetooth® watches (P.13-14)



(&%) » (]

e OB RowmEGe

&S XX:XX:XX XXXKB/XXXKB
ElOptions [xcu) -5
Video Viewfinder
® For pre-recording operations, see
P.7-4 "Pre-Image Capture Operations."

Frame image on Display » (=]
® Recording starts after a tone. (To
start over, press [%£7.)

(w]

Save Ti® 15058
Recorded video is
Preview save to Data
Send Folder.
| [=)

Video Save Menu
® Recording stops with a tone. (To
discard file and start over, press [&7.)

Save » [u]

® Video is saved. (Viewfinder returns
for another shot.)

® Play saved video from Data Folder or
Media Player.

® Camera shuts down

Playing Unsaved Video
In @, (8] Preview » (u]
Playing Saved Video
After ©), » (3 Data Folder #» (m]
» (7] Select file » [u]
Sending Recorded Video via S! Mail
In ©), (7] Send » [(u] ®» [3] Save and
Send » [u] » Complete message
»
® May not be delivered as sent depending
on file size or recipient devices.
Incoming Calls
® |f a call arrives before recorded video is
saved, captured clip is temporarily saved.
End the call to return.
When Battery Runs Low
® Recording stops. (Captured clip is saved.)

(% ¢ Activating Mobile Light ¢ Adjusting Focus Quickly for Close-up Shots
Switching Active Camera

Sending Images Wirelessly
Recording Time/Format (P.7-13)

Changing image quality

size (P.13-14)

I Changing save location
Recording video without sound

Activating automatic saving © Selecting
Enlarging Viewfinder

Buibew) B elawe)




Shooting Modes
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Using Shooting Mod

May be unavailable depending on selected image/video size.

In Photo/Video Viewfinder,
» (3] Self-timer » [u]

Select time » [u]

[ i HOAD BORIES

E0ptions
Self-timer Viewfinder

Frame image on Display » (=]
® After selected time elapses, captured
image appears or recording starts.

® To stop recording, press [w].

Releasing Shutter during Countdown
After ), [u]
Incoming Calls/Alarm during Countdown
® Countdown stops. (Self-timer remains
active.)

Solo Traveling Photo® (Photo Camera)

Combine External Camera image
(background) with Internal Camera image
(your portrait).
In Photo Viewfinder, »
Modes » [u]

SoloTravelingPhoto »
(=] ® (3] Select size » (1]

® Background Viewfinder appears.

Frame image on Display » [u]

Options
® Shutter clicks and background image
is captured.

Frame your image on Display

® Holding 922SH straight out in front of
your face at eye level, slowly move it
left and right, a few centimeters at a
time, for better recognition.

® Use 24 to change position of your
image and use |¢] to adjust image size.

® Shutter clicks and your image is
captured.

® To start over, press [(&].
(Background image remains.)

(w]

® Combined image is saved.
(Viewfinder returns for another shot.)



Opening Portrait Shooting Tips
In ),
Sending Combined Images via S! Mail
After -, » Complete message
»>
® May not be delivered as sent depending
on file size or recipient devices.
Opening Saved Images
After (), » (3] Data Folder % [u]
» [J] Select file » [u]

Continuous Shoot (Photo Camera)

Available Modes:

. Capture four separate
R images with Index Image
9 Pictures Qapture nine separate

images with Index Image
Overlapped Capture five images to
create a composite image

In Photo Viewfinder, »

Modes » (u]
= = BORE5
i) R
st f
el | RO,
|
= [
Mode Menu

Continuous Shoot » [u]

Select mode » (=] »
Select speed » (1]

Frame image on Display » [m]

® After image capture, Index Image or
a composite image appears.

® \When shooting speed is set to
Manual (4 Pictures and 9 Pictures
modes), repeat ) for each frame.

(]
All Pictures » (]

® All captured images are saved.

Saving the Selected Image
After ©), b2 (select image) » [n] »
Selected Picture % [u]

Adding Frames (Photo Camera)

In mode menu, (5] Add
Frame w» [u]

Preset Frames » [u]| »
Select frame » [u]

Frame image on Display » [u]
® Captured image appears.
Using Frames in Data Folder
In &, 3] Data Folder » (=] » {34
Select frame » (1] » (u]

| Shooting Modes

I_

Camera Effects (Photo Camera)

In mode menu, (& Camera
Effects » [u]

[ @] £ 2 PRI05E
Camera Effects
Roff | 7 | SRz S
SEE Sy
= 1

Select effect » [u]
Frame image on Display » [u]

® Captured image appears.

Buibew) B elawe)
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Shooting Modes :
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Panorama Picture (Photo Camera)

In mode menu,
Panorama/Scanner % (u]

i S B PRI

Panorama Picture

] CEC] I

[ o 1

Panorama/Scanner Menu

Panorama Picture » (]
» [ On» (u]

Frame image on Display » (=]

® Move handset slowly to keep ¢
aligned with either of yellow lines.

® Image is captured automatically
when the bar (===) turns blue.

[ [ o ]

Save Menu
® Image is captured.

Save » (u]

® Image is saved

Checking Unsaved Images

[Save Menu] (2] Preview » [u]
® To change preview method, follow

these steps.
» [ Select method » (=]

Sending Captured Images via S! Mail
[Save Menu] (2] Send » (=] » (3]
Save and Send % (8] » Complete
message »

Scanning Images (Photo Camera)

In Panorama/Scanner menu,

Scanner » [u]

Select size ®» [®] » Frame
image on Display » (=]

® Move handset slowly to scan the
area to capture. (Refer to indicators
on Display.)

(m]

® Image is captured and Save menu
opens.

® Preview or send captured image via
S! Mail in the same way as
Panorama Picture images.

Save » (u]

® Image is saved.

é} Sending Images Wirelessly (P.7-13)



Editing Images
The following options are available. Basic Operations . Select effect » E| » Edit
Some images may not be editable .

® To start over, press [%&]

depc.anding on.file type and size. (m] » Data Folder % (u] When finished,
M Picture Editor Pictures » [u] » - -
- R
Resize Select from preset sizes Select image » (m] Save as New
or crop image for size Overwr i te
Retouch Dress up images with » Edit » [u]
preloaded visual effects 3 3
Paste Add text/dates to images P'Ctu’_'e Editor or
Stamp Add stamps to images Compos:te » E I i I P
Face Arrange gzkfazg;"ey’ angry or Piciure Editor ® For Split Picture, skip ahead to 5
- For Merge Panorama, press (=] and °
Frame Add Frame to images skip ahead to o
Correction Correct images e | o
Rotate Rotate images B it | ke Save as New » [u] §
TS Convert file format and ® To overwrite, sglect Overwrite and ‘g
change file size press [m]. (Omit ©.) @

Enter name » [u] B
Combine two still Sp11£Pic. XXXXXXX Save here » [u]

images into one Canceling Effects

Combine up to After ), (3] Undo » (u]

four images into one m To restore effect immediately after
canceling, select Redo and press [m].

H Composite

Merge Panorama

Split Picture

Composite Menu
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Editing Imag I
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Changing Image Size

. Resize to Preset Size

In Picture Editor menu,
Resize » [u]

Select size » [u]
Specify display area

p

Assign I

EResize ]
® To zoom in/out, press then use (2.
® Omit ) if there is no rectangle on the

image.

(w]

® Editing is completed.

. Cropping Images
In Picture Editor menu,
Resize » (u]

(5] Cut W (=]

Move + to the upper left
corner of the portion to crop

» [n]

| Assign [

Move + to the lower right
corner of the portion to crop

» (u]
Specify display area

® To zoom in/out, press then use (2].

(w]

® Editing is completed.

In Picture Editor menu,
Face Arrange » (]

Picture Editor [N/ |

Face Arrange

Collage:Left-half
Grin
Mad
Sad
Big Eyes
Burning Eyes

ElParts

Face Arrange Menu
Select type » [u]
[m]

® Editing is completed.

Important Face Arrange Usage Note

® \When using Face Arrange, take care not
to create images that may embarrass or
offend others. Always obtain permission
before photographing others.

7-10

@ Applying Visual Effects ¢ Adding Text ¢ Adding Frames

Stamps (P.7-14)

Adding



: Editing Images

. Adjusting Positions
Change the default positions and sizes of
targets to fit the image.

In Face Arrange menu,
»

® A rectangle appears with +in the
upper left corner.

Move + to top left of face
Set Upper Faceline
7 N

Assign

Move + to bottom right of
face » [m]

Set RightEye Upper IR/ 15058

[ Assign
® Face line is set. Set the eyes and
then mouth in the same way.

Picture Editor

] (3] Yes» (u] B

Save here » [u]

® Image is saved as a new entry with
Face Arrange positions adjusted.
Complete Face Arrange. Face Arrange
is applied to the adjusted positions.

I_

Panorama Images

Panorama Image Effects:

Near View | Best suited for close-up shots
Document | Use for images with text
Standard | Apply to other images

In Composite menu,
Merge Panorama » [u]

Composi te Ti® 5058

Merge Panorama

1]
H<Empty>
EZSistandard

—

Eiflip

<Empty>» [u] »

Select image » (u]

(5] EFFECT & (] & [5]
Select effect » [u]

® Editing is completed.

Changing Images
After ©), [2] (select image) » [u] »
» (5] Select image » [u]
Switching Image Positions
After &,

Buibew) B elawe)

n
& Correcting Image Parameters
Format

Rotating Images
Combining Reduced Images (P.7-14)

Converting File

7-11
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Printing|

Digital Print Order Format (DPOF)

Select images in DCIM folder and specify
the number of copies to print on
DPOF-compatible printers, or at digital
printing services.

DPOF settings made on other devices are
unusable; delete existing settings to
create new ones on handset.

(] & (3] Settings » (=] »
Connectivity % [u]

Memory Card W (] B
DPOF » [u]

Photo Print (OPOF) [ [52] 5058
For All Pictures
For Each Picture

Check Settings are included.

] =

Photo Print Menu

Number of Copies » (u]

For Each Picture % (u]
» (3] Select folder » [u]

Select image »

Images ll* 5058
Set copies of selected images.

004 iy

[ Accent |

Enter a number of copies to
print B [u]

® For more settings, repeat =) -

Applying a Number to All Images
In &), (3] For All Pictures » [u] »
Enter a number of copies to print # (=]
Canceling Specified Number
In ), enter 00 » [u] B
Viewing Current Print Settings
In ©), [2] Check Settings » (u]

Using Printers

Connect handset to a Bluetooth®-compatible

printer and print images in Pictures folder.

® Activate Bluetooth® on the printer.

® Some images may not be sent depending
on file type and size.

(w] & (3] Data Folder ® (u]
» (0] Pictures W [u]

Select image » »
Print » [u]

Via Bluetooth #» (=] »
Select printer » [u]

Yes » (u]
® To cancel, press [(¥].

When Authorization Code is Required
Enter Authorization Code » [u]

7-12

@ Adding Dates to Prints

Creating an Index Print (P.7-14)



% Camera

[Viewfinder] Photo Camera: P.7-4, Video Camera: P.7-5 [Image Save Window] P.7-4 [Save Menu] P.7-8 [Video Save Menu] P.7-5

Photo Camera & Video Camera

Activating Mobile Light

[Viewfinder] » (3] Mobile
Light » [u] & (5] On, Automatic or
Low Light » [u]
® Low Lightis available for still image
capture.
® Do not use Mobile Light near people's
faces or look into the light yourself.

Adjusting Focus Quickly for
Close-up Shots

[Viewfinder] Slide Portrait/Macro
Selector to Macro ()

Sending Images Wirelessly

Photo Camera

M Still Images
[Image Save Window] »
Send #» [m] ®» 3] Bluetooth, Via
Infrared or IrSimple » [u]

M Panorama/Scanned Images
[Save Menu] [$] Send » [=] & [Z]
Send via Bluetooth, Send via IrDA
or Send via IrSS » [u]

M Video

[Video Save Menu] (2] Send » [u]
» (3] Bluetooth or Infrared #» (m]

Changing Image Size

[Photo Viewfinder] »
Picture Size % (] » [ Select
size » (u]

Changing Mode According to
Lighting or Subject

Switching Active Camera

[Photo Viewfinder] » (] Scene
» (] B [{] Select mode » (]

[Viewfinder] » (3 Internal
Camera or External Camera % [u]

Changing Recording Time/Format

[Video Viewfinder] »
Record Time/Size % (=] % 2] For
Message, Extended Video or SD
VIDEO % [m] » (5] Select size » [u]

® For SD VIDEO, choose Yes and press (1],

Additional Functions

Buibew) B elawe)
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Additional Functions I
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Editing Images

% Image Editing & Printing

[Picture Editor Menu] P.7-9 [Composite Menu] P.7-9 [Photo Print Menu] P.7-12

Applying Visual Effects

Adding Stamps

Combining Reduced Images

[Picture Editor Menu] 5] Retouch »
(=] & [3] Select effect » [u] B (]

[Picture Editor Menu] (5] Stamp »
(=] » (5] Select stamp » (=] B [3]
Move stamp » [u]

Adding Text

Correcting Image Parameters

M Text

[Picture Editor Menu] (5] Paste »
(m] ® [J] Free Text » [u] & Enter
text ®» [u] ® [3] Move text » (m]
M Dates
[Picture Editor Menu] [ Paste »
[m] » [§] Date » [u] & [ Move
date » [u]
M Outline
[Picture Editor Menu] [ Paste »
(m] » » (o] Select text color
» (=] » [3] » (5] Select outline
color » (u] B

[Picture Editor Menu] ¢& Correction
» [u] » (3] Select type » (u] » [u]

[Composite Menu] (54 SplitPict.
854x480 or SplitPict. 240x320 »
(=] » [2] Select <Empty>» [u] »
Select image » [u]

® Repeat from selecting <Empty> as
needed.

Rotating Images

Adding Dates to Prints

[Picture Editor Menu] (3 Rotate »
(] » [J] Select type » (=] » [u]

Converting File Format

[Photo Print Menu] [$] Settings »
(=] » [3] Add Date » [u] » (5] On
» (=]

Adding Frames

7-14

[Picture Editor Menu] ¥ Frame %
(=] » [2] Select frame » (=] B (=]

[Picture Editor Menu] &9 File
Format » (m| & (3] File Format or
File Size » [u] » (3] Select format/
size » [u]
® Changing file format/size may affect file
size/image quality.

Creating an Index Print

[Photo Print Menu] [£] Settings »
(m] » (2] Index Print » [u] »
Oonw (u]
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Media Player
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Use Media Player to play music/video on 922SH.

® Download media files from Mobile Internet sites via Media Player directly.
® Transfer PC music files and save them on Memory Card.

Features & File Support:

Music

—— My Music

SD AUDIO

WMA

| Handset/Memory Card |

| Memory Card

| Memory Card

Downloads/Transferred Files

Transferred SD-Audio Files

Transferred WMA Files

Videos

—— My Videos

SDVIDEO —

[ Handset |

| Memory Card

| Memory Card |

SD-Video Files

Downloads/Recorded Files

Playback Precautions

® Media Player is not compatible with
some recording/playback formats. Files
may not play depending on the Memory
Card status.

® Playback stops for incoming calls.

® When battery is low, Media Player will not
play. If battery runs low during playback,
Media Player shuts off.

® Turn down the volume if distortion is
noticeable in Speaker sound.

® Handset plays media while it downloads
(streaming); downloaded media cannot
be saved. Packet transmission fees
apply even while stream is paused.

Compatibility

® Files transferred from PCs cannot be
used as ringtones or System Sounds.



Music Playback Window Indicators

uif

All Music

Video Playback Window Indicators

Video Player

: Media Player

Downloading Music

Download music from the Internet.
Read information (price, expiry date, etc.)
on the source site.

[I did S Pl . [I .
g —— g L (m] Entertainment #» [u]
o-§ 5 011 C15 4 No Artiot N (a8 T, (Geotor Media Player % (u]
g T g S0t iofs - .
(2] Music »
H | Information link H | Information link e
F1 | Playback Mode Hl | Sound Effects Show the Tist of
playlists. ou can
El | Sound Effects E | Playback Mode create new
praylist, edi
ﬂ Status g Status Download Music ;Lz?c\lﬂ]ezn?oagd
H | Title Title Music Search playlists.
Setti
[ | Playback in progress A | Clip number ertines
B | Track number Ik | Elapsed time ‘ _:' ‘
E | Elapsed time H | Volume Music Menu
B | Volume E1 | Author name Download Music % [u]
M | Artist name ® Follow the links to download media.

Download via Music Search (Japanese)
In ©, (8] Music Search % [u]
® Follow onscreen instructions.

suopealddy s % Jafe|d eipay




Media Player :
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Downloading Video

(m] & (] Entertainment »
(m] ®» [2] Media Player » [u]

Videos » [u]

Videos fll®

Show the list of
playlists. You can
create new
playlist, edit
playlists, and add
movies to a
playlist.

Download Videos
Settings

)

Videos Menu

Download Videos % [u]

® Follow the links to download media.

Saving Media Files from PCs

® Use software to convert media file format.
® For software usage and specifications, see
the provider's website, etc.

Handling Transferred Files

® Copyright laws limit duplicated material
to private use only.

® Comply with copyright and other
intellectual property laws when using
obtained files.

[l saving WMA Files

Follow these steps to save WMA files via
S! Music Connect (Japanese).

Copy protected files can only be played
on the handset with which the files were
transferred.

(m] & (3] Settings » (] B
Connectivity » [u] »
USB Mode » [u]

USB Mode Ti® 5058
Save music or
image file from
computer to memory
card by using
“Mass Storage”.

MTP Mode

[ —

MTP Mode » (=] »
Yes » [u]

Connect handset to a PC via
USB Cable
® Copy music from PC. Refer to the
S! Music Connect help menu for
operational instructions.

» (] Yes (u] »
Connection ends
® Disconnect USB Cable.
S! Music Connect
® For details, see Utility Software Starter
Guide (Japanese) on Utility Software
CD-ROM.

[l saving AAC Files

Convert PC music files to
922SH-compatible format (P.14-18), then
save to corresponding Memory Card
folder (P.14-20) via Mass Storage.

Install Utility Software CD-ROM
(Japanese) beforehand.

[l saving ASF Files
Save files to handset via MTP Mode or to

corresponding Memory Card folder
(P.14-20) via Mass Storage.



Playing Musi

(m] & (3] Entertainment »
(=] » [3] Media Player » (]

» (3] Music % [u]
My Music » [u] »

Select folder

Music Folder

All Music
B 7v{YAM
Fv4Yar2
[ERIZUIS]

Music Playlists Window

All Music % [u]
Al Music

Classic musi.. 8
No Artist N..X:XX:XX
(ﬂ Classic musi.. 8

No Artist N..X:XX:XX

Pop music 2}
No Artist N..X:XX:XX
Pop music 2]
No Artist N..X:XX:XX
|=options | Play I
Music File List

Select file » [u]

Music Playback Window

® Album art appears for compatible files.

Stopping Playback
While paused,
When Handset is Closed during Playback
® Playback continues; follow these steps to
stop.
> HYs» B
Playing SD AUDIO or WMA Files
In 3, (2] SD AUDIO or WMA » [u] »
From

Searching Music Files
After ), » (C] Search » (u] »
Enter search text » [u]

Lyric Display-Compatible Files

® Press to display lyrics.

. Music Playback Operations

ko] Replay (Long Press: fast rewind’)
E] Skip forward (Long Press: fast

forward’)
[m] Pause
Volume down (Long Press: mute)
Volume up or cancel mute

(Long) | Switch Sound QOutput

"Release for playback.

suonealddy js 3 1afe|d eipsiy

(Q” Deleting All WMA Files © Deleting SD AUDIO Files (P.8-6)
Resuming from Stopped Point ¢ Playing Repeatedly or Randomly
Changing Sound Effects ¢ Sorting Files (P.8-12)

-l' Switching audio output to wireless device (P.13-15) ﬁ




Music I
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. Deleting Files
Delete other music files from Data Folder.

Deleting All WMA Files

[w] & (34 Entertainment » (=] »
Media Player % (u] »
Settings » [m] » [J] Delete All
WMA » [u]® Enter Handset Code
» [a] B [{] Yes » [u]

® Source files will be deleted.
Deleting SD AUDIO Files

M Single Files
[Music File List] Select file »
» (2] Delete Track » (u] »
Yes » (u]

M All Files
[Music Playlists Window] (2] All
Music % » (2] Del. All Tracks »
(m] > [3] Yes » [m] & [J] Yes » (u]

® Source files will be deleted in both cases.



(w] » (& Entertainment #»
(=] » [3] Media Player » (]
» (3] Videos » [u]

My Videos » (=] »

Phone Memory or Memory

Card W [u]

Playlist
All Videos
Playlist 1
Playlist 2
Playlist 3

0 1 |

EOptions = [

Video Playlists Window
All Videos » [u]

videoXXX
No Author

.videoXXX
No Author XaXX:XX

E0ptions =] [

Video File List

Select file » [u]

Video Player I® 5058
® SRS
BvideoXxk @iNo Author [
EOptions | =)

Video Playback Window
» Playback stops

When Handset is Closed during Playback
® Playback stops.
Playing SD VIDEO Files
In &, (2] SD VIDEO % [=] »
Searching Video Files
After ©), (2] & [§] Search » (=] »
Enter search text # (=]
At Alarm Time
® Playback stops.
Video Recorded on Other Devices
® \Video image may appear rotated.

. Video Playback Operations
For pause, volume up/down or sound
output, see P.8-5 "Music Playback
Operations."

ko] Replay (Long Press: fast rewind’)

Skip forward (Long Press while
E paused: advance frames,
Long Press: fast forward’)

Ww3/[=9] | Toggle Display Size

"Release for playback.

&

Deleting SD VIDEO Files (P.8-8)

Resuming from Stopped Point

Playing Repeatedly or Randomly © Changing Sound Effects

Changing Playback Size

Sorting Files (P.8-12)

-l' Switching audio output to wireless device (P.13-15)
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. Deleting Files
Delete other video files from Data Folder.

Deleting SD VIDEO Files

[Video File List] [¢] Select file »
®» (3] Delete » (u] » (3] Yes
» [u]

® Source files will be deleted.



Playlists
Playlists store playback orders. Add My Music » E Renaming Playlists

favorite media files to Playlists, or

organize files by artist/genre. All Mus:c E » In Playlists window,
Playlists store only file locations. Source Select file ® (=] (select Playlist) ®»
files remain in All Music or All Videos. All Music ;

Music Folder

i

Classic musi

- B
Adding to Playlist = SRR

Follow these steps to add a music file to

B All Music
ZER

Options
Add New Playlist

7 VYAM. gg;;i‘s EZ?:ill?st Title
. Delete Playlist
(m] » ({d Entertainment » = —
(w] ® (3] Media Player % (u] _
» [3] Music » [u] Add to Playlist % (u] Edit List Title » [=] » =
7 VfYAM » [u] Enter name ®» (=] g2
Last Played Music Show the list of b o]
playlists. You can o
b AupIo lay s edit S
WA ist) =
Download Music r?.&?illlﬁywezmtjoagd =
Music Search playlists. [2)
Settings ;
[ = 3
=
2
g
3
»
é@ Adding New Playlists " Deleting Playlist Files © Deleting Playlists ﬁ
Changing File Order (P.8-13) @
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. 1 . R
Try out the preloaded S! Applicatiqns or S! Appli Library %» E] . Exiting S! Applications
download and use 922SH-compatible St ool Library EIRY & s =
S! Applications, including games. [ I (2]
Refer to the S! Application's help menu or [ XXXXXXXX
the source Internet site, etc. for - F— N
operational instructions. XXXXXXXXXXXXXKB
Remote Control - XXXKB
. - El0ptions [ Start [ CheckEa
® Use a compatible S! Application to | . [ End |
control a TV, VCR, etc. via infrared. S! Appli Library e
(m] & [ Entertainment & (u] Select application # [u] End» [a]
S! Appli % [u] Network S! Applications ] .
® A message appears indicating that Pausing S! Applications
Internet connection is required. Follow _" Sus;'wenc'l » [u]
onscreen instructions. Res&]ml’n! RAPPHCEN:IEI
Incoming Calls esume .
® Incoming calls automatically pause = Select Cancel to open Main Menu and
S! Application. keep the S! Application paused.

; A
Opening S! Appli Request Log m Select End to end the S! Application.

In &, [2] Demand History % (u]

\@ Downloading S! Applications ¢ Setting S! Application to Activate in 1 Adjusting S! Application sound volume ¢ Canceling surround effect
Standby ¢ Deleting S! Applications (P.8-11) Showing incoming transmission notice  Pausing S! Application for
incoming mail © Setting handset to show notice at Alarm Time
Showing incoming S! Appli Request notice © Changing Screensaver
Activation Time © Restoring default S! Application settings © Restoring
default S! Appli Library (P.13-15)



Downloading S! Applications

Deleting S! Applications

[S! Appli Library] (] Download % (=]
® Follow onscreen instructions.

Setting S! Application to Activate in
Standby

M Activating Screensaver

[m] & (34 Entertainment » (] » 2]
S! Appli % [u] ® [J] Settings » (u]
» (2] Screensaver » [u] » (3]

Switch On/Off » u] » (] On » [u]

[l Setting Screensaver

[S! Appli Library] (2] Select
application » » [J] As
Screensaver » [u]

® As Screensaver appears for
compatible S! Applications.

® Screensaver may not start or operate
correctly when an external device
(Headphones, etc.) is connected to
handset.

[S! Appli Library] [2] Select
application » » (3] Delete »
(w] B (3] Yes » (u]

® Handset Code may be required.

® Cancel Screensaver to delete
Screensaver S! Application.

S! Appli

I_
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Additional Functions

& Additional Functions (Media)
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[Menu] Music: P.8-3, Video: P.8-4 [Playback Window] Music: P.8-5, Video: P.8-7 [File List] Music: P.8-5, Video: P.8-7

Music/Video Playback

Resuming from Stopped Point

Changing Sound Effects

Changing Sound Effects

[Menu] Last Played Music or
Last Played Video » [u]

Music Playback

Playing Repeatedly or Randomly

[Music Playback Window] »
(] Sound Effects % [u] % [2]
Select effect » [u]

Video Playback

Available for My Videos files only.

[Video Playback Window] »
Settings % (=] » (3] Sound Effects
» (u] ® 3] Select effect » [u]

Changing Playback Size

8-12

M Play Randomly

[Music Playback Window] »
Playback Mode » (=] »
Random » [u]

M Repeat Randomly

[Music Playback Window] »
(2] Playback Mode » (=] » [&]
Random Repeat % [u]

H Repeat One File

[Music Playback Window] »
Playback Mode » (=] »
Repeat % (u]

M Repeat All Files

[Music Playback Window] »
Playback Mode » (=] »
Repeat All » (=]

Playing Repeatedly or Randomly

H Play Randomly
[Video Playback Window] »

Settings % (u] & (3] Playback

Mode % (=] » (3] Random » (]
M Repeat One File
[Video Playback Window] »

Settings W (u] & ] Playback

Mode » (u] ® (3] Repeat » (u]
M Repeat All Files
[Video Playback Window] »

Settings W (u] ® ] Playback
Mode » (=] » (3] Repeat All » [u]

[Video Playback Window] »
Settings % (u] » 3] Display
Size ® (] » (2] Select size » (1]

Managing Files

Sorting Files

[File List] » (2] Sortw [u| »
(2] select option » (=]



| Additional Functions I—

& Additional Functions (Media)

Adding New Playlists

[Playlists Window] Music: P.8-5, Video: P.8-7

[Playlists Window] » (3] Add
New Playlist % [u] % Enter name
» (=]

Deleting Playlist Files

[Playlists Window] (2] Select

Playlist » (=] & [{] Select file ® %

(=] » (&] Delete ®» (=] » (3] Yes %

» (u] )
D

Deleting Playlists ‘t<_|3
Q0
w

[Playlists Window] (2] Select >

Playlist » » (3] Delete 3

Playlist % [u] ® (3] Yes » [u] 5
Q

Changing File Order §'
»

[Playlists Window] (2] Select

Playlist » (=] ® [] Select file ®

® (3] Change Order » (u] »

Move file #» [u] b
[
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Pen Light
Use handset as a flashlight. To use Mobile

Light as a strobe for mobile camera, see
P.7-13 "Activating Mobile Light."

(> (Long)
® Mobile light illuminates.
® Press a key to turn off.

Important Pen Light Usage Note
® Do not point Pen Light at people or look
at it directly.

senx3g Apuey




b

Access this handy guide to handset
settings and key functions/shortcuts.

[ )+@9)]

Phone Help
Settings Method
Commonly Functions
Key Operation

i

Mode Settings

Security Settings
Connectivity
etc. included.

= 1
Select item » (=]

® Press 44 to toggle guides.

Opening Function Help
While using camera, TV, etc., [[F |+@%]]

seJix3 ApueH




Calendar & Tasks

Opening Calendar . Switching View . Key Assignments

(w] » Tools » (m] B In Calendar window, == | Open previous Goto
PIM Tools » (] XA IR page (Enter Date)
= Open next Find
PIEiresteTcolsI | papge (By Category)
Calendar View Calendar, or
QhAlarms save and check Stamp' Select week?
CIWakeup TV Schedule entries.
[ Tasks Set Color Select date
ggigz:;::o&lemo Go to (Today)
- !Available in Month/3Month View.
= Example: 2Month View 2In Week View, select time block.
® Fress to toggle view. Searching Entries by Subject
Calendar » (] [Calendar Window] [[F ]+(F ]] »
T Enter subject » (1]
D Couow e s e Accessing Secret Entries
H [Calendar Window] [[F]+(c 1] %
Tn Enter Handset Code # (]
= O
N
(] @:Stam
EOptions View Swi tchEd

Calendar Window

m @E Changing Date Color ¢ Adding Stamps (P.9-31)




Saving Schedules

Follow these steps to save subject, start/
end date/time, Alarm and schedule details.
Either Subject or Description must be
saved per entry.

In Calendar window,
(select date) » [u]

L]

EOptions [=] [

<Add New Entry> w (]
Enter subject » [u]

Start Date & Time
[Exxx] / [xx] / [xx]
YYYY mM DD
:
HH MM
[JAIl Day
ECheck Accept |

Enter start date/time » [u]

New Entry
Subject: XXXX
Start: XX/XX
Category: #No Category
Alarm: No Alarm
Repeat Once Only
Location:
Description:

I = I SaveEd

Schedule Entry Window

End: % (u] & Enter end
date/time » (u]

Alarm: » [u]

Alarm Ti® 5058
Assign Tone/Video: Alert 1
Duration: 10 sec.
I =

Alarm Time: » (u] »
Select time » (u] » [

| Calendar & Tasks

I_

Description: % (=] »

Enter schedule details ® [u]

®» Saved

All-Day Schedule

In @), (=] » (=] » From

Custom Alarm Time

In &, (2] Alarm Time: » (u] »

Other » [u] ® Enter date/time » (=]

> » From

seJix3 ApueH
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(% ¢ Changing Alarm Tone/Video  Changing Alarm Duration © Hiding
Entries ¢ Saving Repetitive Schedules © Editing Schedules (P.9-31)
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Calendar & Tasks :

sedjx3 Apuey

. At Alarm Time

Alarm activates; sounds/vibrates by
related settings.

CalniaTAIARTI | S |

XXXXX XXXK/XX/XX XX:XK
I Stop Viewkd

To stop Alarm, press [®] or a Front/Side Key.

Opening Schedule
While Alarm is activated,

When Another Function is Active

® Alarm may not activate until handset
returns to Standby.

Incoming Calls

® Active Alarm stops for incoming calls.
Information window opens after handset
returns to Standby.

Opening Schedules/Tasks

In Calendar window,
(select date) » (=]

souoT W1 oF s

o AXXXXXXX
XXKXKK/XK

—

Schedule List

Select schedule or task
» (u]

» List returns

Opening Task List
In &, [3] (select task) » » (3]
Go to Tasks » [u]
Opening Related Message
After &, » (3] Related Mail » (=]
When Related Message is Saved
® To delete message from schedule, follow
these steps.
After &, (u] & [J] Related Mail: % [u]
» 5] Yes» m] B
Accessing Secret Entries
[Calendar Window] [ ]+(c ] »
Enter Handset Code » (u]

|E0ptions

Deleting Schedules

H Deleting One Entry

In schedule list, [2] (select
schedule) »

Delete » [u]

This Appointment % (u]
» [J] Yes » (u]

H Deleting All Entries of the Day
In Calendar window,
(select date) »

Delete % [u] » (2] All This
Day W (u] » (3] Yes  [u]

/
(% - Deleting All Schedules (P.9-32)



: Calendar & Tasks

I_

Enter subject » (u] Alarm Time: % (u] »

— Select time » (=] »
Follow these steps to save subject, due Due Dite &Tine I (=]
date/time, Alarm and task details. / / Description: % [u] B
Either Subject or Description must be Enter task details » [u]
saved per entry. :
p Y. HH W » Saved
(m] » (3 Tools » [m] B (3] -Dcﬁoklimit\ S . )
eC| \CCe|
PIM Tools » E’ D Task with No Due Date/Time
Enter due date/time » (u] In ©, (=] % (2] » From
Tasks » [m] nter du Custom Alarm Time
; In &, (] Alarm Time: » [u] » (]
AIINTESRS v R Other » [m] » Enter date/time » (=]
<Add New Entry> o Alarm » » From
Priority: Normal
Description:
Secret: 0ff
- [ o ] SaveEd
(Moot ions | — ‘ Task Entry Window
<Add New Entry>» [u] Alarm: % [u]
Alarm I 7 ]
Alarm Time: No Alarm
Assign Tone/Video: Alert 1
Duration: 10 sec

—

seJix3 ApueH

é Changing Alarm Tone/Video ¢ Changing Alarm Duration ¢ Hiding
Entries ¢ Editing Tasks (P.9-31)
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Calendar & Tasks :
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. At Alarm Time

Alarm activates; sounds/vibrates by
related settings.

Tasks Alarm

‘e @)

XXXXX XXXX/XX/XX XX:XX

] Stop. ViewEd

To stop Alarm, press [®] or a Front/Side Key.

Opening Task
While Alarm is activated,

When Another Function is Active

® Alarm may not activate until handset
returns to Standby.

Incoming Calls

® Active Alarm stops for incoming calls.
Information window opens after handset
returns to Standby.

(w] & (3] Tools » (=] B 3]
PIM Tools » [u]

Tasks » [u]

CI@XXXXXX
XX/XX/XX XX:XX

Task List
® Use to open completed or
uncompleted task list.

Select task » (u]

®» List returns

Accessing Secret Entries
After &), [(7)+[c ']] ® Enter Handset
Code » (u]

Marking Tasks as Completed
After ¢, (2] (select task) »

Deleting Tasks

M Deleting One Entry

In task list, 2] (select task)
»

Delete » [u]

This Task % (=] B
Yes » [u]
H Deleting All Completed Tasks

In task list,

Delete » [u] » (2] All
Comp. Tasks » [u] »
Yes » (u]

0
(% © Deleting All Tasks (P.9-32)




o 2] Exterhour Srooze: » [«
(24-hour format) ® Enter

Select interval » (u]

Follow these steps to set Alarm to sound .
minutes » .
at a specific time on a specific day of the (=] ® For custom intervals, select Other.
Set Al TP
week. — Alarm Volume: % (]
Set Snooze (Alarm repeats at set q j i Alarn 1
epeat: Once H
interval), Alarm Volume and Duration. poren Tone/Video: At 1 Adjust level » (m]
Snooze: Off
(w] » Tools » [u] B Alsrm Volune Levers Duration: » [u]
Ibration:
PIM Tools » ‘EI Duration: : — 10 sec‘v — Select time ’ E
Alarms » (u] Alarm Menu ® For custom Duration, select Other.
T 6 Repeat: » [u] » Saved
p—— Sel D, > (1] ® For more settings, repeat ) -
elected Days . =
For Once or Every Day (All), skip » Alarm settlng ends g_
- <
Settings aheadto Selecting/Canceling All Days m
i Selected Days In &, » Check All or =
I s Uncheck All % (1] s
Alarm List Excluding Holidays
In &), [2] (select day) » (=] (CI/&]) »
Complete selection #» Except
Cltxcont Hol idays Holidays » (] » » From
EOptions I Check
Select day » (=] (L/V]) »
Complete selection »
é@ Saving Entry Name © Changing Alarm Tone/Video © Setting m
Handset to Vibrate at Alarm Time (P.9-32)




Alarms I

senx3g Apuey
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At Alarm Time

Alarm activates; sounds/vibrates by
related settings.

Alarm

To stop Alarm, press [®] or a Front/Side Key.

When Another Function is Active

® Alarm may not activate until handset
returns to Standby.

Incoming Calls

® Active Alarm stops for incoming calls.
Information window opens after handset
returns to Standby.

. When Snooze is Set
Alarm repeats at the set interval.
Other Alarms do not activate while
handset is Snoozing.
Canceling Snooze
While Snoozing, (=] (or [I)) ® [3] Yes
» [u]
® Snooze is automatically canceled after a
period of time.

Canceling Alarm

In Alarm list, [J] (select
entry) »

Switch Off % (u]
® Reactivate entry to use the same
settings.

Reactivating Entry
In &, (] Switch On » [u]

Deleting Alarm

H Deleting One Entry
In Alarm list, (3] (select
entry) $
Reset Alarm » (u]

(8] Yes » [m]

H Deleting All Entries

In Alarm list, (2] (select entry)
» » (3] Clear All % [u]

Enter Handset Code » (=]
» (] Yes» (u]

é} Editing Entries (P.9-32)

I Sounding Alarm Time tone even in Manner mode

Activating Alarm

based on World Clock time (P.13-16)



Setting Wakeup TV

Follow these steps to activate TV at a
specific time on a specific day of the week.
® Complete Area Setup (P.6-3) beforehand.
® TV may not activate in poor signal conditions.

(w] W (& Tools » (=] » 3]
PIM Tools » [u]

Wakeup TV » (u]
Wakeup TV Ti® 058

F0|.' Manner Mode

Edit [
Wakeup TV List

--:—- % [m] B Enter hour
(24-hour format) % Enter
minutes » (u]

Set Alarm
Time:

Channel: Channel 1
Alarm On/Off: on
Assign Tone/Video: Alert 1
Alarm Volume: Level:3

I = Savel

Wakeup TV Menu

Repeat: & (u]

Selected Days » [u]
For Once or Every Day (All), skip
ahead to

Selected Days  [Wf]i 5058
[

[=0ptions I Check

Select day » =] ((J/V)) »
Complete selection »

Channel: » (u]
Select channel » (=]
®» Saved

® For more settings, repeat ©) -

®» Wakeup TV setting
ends

Selecting/Canceling All Days
In &, » (3] Check All or
Uncheck All % [u]
Excluding Holidays
In &, [2] (select day) » [u] (C)/M]) »
Complete selection ®» Except
Holidays » (] » » From
Canceling Alarm
® Alarm activates at Wakeup TV time. To
cancel Alarm, follow these steps.
[Wakeup TV Window] [¢] Alarm On/
Off: W (u] & (3] Off » (=] » From
Adjusting Alarm Volume
[Wakeup TV Window] (2] Alarm
Volume: » [u] ® (3] Adjust level »
(=] » From

Wakeup TV

Using Wakeuwptv. ...

seJix3 ApueH

/7
(% - Changing Alarm Tone/Video (P.9-33)

I Sounding Alarm Time tone even in Manner mode (P.13-16)
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Wakeup TV :
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At Wakeup TV Time

TV activates after Alarm.

Wakeup TV Ti®

XX:XX
[ Startv

Stopping Alarm Instantly

® While Alarm is activated, press (w] ora
Front/Side Key.

When Another Function is Active

® TV may not activate depending on the
function.

After TV is On for a Period of Time

® Confirmation appears. Choose Yes and
press [m] to exit TV.

Canceling Wakeup TV

In Wakeup TV list, [2] (select
entry) »

Wakeup TV Off » (u]
® Reactivate entry to use the same
settings.

Reactivating Entry
In &, [2] Wakeup TV On » [u]

Deleting Wakeup TV

H Deleting One Entry
In Wakeup TV list, 2] (select
entry) »
Reset Alarm » (u]

Yes » (u]

H Deleting All Entries
In Wakeup TV list, (2] (select
entry) » » (2] Clear All
» (s
Enter Handset Code » [u]
» [J] Yes » [u]

@ Editing Entries (P.9-33)



Calculator

(w] W (& Tools » (=] » 3]
PIM Tools » [u]

Calculator » [u]

(]

NEmEEEE (.

LT L T
ElOptions = [ ExitE

Calculator Window

Use Letter Keys to enter
digits ® Calculate

® Clear Memory before starting new
Memory calculations.

® Calculator ends

. Key Assignments

H Numbers
0 5 |76
1 |2 6 |k¥0E
2 | /WA 7
3 |MAE3 8
4 | bART 9
H Calculations
+ (Add)
- (Subtract)
x (Multiply)
+ (Divide)
= (Sum) (m]
C:CE (Clear)

CM (Clear Memory)

RM (Recall Memory)

(4

M+ (Add to Memory)

2

. (Decimal)

+/- (Positive/Negative Value)

% (Percentage)

Spoce/si =

Memory Calculation

® Numbers saved in Memory remain until
handset power is turned off.

Incoming Calls

® Calculations are not affected. End the
call to return to Calculator.

Using % Function

Use to find definite percentage of

a known value.

Example: Calculate 30% of 800,000

Enter 800,000 % x % 30% %

® 240,000 appears.

seJix3 ApueH

/7
(% ¢ Copying Calculation Results ¢ Changing Exchange Rate for Currency

Conversion

Converting Currencies (P.9-33)
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Expenses Memo
Entering Expenses Checking Entries ®» Menu returns

Enter amount % (w] B (3 Tools » (=] B Saving Entries to Notepad
PIM Tools » [u] [Expenses Memo List] [2] Select
e — il entry » » (3] Save to Notepad
Expenses Memo % [u] » (=]
Expenses Memo Deleting Entries
Add New Expense
Totals -
£oit Category H Deleting One Entry
(e e In Expenses Memo list,

(select entry) »

v - = Delete Item » [u] »
[GlNo Categor Ye
T OMscIIaneous Totals » ‘E’ e_s » ‘E’ .
] OvVehicle H Deleting All Entries
QOAirfare G 058 .
< Osramine DIX/XX/XY XEXK In Expenses Memo list,
g Ohotel” » (3] Delete All » [u]
3 QOEntertainment
2 L& Enter Handset Code » (=]
Select Category » (u] » — = » (2] Yes » [u]
Saved EI0ptions | Change |

Saving under Custom Category Expenses Memo List

In ©), (8] Other ®» [m] ®» Enter name
» (=]

m @9 Changing Category of Saved Entry ¢ Changing Amount (P.9-33)
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Using Stopwatch

Stopwatch stops when battery runs low.

(w] & (3] Tools » (=] B [3]
Timer/Clock Tools W (]

Timer/Clock Tools [l
4] Record elapsed
time for up to,
but not including,
24 hours in

0. 1-second
increments.

X Countdown Timer
@World Clock
4 Hour Minder

(=] I

Stopwatch » (]

Stopwatch Ta® 5058
LAP 1

Start |
Stopwatch Window

(=] ®» Stopwatch starts
(=] & Stopwatch stops

® Press [m] to resume.

» (] Yes» [n] »

Stopwatch ends

® Records are deleted when
Stopwatch ends.

Recording Lap Times
While Stopwatch is running,
Saving Records to Notepad
After ©), » (3] Save to Notepad
» [u]
Resetting Records
After (), » (] Reset® (u] »
From
Incoming Calls
® Stopwatch is not affected by incoming
calls. End the call to return.

seJix3 ApueH

9-15



Countdown Timer
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(m] & (3] Tools » (=] » (7]
Timer/Clock Tools » [m]

Countdown Timer » [u]
Countdown Timer

Enter Time
(1sec-60min)

0:00

9-16

Timer Entry Window

Enter minutes ®» Enter
seconds » [u]

Countdown Timer [ 15058

Time Remaining

EEdit ] Start
Countdown Timer Window
® Press to change time.

(=] » Countdown starts

® Press [m] to stop/resume countdown.

Set time elapses ®» Tone
sounds

» (3] Yes (u]
Countdown Timer ends

Resetting Timer
Stop countdown and
Incoming Calls
® Countdown is not affected by incoming
calls. End the call to return.

. When Set Time Elapses

Tone sounds.

Countdown Timer

Timer Expired

I I StopEa

To stop tone instantly, press ora
Front/Side Key. (Tone stops automatically
after a period of time.)

When Timer Time Elapsed during a Call
® Tone sounds after the call.



World Clock
=] % & Tools # (=] Select area % [x]

Timer/Clock Tools #» [u] ®» World Clock ends (m] ® F4 Settings » [u] »
World Clock » E, Advancing One Hour (Daylight Saving) Phone Settings » E »
Local Time Zone ~ World Time Zone [Set Time Zone Window] Display » (m]
GTIGROIGE | R ® To cancel, press [37]. Standby Display #» [u]
Tokyo Tokyo Standby Display
My;me()\ty XX : XX Th;thercm XX'XX a Clock (W)

Show Indicators

XXXX/XX/XX XXX XXXX/XX/XX XXX
Show Operator Name Off

Edit
(m] [
o
Pt Clock/Calendar % [u] 3
<
Tok
Ak World Clock (L), etc. » (=] @
T 100:00 E"':'
¥ 1505 ]
@ &2 :Select Time Zone
ECustom Accept Summer_TimeEd
Set Time Zone Window
é@ Adding Custom Time Zone (P.9-34) m

9-17
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Using Hour Mind

Setting Hour Minder

Follow these steps to activate the hourly
time signal at selected hours.

(m] & (3] Tools » (=] » (7]
Timer/Clock Tools » [m]

Hour Minder % [u]

Hour Minder T 15058
Switch On/0ff of f
Select Time Every Hour
Advanced

[———]

Hour Minder Menu

Switch On/Off % [m] B
Onw [u]

Select Time » [u]
Select hour » (=] (/)

» Complete selection »

®» Saved

® Hour Minder setting
ends

Adjusting Hour Minder Volume
In ©), (3] Advanced » (=] » 3]
Volume: » (] & [J] Adjust level »
(m] » » From

Changing Hour Minder Duration
In ©), (3] Advanced » (=] » 3]
Duration: % (=] ® (3] Select time »
(m] » » From

® For custom Duration, select Other.

Selecting/Canceling All Hours
In ), » (3] Check All or
Uncheck All » [u]

At Hour Minder Time

Hour Minder activates; sounds/vibrates by
related settings.

Hour Minder

XX:XX
Stop

[ ]

To stop tone instantly, press [®] or a Front/
Side Key.

When Another Function is Active

® Hour Minder does not activate.

Incoming Calls

® Active Hour Minder stops for incoming

calls.

Canceling Hour Minder

In Hour Minder menu,
Switch On/Off % [u] B
Off » (u] »

9-18

@ Changing Hour Minder Tone/Video
Hour Minder Time (P.9-34)

Setting Handset to Vibrate at

I Sounding Hour Minder Time tone even in Manner mode © Activating

Hour Minder based on World Clock time (P.13-16)



Dictionary/Sea

Activate Jispa (preloaded dictionary Switching Dictionaries
application by Gakken Corporation) to [Dictionary Window] »

look up words in Japanese-Japanese, Select type »

English-Japanese and Japanese-English Using Dictionaries in Text Entry Windows
dictionaries. (Long)

Copying Definition Text

After ), (m] » [ Select first
— T character ®» (=] ® [ Highlight text
ER range » [u]
Changing Font Size

[Dictionary Window] [[F2 ]+ 9]

(enlarge) or [ ]+ 9] (reduce)
Opening Dictionary Information

[Dictionary Window] »
El0ptions [ Swi tchEd Information % El

Dictionary Window

Enter reading (spelling for
English-Japanese
dictionary) ® [J] Select
word » [u]

seJix3 ApueH
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—I Dictionary/Search :

b

Search text on the Internet or within sent/ Search » [m]
received messages. For Mail Search, select an option and
press (m].
E‘ » Tools »»E‘ » ® Search results appear.
Doc./Rec. Tools E Searching within PC Sites
Search » (u] [Search Window] (=] # [§] Change
Browser % [u] » 3] PC Site
Input key word to BI'OWSOI'» ‘El
QL |gearch, Searching within Sent or Received
@® Web Search Messages
O Mail Search [Search Window] » (2] Change

Mail Folder » [u] » [2] Sent Messages
or Received Messages % [m]

|E0ptions I Edit
Search Window

Select entry field » [u]
®» Enter search text » (=]

Select search type » [u]

senx3g Apuey
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Supported File Formats: (m] B (5] Tools » (u] B . Key Assignments

| PDF (.pdf) | Doc./Rec. Tools » (u]
View whole page

| Microsoft® Excel® (xls) | Document Viewer » (=] Scroll

| Microsoft® Word (.doc) | TGS N - View upper left

- XXXXXKK &z Full screen

| Microsoft® PowerPoint® (.ppt) | e View upper right

View center

® Some files may not appear correctly.

® Download files via the Internet.

® When transferring files from PCs, save to
corresponding Memory Card folder

(P14-20). Select file #» (u]

View lower left
Jump to page
View lower right
Open Help
Next page
Previous page
Fit width

Rotate 90°

Show Loupe
(magnifier tool)

Zoom in

Continuous zoom in
Zoom out

[[F]+£ 9] (Long) | Continuous zoom out

View

EOptions

[ 3 o) | ) ol ) 2 |

(Long)

seJix3 ApueH
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Notepad
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b

New Notepad Entry

(m] & (3] Tools » (=] » (7]
Doc./Rec. Tools » [u]

Notepad » (=]

=

Notepad List

<Add New Entry>» [u]
5

:Dict X/XXXX

EOptions ] Done Cancel

Enter text » [u]

Select Category » (=] »

Saved

Sorting Entries Temporarily
[Notepad List]

m Press repeatedly to toggle sort
options (Modified, Created, Category
and Accessed).

Changing Notepad List View
[Notepad List] [¥] Select entry »
» (2] Setting/Manage » [u] »
Default View » (=] # (3] Select
option » (=]

Opening Notepad

In Notepad list, (2] (select
entry) » [u]

Notepad T
#No Categor

y
XXXXXXXXXXXXXXXXXXXXXXXXX

ElOptions | EditText |
» List returns

Deleting Entries

H Deleting One Entry

In Notepad list, (2] (select
entry) »

Delete Item » [m] B
Yes » [u]

H Deleting All Entries

In Notepad list, [J] (select
entry) » » (3] Setting/
Manage » (u]

Delete All % (=] & Enter
Handset Code » (=] B
Yes » [u]

@7 Editing Notepad  Searching Text within All Entries  Inserting
Notepad Text into Message Text © Sending Notepad Entries via S! Mail
Inserting Notepad Text during Text Entry (P.9-35)



o |f battery runs low while recording, Voice
Recorder shuts off.

® Record conversations during calls via
Record Caller Voice (P.3-13).

(w] & (3] Tools » (=] B 3]
Doc./Rec. Tools » [u]

Voice Recorder » (]
Voice Recorder

XXKKKK/ XXKKXK

ElOptions [=)
Recording Window

(=] ® Recording starts

(=] ® Recording stops
T

Voice Recorder
Save

Playback
Save and Send

Save recorded
voice memo.

[ [
® For Extended Voice, recording is
saved automatically.

Save » [u]

Play Before Saving
In &, [2] Playback » (u] » Playback
starts » » Playback stops
Starting Over
In 5, » From

Playback

In recording window,
Ring Songs-Tones » [u]

Ring Songs-Tones[:]
® Free: XXMB
Need size: ——KB
voiceXXX

EOptions [ Play I
Select file » [u]

® Use [2] to adjust volume.
® Press (] to pause/resume. Press
to stop playback.

Playing Data Folder Files
[w] & (34 Data Folder » [u] »
Ring Songs-Tones » (u] » [
Select file » [u]

Voice Recorder

seJix3 ApueH

(% Saving Longer Recordings
Switching Storage Media (P.9-35)

Sending Voice Files via S! Mail
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Scanning Printed Barcod

Scan UPC/JAN (1D barcodes) or QR

Codes (2D barcodes).

® Slide Portrait/Macro Selector to Macro ()
beforehand.

® Membership file or password may be
required when scanning barcodes.

® Some barcodes may not be scanned.

(w] & (3] Tools » (=] B (3]
Doc./Rec. Tools » [u]

Barcode/Scan % [u]
Bar code/Scan

Scan printed
Open Barcode barcodes.
Create QR Code
Scan Card
Scan Text
Scanned Resul ts

I =

Barcode/Scan Menu

Scan Barcode » [u]

Frame barcode in center of
Display

Focus Adjustment Bar

e [] @ |15058

Normal Scanning

A

Eloptions Scan Cancel

Scan Window
® Use Focus Adjustment Bar as a
guide (better focus in darker blue).

(m] ®» Scan starts

® |f recognition takes time, slowly
adjust the distance between handset
and barcode.

® Press to stop scan.

Tone sounds ®» Scan
results appear

[aabb@xxx. x4

ElOptions
Barcode Scan Results Window

Key Assignments in Scan Window
[8%): Mobile Light on/off
fo): Adjust brightness
Split Data
® After scanning, confirmation appears.
Follow onscreen prompt(s).
® Scan results do not appear until all split
data is scanned.
Starting Over
After &, (=5 & (3] Yes » [u] »
From

n
(% ¢ Scanning during Text Entry
Using Linked Info © Saving Scan Results
Results © Using Images as Wallpaper

Opening Saved Scan
Saving Linked Info to Phone

Message Text

Reading Saved Barcode Images Book ¢ Saving Images & Melodies ¢ Opening or Playing Files © Using
Images for System Graphics
Copying Text (P.9-36 - 9-37)

Saving to Notepad © Pasting to



Create QR Code

Creating QR Codes

Create QR Codes from these items on
handset:

| Phone Book | |

Text Input |

[ Ring Songs-Tones | | Pictures |

Notepad

Large items are divided into multiple QR
Codes.

Procedure

Follow these steps to create QR codes
from Data Folder files.

(w] & (3] Tools » (=] B 3]
Doc./Rec. Tools » [u]

Barcode/Scan » (u]

Barcode/Scan T

Scan printed
Open Barcode barcodes.
Create QR Code
Scan Card

Scan Text
Scanned Resul ts

Create QR Code » (u]
Data Folder » (=]

Data Folder Ti®

Ring Songs-Tones
Notepad
Other Documents

[ = Cancel

Select folder » (=] »
Select file or entry » [u]
® QR Code is created.

® QR Code is saved to Data Folder
(Pictures).

From Phone Book Entries
In ©, (3] Phone Book » (=] »
Select entry » [u] »
From Entered Text
In ), [2] Text Input » (=] & Enter
text » [u] »
Switching Storage Media
In &), (=] & (2] Save to» =] » (3]
Phone or Memory Card » [u] » [u]
Attaching to S! Mail
In G, (=] ® (2] Send As » (=] »
Complete message »
Incoming Calls
® QR Code creation is not affected by
incoming calls. End the call to return.

seJix3 ApueH
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Scan business cards and save names, Frame card on Display (m] »
addresses, etc. to Phone Book. 7 ® New Phone Book entry is saved.
@ Slide Portrait/Macro Selector to Macro (&) e Key Assignments in Scan Window
beforehand. XA (8%]: Mobile Light on/off
® English business cards may not be A fo: Adjust brightness
scanned correctly. e If Text Exceeds Phone Book Entry ltem
® Some cards may not be scanned. ! oo Character Limit
[m] » Tools » [u] » lons Read Can ® Confirmation appears. Follow these
) steps to delete overage.
. 3 Scan Wind
Doc./Rec. Tools » [u] can Window ) ves » [8]
Barcode/Scan % (u] (m] Starting Over
® Press to stop scan. After C, » [ Yes® [a] »
Barcode/Scan i i 5058 From
Scan Barcode ggfgozgénted E ®» Scan results appear

Open Barcode
Create QR Code
Scan Card

Scan Text
Scanned Resul ts

Scan Resul t )

| =

Scan Card » [(u]

senx3g Apuey

Card Scan Results Window

é? Saving to Notepad © Pasting to Message Text © Copying Text
(P.9-37)
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Text Scanner
Scan text (URLs, mail addresses, phone Frame text in center of E

numbers or alphanumerics). Display
@ Slide Portrait/Macro Selector to Macro ()

Scanned Text Ti®

Focus Adjustment Bar LOOCCKOXXXXXKXKXXXX XXX

beforehand.
® Some text cannot be scanned. 1. Capture characte?ﬂ 8
(m] & (] Tools » (u] B [J] |
Doc./Rec, Tools » ‘E’ XXXXXXXXXXXXXXXXXXXXXXXXX
= — ElOptions. [
Barcode/Scan » (u] 2 Scan uhen bar s the bluest. Scanned Text Window
Barcode/Scan  [f FE [EOptions T Scan CancelEZ Key Assignments in Scan Window
O B ﬁg?goggy‘e" Scan Window [&3): M_obile L_ight on/off
Create QR Code ® Adjust to frame text in [ ]. t2d: Adjust brightness
gggz gg;tti ® Use Focus Adjustment Bar as a For White Text on Black Background
Scanned Resul ts guide (better focus in darker blue). In O, » (2] Reversed Text » (] -
» (5] Reversed » (=] % From 2
= ‘ ‘EI Correcting Text Type s
- ® Press to stop scan. After (), » (0] Change Mode » m
Scan Text » . (=] » (3] Select type » [u] » =
=y
Select line ® (2] ® Scan Editing Scanned Text a5
results appear After &, (=] & (2] Select/Edit » (=] »
Select text » (7] Select alternative
from list or edit directly »
Starting Over
In &, =] » (2] Yes » (=] ®» From
(G” Scanning during Text Entry © Using Linked Info © Saving Scan
Results ¢ Opening Saved Scan Results  Saving Linked Info to Phone
Book ¢ Saving to Notepad  Pasting to Message Text © Copying Text
(P.9-36 - 9-37)
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Receiving, Content Updates (! |

Transmission fees apply.

Registering S! Quick News ltems Eﬁlliljc 559 (u)» Updating Items Manually
Yes » [S! Quick News List] (2] Select item
(w] & (2] Entertainment » (]

. ® Handset connects to the Internet. » » (3] FEF» (u] > [3] —ffor
» (3] S! Quick News W [u] . 2% (1]
Select item » (u]
STNCUTERARERSI (] ST Sfm ® Follow onscreen instructions. . Indicators
Sl L List Quick News, Check . q
Settings the latest’ Opening Information & Unread Special news
Undate, etc. B . @ i
pdate, ete In S! Quick News List, = Read Special news
. &y
(select item) » El & Unread News Flash
I = o Title list appears. @ Read News Flash
O Unread General news
o .
S! Quick News Menu Select title » (=] 0 Read General news
%::: S! Quick News List » [u] SI Quick News List I/ o -] Auto update disabled
@ S NER M
& 51 Quick News Listi N T
= — By =7 =
N CCr=re—" o
-3 . AN DRI E, ERDBHE,
= :
™ = adicn XOFSE TR 3
I i M=HmE Moy R9-5E A ¥
= gs5n BAREOBF Y
- JRE ] iR [ *=a2-—
TR . ® Press to return to item list, or

S! Quick News List press to open next title.

0

(7 ¢ Receiving S! Loop Item Updates © Updating List Automatically

m Checking Update Schedule ¢ Changing Background Image
Deleting S! Quick News Items (P.9-38)
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S! Information Channel

® Transmission fees apply.
® Only available within Japan on compatible 3G handsets.

Service Registration & Content Subscription New Received Information Using Weather Indicator

E| » Entertainment » Information window opens for new After S! Information Channel registration,
(m] » S! Information S! Information Channel info delivery. local area weather indicator appears in
Channel/Weather % [u] While Information window Standby.
St Info. Channel appears, | 2] S! Info. Channel © | Clear skies (day) | 8 | Snow
fhatis lew » (u] 2 | Clear skies (night) | @ | Thunder showers
sz'f;;:g“gggigﬁz @ S! Information Channel page opens. & | Cloudy [> | Then
S! Info. Ch. Notif.  on Follow onscreen instructions. “ | Rain / | Partly/chance of
Weather | i
cather feon ® S! Information Channel page Example: /4 # Partly cloudy with a
handling is similar to that of Yahoo! )
I =i Keitai. chance of rain -
Sl Information Channel Menu Indicators for chance of rain, seasonal p
N Iy
. . ®» Page closes events, etc. appear at the same time. 2
Registration/Cancel » [u] ] at
® Handset connects to the Internet. Opening Unread Latest Issue 2 Update. -
Follow onscreen instructions. [S! Information Channel Menu] (] [S! Information Channel Menu] S
' What's New » [u] Weather Icon » (] & [J] Manual @
Opening Back Issues Update » (=] & [] Yes » (u]
[S! Information Channel Menu]
History » [u] & (3] Select date » [u]
(GV Saving Files to Data Folder © Changing Display Size ¢ Changing -l' Hiding Weather Indicator in Standby  Canceling Weather Indicator
Scroll Unit © Copying Text  Requesting Re-Delivery ¢ Checking automatic updates (P.13-16)
Weather Forecast (P.9-39)
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Reading e-Books (Japanese)

Visit SH-web for e-Book order information, Read XMDF books and dictionary files.
etc. Some files may not be supported.
» [ X=z—-UX P (m] & (3 Entertainment » [u]

» (u]

T

Entertainment

IS Media Player Ml_ASic
g}s '.7:77'555» E’ AAS! Appli gldeos
i : %,S! Quick News treaming
® Follow onscreen instructions. ®S! Information Chan..|SeLtines
8 BookSur fing are included.

® Downloaded e-Books are saved to o-Book Viower
Data Folder (Books).

[ o T

Entertainment Menu

e-Book Viewer #» (]

® e-Book Viewer starts. Refer to the
e-Book Viewer help menu for
operational instructions.

Note

® Pages appear in portrait orientation if
opened e-Book does not support
landscape view.

BookSurfing®

Download Contents Keys and read CCF files.
Some files may not be supported.

In Entertainment menu,

BookSurfing » (u]

® BookSurfing® S! Application starts.
Refer to the BookSurfing® help menu
for operational instructions.

Moving CCF Files via Memory Card

® When purchasing a new handset, move
CCF files and retrieve Contents Keys to
open the files. Some files may need to be
re-downloaded.

@ Copying Text © Opening Non-922SH e-Books (Library) (P.9-39)



Additional Functions

5 PIM Tools
[Calendar Window] P.9-4 [Schedule Entry Window] P.9-5 [Task Entry Window] P.9-7 [Schedule List] P.9-6 [Task List] P.9-8

Calendar & Tasks . Saving Schedules/Tasks . Saving Schedules

. Calendar

Changing Date Color

Changing Alarm Tone/Video

Saving Repetitive Schedules

H By Days of the Week

[Calendar Window] »
Calendar Settings » (u] ® (3] Set
Color % (u] & [J] By Week » (]
» (J] Select day » (=] ® 3] Select
color » (]

M By Date

[Calendar Window] Select date
» » (3] Select color » [u]

M Resetting "By Date" Colors
[Calendar Window] »
Calendar Settings % [u] » 2] Set
Color » (u] » (3] Reset Color %
(] » [$] Select option » [u] »
Yes » [u]

Adding Stamps

[Schedule Entry Window]/[Task
Entry Window] (5] Alarm: & [u] »
(8] Assign Tone/Video: » [u] »
Select folder » [u] » [ Select
tone/file » (] »

® Select start point if required.

Changing Alarm Duration

[Schedule Entry Window]
Repeat: » [u] ® 2] Select cycle #»
(=] ®» Enter repeat time » (]
»
® Repeat time is not available for Every
Year.

Editing Schedules

[Schedule Entry Window]/[Task
Entry Window] (5] Alarm: & [u] »
(2] Duration: % [m] ® [3] Select
time » (=] B

® For custom Duration, select Other.

Hiding Entries

[Calendar Window] (Month/3Month
View) (4] Select date » »
Select stamp » [u]

[Schedule Entry Window]/[Task
Entry Window] [$] Secret: » [u] »
Oonw [m]»

[Schedule List] 5| Select Schedule
» (=] » (5] Edit® (s] » [3]
Select item ® (=] ® Edit in the
same manner as saving schedules
L CIR 2

. Saving Tasks

Editing Tasks

[Task List] (2] Select task » »
Edit % [u] ® (5] Select item »
(=] ® Edit in the same manner as
saving tasks » (1] B

sesnxg Apueyq
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Additional Functions :
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k& PIM Tools

. Managing Schedules

Deleting All Schedules

[Calendar Window] P.9-4 [Task List] P.9-8 [Alarm Menu] P.9-9 [Alarm List] P.9-9

[Calendar Window] » (0] Delete
» [u] » (3] All Appointments » (u]
®» Enter Handset Code # [u] »
Yes » (u]

. Managing Tasks

Saving Entry Name

[Alarm Menu] [¥] Subject: » (=] »
Enter name #» (1] »

Setting Handset to Vibrate at Alarm
Time

[Alarm Menu] (2] Vibration: » (=] »
On or Link to Sound » (=] %

® Select Link to Sound to allow compatible
SMAF files to control vibration.

Changing Alarm Tone/Video

Editing Entries

Deleting All Tasks

[Task List] » (3] Delete » (]
» (3] All Tasks % (=] ® Enter
Handset Code » [u] ® (3] Yes » [u]
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H Using Preset Tone or Data Folder File

[Alarm Menu] [ 2| Assign Tone/Video:
» [n] » (3] Select folder » [u] »
Select toneffile » [a] B

® Select start point if required.

l Using Customized Screen Tone/Video

[Alarm Menu] [¢] Assign Tone/
Video: » [u] & (2] Customized
Screen » (u] »

[Alarm List] (2] Select entry » [u]
» (7] Select item ®» (=] ® Edit in
the same manner as saving entries
» (=] »



& PIM Tools

| Additional Functions

I_

[Wakeup TV Menu] P.9-11 [Wakeup TV List] P.9-11 [Calculator Window] P.9-13 [Expenses Memo List] P.9-14

Changing Alarm Tone/Video

Copying Calculation Results

Changing Category of Saved Entry

H Using Preset Tone or Data Folder File

[Wakeup TV Menu] [2] Assign
Tone/Video: % [m] ® 3] Select
folder » (=] » (3 Select toneffile
» (s
® Select start point if required.
[l Using Customized Screen Tone/Video

[Wakeup TV Menu] (3] Assign

Tone/Video: » [u] %
Customized Screen % [u] »

Editing Entries

[Wakeup TV List] [2] Select entry
» (=] » [] Select item » [n] »
Edit in the same manner as saving
entries » (1] B

While result appears, [[F ]+[c =]

Changing Exchange Rate for
Currency Conversion

[Expenses Memo List] |¢] Select
entry ® (1] ® 3] Select Category
» (1]

[Calculator Window] »
Money Converter % [u] »
Exchange Rate % (=] »
Domestic or Foreign % (u] »
Enter rate » [u]

Changing Amount

Converting Currencies

[Calculator Window] Enter amount
of money ® [[(]+[2 9] (to foreign
currency) or [ ]+ 9] (to
domestic currency)

® Set Exchange Rate first.

[Expenses Memo List] |¢] Select
entry » » (3] Change
Amount % [u] » Edit » (u]

seJix3 ApueH
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—I Additional Functions I

& Timer/Clock Tools
[Set Time Zone Window] P.9-17 [Hour Minder Menu] P.9-18

Adding Custom Time Zone Changing Hour Minder Tone/Video

[Set Time Zone Window] » H Using Preset Tone or Data Folder File
Enter city name » (=] » (§] +or - [Hour Minder Menu] (2] Advanced
» (o] » Enter time difference » [u] » (u] » (3] Assign Tone/Video: %
(=] » (5] Select folder » [u] »
Select tone/file » (=] » »
® Select start point if required.
[l Using Customized Screen Tone/Video

[Hour Minder Menu] |&] Advanced
» (u] ®» [3] Assign Tone/Video: %
(=] » [2] Customized Screen » [u]
» »

Setting Handset to Vibrate at Hour
Minder Time

sedjx3 Apuey

[Hour Minder Menu] [£] Advanced
» (u] & (3] Vibration: » (=] »
On or Link to Sound % (=] »
»
® Select Link to Soundto allow compatible
SMAF files to control vibration.
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| Additional Functions I—

% Doc./Rec. Tools

[Notepad List] P.9-22 [Recording Window] P.9-23

Sending Notepad Entries via S! Mail

Editing Notepad

M Editing Text

[Notepad List] [2] Select entry »
» (2] Edit Text » (=] » Edit
text » [u]

l Changing Category

[Notepad List] [2] Select entry »
» (3] Change Category » (]
» 3] Select Category » (u]

[Notepad List] [¢] Select entry »
(=] » [2] Send » (u] & [2] Via
Message » (u] » Complete
message »

Saving Longer Recordings

Inserting Notepad Text during Text
Entry

[Recording Window] »
Record Time » [u] » (3] Extended
Voice » (u]

Searching Text within All Entries

[Notepad List] [¢] Select entry »
» (3] Search % (=] » Enter
text » (u]

Inserting Notepad Text into
Message Text

[Notepad List] (2] Select entry »

» (3] Send » (=] » [7] As Msg.
Text » (=] & (3] S! Mail or SMS »
(=] ®» Complete message »

® S! Mail Composition window opens
automatically depending on character
count.

In a text entry window, »
Notepad ®» (u] » (J] Call Notepad
» (=] » [] Select entry » (u]

Sending Voice Files via S! Mail

[Recording Window] (=]
Recording starts » (1] ® Recording
stops ® (&] Save and Send » [u] »
Complete message »

® Available in For Message mode.

Switching Storage Media

[Recording Window] »
Save Recording to % [u] »
Select option » [u]
® Available in For Message mode.
® Set to Ask Each Time to select media
after every recording.

seJix3 ApueH
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k& Doc./Rec. Tools

Scanning during Text Entry

Scanning during Text Entry

H Pasting All Scan Results

In a text entry window, [[F]+[&]]
» (3] Scan Code ®» (8] » Frame
barcode in center of Display » [m]
» (=]

H Pasting a Part of Scan Results

In a text entry window, [[F J+[&]]
» (2] Scan Code » [u] ®» Frame
barcode in center of Display » (=]
» » (34 Select first character
» [m] » (3] Highlight text range
» [u]

In a text entry window, [[F J+[&]]
» (0] Text Scanner » (8] » Frame
text in center of Display » [u] »
(2] select line » [u] » (=]

[Barcode/Scan Menu] P.9-24 [Barcode Scan Results Window] P.9-24 [Scanned Text Window] P.9-27

M Accessing Internet Sites

[Barcode Scan Results Window]/
[Scanned Text Window] (4 Select
URL » (u]

Saving Scan Results

[Barcode Scan Results Window]/
[Scanned Text Window] » (3]
Save » [u]

Using Linked Info

Opening Saved Scan Results

Reading Saved Barcode Images

9-36

[Barcode/Scan Menu] |¢] Open
Barcode » (m] ® [3] Select file # [u]

H Dialing Numbers

[Barcode Scan Results Window]/
[Scanned Text Window] (4 Select
number » (u] B

M Sending Messages

[Barcode Scan Results Window]/
[Scanned Text Window] & Select
mail address ® [u] » Complete
message »

® When MAIL TO: appears in scan
results, press [m] to enter the items
underlined with a dotted line
automatically in Composition window.

[Barcode/Scan Menu] [¢] Scanned
Results % [u] & (3] Select file ® (=]
® Select a file and press to rename
files, open properties or delete files.
® Some files may not open.

Using Images as Wallpaper

[Barcode Scan Results Window]
Select image » » [J] Set
as Wallpaper % [u] » (2] Select
display option » [u] » [u]



| Additional Functions I—

% Doc./Rec. Tools

[Barcode Scan Results Window] P.9-24 [Scanned Text Window] P.9-27 [Card Scan Results Window] P.9-26

Saving Linked Info to Phone Book

Using Images for System Graphics

[Barcode Scan Results Window]/
[Scanned Text Window] ¢34 Select
number or mail address #» »
Save to Ph.Book W (1] ® [2] As
New Entry » [u] & Complete other
fields »

® To add to an existing entry, select As
New Detail.

® When MEMORY: appears in scan results,
press [®] to enter the items underlined
with a dotted line automatically in Phone
Book entry window.

Saving Images & Melodies

[Barcode Scan Results Window]
Select image » » (3] As
System » [u] ® (7] Select item »
[w] » =] B [34 Specify display
area » (u]

® Some images may be usable without
specifying display area.

Saving to Notepad

[Barcode Scan Results Window]
Select file » ®» (0] To Data
Folder » (u]

Opening or Playing Files

[Barcode Scan Results Window]/
[Card Scan Results Window]/
[Scanned Text Window] »
Notepad » (=]

Pasting to Message Text

H Selected Text

[Barcode Scan Results Window]/
[Card Scan Results Window]/
[Scanned Text Window] »
Send Message » (] » »
Select first character » [u] »
Highlight text range » (] »
S! Mail or SMS » (=] » Complete
message »

® S! Mail Composition window opens

automatically depending on character
count.

Copying Text

[Barcode Scan Results Window]
Select file » (]

M All Text

[Barcode Scan Results Window]/
[Card Scan Results Window]/
[Scanned Text Window] »
Send Message % [u] » [u] »
S! Mail or SMS % (=] » Complete
message »

® S! Mail Composition window opens
automatically depending on character
count.

M Text

[Barcode Scan Results Window]/
[Card Scan Results Window]/
[Scanned Text Window] »
Copy » [u] » 3 Select first
character ®» [u] ® (3] Highlight
text range » (u]

Hl Number, Address or URL

[Barcode Scan Results Window]/
[Scanned Text Window] (3] Select
number, mail address or URL »
» (2] Copy Telephone, Copy
Address or Copy URL » [u]

sesnxg Apueyq
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—I Additional Functions :

% Handy Extras

[S! Quick News Menu] P.9-28 [S! Quick News List] P.9-28

Updating List Automatically Changing Background Image

Receiving S! Loop Item Updates B S! Quick News List

sedjx3 Apuey
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M Registering with S! Loop Items

[S! Quick News Menu] (2] S! Loop
List® [u] & (3] stp-7° [C7067» (m]
» (2] Yes » (u]
® Handset connects to the Internet. Refer
to the S! Loop help menu for operational
instructions.
H Opening Information

[S! Quick News Menu] (2] S! Loop
List % [m] ® [3] Select item » [u]
» (2] Select title » (u]

® |ndicators:

0 Unread S! Loop

O Read S! Loop

Auto update disabled

[S! Quick News Menu] (2] Settings
» (u] » (3] Automatic Update »
(=] & (3] S! Quick News » (u] »
Select item » [u] B [u] B
Select interval or choose On or Off
» [u]
® When Special is set to On, items are
updated every four hours.
® \When General is set to On, items are
updated once a day.

® Updating items may incur high charges.

® Only available in Japan.

H S! Loop List

[S! Quick News Menu] [J] Settings
» (u] » (3] Automatic Update »
(] » (2] S! Loop ™ (=] » =] B (3]
Oonw [u]

® |tems are updated approximately
four times a day.

® Only available in Japan.

[S! Quick News Menu] (2] Settings
» (8] & (3] Change Skin % [u] »
Select pattern » [u]

Deleting S! Quick News ltems

Checking Update Schedule

[S! Quick News Menu] (2] Settings
» (u] » [3] Check Schedule % (=]

l One Entry

[S! Quick News List] [2] Select
item » (=] (0] —F£» (=] » (]
Yes » (u]

M All Entries

[S! Quick News List] [2] Select
item » (2] B [3] 24 » =] »
Enter Handset Code » (u] B
Yes » (u]



| Additional Functions I—

% Handy Extras

[S! Information Channel Page] P.9-29 [S! Information Channel Menu] P.9-29 [Entertainment Menu] P.9-30

e-Books

Copying Text

Saving Files to Data Folder

[S! Information Channel Page]
» (2] Save ltems » (] B 3]
Select file » (=] » [3] Save » (u]
» Enter name » (8] ® [ Save
here » [u]

® Some files are saved automatically.

[S! Information Channel Page]
» (2] Copy Text » (] » 5 Select
first character » (=] B
Highlight text range ®» [u]

Requesting Re-Delivery

Changing Display Size

[S! Information Channel Page]
» (2] Settings » (u] ® (2] Display
Size % (] » [3] Select size #» (u]

[S! Information Channel Menu]
Get Latest Contents W [u] »
Yes » (u]

Checking Weather Forecast

Changing Scroll Unit

[S! Information Channel Page]
» (1] Settings » [u] ® (3] Scroll
Unit % (=] » [3] Select unit » (=]

[S! Information Channel Menu]
Weather Icon » (=] & (3] Weather
» (u]

Copying Text

In open page, » | XxF&
3¢ - [m] » [ Select first
character ®» [u] ® (3] Highlight
text range » (=]

Opening Non-922SH e-Books
(Library)

[Entertainment Menu] | 2| e-Book
Viewer » » (] Select file » [u]

® Some files may not open.

seJix3 ApueH
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Communication
Services




S! Town & S! Loop

® Downloaded S! Town-compatible

Select an avatar to enter this 3D virtual S! Applications are saved to S! Town S! Loop is an online communication
town, where you can play games and Library. To start an application in S! Town service. Share your diary, join BBS, etc.
meet other users. Library, follow these steps. Internet connection is required; may incur
® To use S! Town, agree to the terms of (=] # £ Communication # (=] % high charges.
service then complete free user registration. S! Town » » (9] Select ors c icati
® |nternet connection is required; may incur application » [u] ommunication
high charges. » ‘E’
(m] & (i Communication S!Loop » (=]
» ‘EI ® Refer to the S! Loop help menu for

operational instructions.

S! Town » [u]

® S! Town (S! Application) starts.

® Refer to the S! Town help menu for
operational instructions.

® When an upgrade notice appears,
follow onscreen instructions to upgrade.
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S! Friend's Sta

® S! Friend's Status requires a separate contract and basic monthly fee.
® Set Connection status to Online beforehand.

Changing My Status Select Status » [u] Changing Connection Status

: [My Status Window] [2] Online (or
Follow these steps to change Status, Connection Status Offline) # [u] ® [3] Select status # [1]

My Status

Availability and Comment; new status is Changing Status Icon/Label
sent to the members. ©<Add Comment> [Status Templates List] Select
©-xa template ®» [u] B [J] Select Status
(Lon_g) . ] _ @Ei\“gwesrt%&“s > » 2] Status Icon or Status
® |f Connection status is Online, skip ®Reply 0K Label % (=] % 5] Select Pictogram
ahead to & Join OK | or enter text » (1] B
TN Changing Availability Settings at Once
Yes » i
(=] My Status Window [My Status Window] [2] Answer
SIS Tl Select Availability, e.g., Status » [u] # [3] Select new
SLYRZIATT e Answer Status » [u]
Ao Template>  |@y £ Answer OK» [u] »

<No Template> Editing My Status Name
[My Status Window] » (7] Edit

<No Template>

652z Select new Availability » [u]

}O’G’(;a :
552 n <Add Comment> % (u] Name » (] & Edit » [u]
[E0ptions %MM‘ ®» Enter text » [u]
Status Templates List » Update starts

Select template » [u]

S99IAI9S UOREIIUNWWOY)

I Disabling S! Friend's Status & S! Circle Talk (P.13-17)



S! Friend's Status

$99IAI3S UOHEIIUNWWO)

Creating Status Templates

Save custom combinations of Status Icon
and Status Label to each template.

In Status Templates list,
» (3] New Entry » [u]

Enter name » (=]
FE>w (u]

i@ & 15|

?
Status Label

Edit

Status Icon » (u] »
Select Pictogram » [u]

Status Label » [u] B
Enter text » [u] B

Repeat © -5 » (x| »

Saved

Saving to Data Folder
[Status Templates List] 2] Select
template » » (3] Save to DF »
(=] ® FH Save here » (=]

Loading Templates from Data Folder
[Status Templates List] »
Add Template » (=] » [{] Select
template » [u]

Renaming Templates
[Status Templates List] 2] Select
template » » (3] Edit Temp.
Name % (=] ® Enter name » [u]

. Resetting Templates
H One Template

In Status Templates List,
(select template) »

Reset » (m] ® (3] Yes
» (=]

H All Templates
In Status Templates List,

Reset All® [m] & [J] Yes
» [u]

® Status Templates List returns to the
default setting.



Registering Members

Follow these steps to register a number
saved in Phone Book for the first time. To
add members, see P.10-6.

(w] & (3] Communication »
(w] & (3] S! Friend's Status
» (m] » (0] Yes » (u]

Add Member

&

Add New Entry

(=] I

Phone Book ®» [m]| »
Select entry » (=]

Select phone number » (1]

® Omit &) if only one number is saved.

Yes » [u]

® Registration request is sent to the
number. Registration is complete
when an acceptance notice arrives.

When Registration is Complete
® My Status is sent and member's status
appears on handset.
Direct Entry
In &, (2] Add New Entry % (u] »
Enter phone number » (5] »

. Registering from Received Request

When a registration request arrives, a
confirmation appears.

Yes » [u]

® Acceptance notice is sent; the
number is registered.

Rejecting
In @, (2] Now [u] ® (2] Yes » (]
® Rejection notice is sent; the number
cannot be registered for 24 hours.
m For ConfirmLater, Information window
opens.

: S! Friend's Status

I_

Opening Member Status

(m] ®» (3 Communication »
(w] & (3] S! Friend's Status
» (=] » [J] Select Group
» (=]

Member Status My Status

8! Friend s Status N[ T NN |

S! Friend's Status Member List

Select member » (=]
S! Friend s Status

Ueda Mikio
090392XXXX1
kY EPStandby Window 0..
40nline
©Z&Fh

@ Answer OK

EBReply 0K

fed Join OK
E0ptions [

Member Status Details Window

Change |

When Cancellation Notice Arrives
® Member is deleted from S! Friend's
Status member list.

(% ) Adding Members
Renaming Groups

Deleting Members
Updating Manually

Moving Members
Opening Notices (P.10-6)

I Rejecting requests from unsaved numbers
Rejecting incoming images (P.13-17)

S99IAI9S UOREIIUNWWOY)

Rejecting all requests
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S! Friend's Status
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Adding Members

Renaming Groups

[S! Friend's Status Member List]
» (2] Add Member ™ [u] » (3]
Select method ® (=] » Select
entry or enter phone number » (=]
» [J] Yes » [u]

[S! Friend's Status Member List]
» (3] Edit Group Name » (=]
» Enter name » (u]

Deleting Members

Updating Manually

[S! Friend's Status Member List]
Select member » »
Registration Release % [u] »
Yes » (u] » [J] Yes » [u]
® Cancellation notice is sent; deleted

members cannot be re-registered for
24 hours.

[S! Friend's Status Member List]
» (3] Settings » (u] »
Status Update » (u]

Opening Notices

Moving Members

[S! Friend's Status Member List]
Select member » »
Change Group » [u] » (] Select
target Group » (=]

[S! Friend's Status Member List]
» (5] Status Notif. List % [u]
» (] Select notice » [u]

® Accept or reject registration requests.



S! Circle Talk
. I O

® A subscription to S! Friend's Status is required.
® Transmission fees apply during S! Circle Talk.

Group » [u] ®» (3] Group Select phone number » [u]

Name: ®» |u| » Enter name -
Follow these steps to register a number » [ (=] —

saved in Phone Book. friend

Ueda Mikio
No. 2:

NewGroup 0 People

Group Name:

Friend
No. 1:

® When registering a member for the

first time, a confirmation appears.
Choose Yes and press [m], then skip No. 3: [ Assign |
ahead to ). No. 4: ® Omit ) if only one number is saved.
<Add New Entry> » E [ g ] Saverd ® Repeat ) - (5 to add members.
New Entry Select number, e.g., » Saved
Individual .
Grow No.1: % (=] Saving as Individuals
In ©, [2] Individual » (=] & ) -
Phone Book % E » Saving from S! Friend's Status Member
Select entry » [u] List
In &, (3] Member List » (u] »
= Select Group » (=] ® [3] Select
member » [u] B

= Omit ¢ when Individual is selected in

S99IAI9S UOREIIUNWWOY)
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S! Circle Talk f
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Initiating S! Circle Talk

Follow these steps to send S! Circle Talk
requests to members.
Set My Status to Online first (P.10-3).

SINC/mIETEESISE - =
>

&Friend
EXXXXXXXXXX

S! Circle Talk Member List

Select member or Group
» [u]

(=] » Transmission starts

® Close handset and put Earpiece to
an ear.

® S! Circle Talk starts when request is
accepted by a receiver.

Direct Entry
Enter phone number » » (x|
Transmission starts

Initiating S! Circle Talk with Handset Closed
» H Select member or Group »
» » Transmission starts

. S! Circle Talk Operations
M Speaking
Press and hold when

FiPress and Hold appears
» You have the floor

[ 1Yalom
B Press and Hold

[EIXXXX XXXXX

® Speaking... appears when you have
the floor.

Keep holding to speak

» Release » Floor is

released

® Warning tone sounds before time limit.

Loudspeaker
During S! Circle Talk, [u] (canceled)
m To reactivate, press [m] twice.

M Exiting S! Circle Talk
or (i) ® Connection ends

® S! Circle Talk ends automatically
when there is only one participant
left, including yourself.
Rejoining S! Circle Talk
2] » [J] Select most resent
S! Circle Talk record » »
Rejoin Circle Talk % (u]
® An error message appears when
S! Circle Talk has ended or maximum
number of participants are already
engaged.

Accepting S! Circle Talk Request
While handset is ringing/
vibrating, or »
S! Circle Talk starts
® S! Circle Talk Operations: left

1 Canceling Loudspeaker (P.13-17)
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Editing Member List

H Replacing Individual Members

[S! Circle Talk Member List]
Select member » » (3] Edit
» (] » [n] » [J] Select method »
[w] » (5 Select entry » (u]

M Editing Groups
[S! Circle Talk Member List]
Select Group » » (3] Edit »
[w] & (3] Select target » [u] »
Edit/enter » [u] »

[l Deleting Members or Groups

[S! Circle Talk Member List]

Select member or Group » »

Delete ® [u] ® (3] Yes » (u]
M Deleting Group Members

[S! Circle Talk Member List] | &] Select
Group » » (3] Edit » (=] »
Select member » » (0] Delete
D [J]Yes m] »

S! Circle Talk

I_
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Near Chat

® |n the event that this handset may be used by a minor, access to this application may be password restricted by a supervising adult. In this
case, Handset Code access must also be managed to prevent the execution of Memory All Clear (P.13-15) that may be used to reset the

application password.

® Because this application employs Bluetooth® wireless technology transmission/connection fees do not apply.

Sending Near Chat Request

(m] & (3 Communication »
(=] & [2] Near chat » (u]

Communication

3
sy with
ble

fes within

(8] Yes & [u]

® Near Chat S! Application starts.
® For more, see Near Chat
S! Application instructions.

$99IAI3S UOHEIIUNWWO)
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Receiving Near Chat Request

When a Near Chat request arrives, a tone
sounds and Bluetooth® Notification appears.

[=Prev. = Nexted

After a period of inactivity, Information
window opens, tone sounds and
notification appears.

(2] Yes » [u]

® Near Chat S! Application starts.
® For more, see Near Chat
S! Application instructions.

Rejecting Request

In @, [&] Now =]
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Handset Security

Ainoag Jespuey

Operations, Securi

Function Lock

Restrict access to handset functions.

Auto Lock when handset is closed

Once One time lock

At Power On Lock when handset is
turned on

(] & (3] Settings » (=] »
Phone Settings % (=] »

Locks » [m]
Locks T 15058
PIN Entry Off
Change PIN2
Face Recognition Off
Function Lock off
IP Service Setting On
Application Lock Off
History Lock off
Show Secret Data Off
[ = 1
Locks Menu

Function Lock » [u]

Select item » (2] B
Enter Handset Code » [u]
Unlocking Handset
[Standby] Enter Handset Code » [u]
When Function Lock is Active
® Press corresponding key to turn handset
on/off, answer calls, place callers on
hold, end calls, etc.

PIN Entry

Activate PIN Entry to require PIN1 entry
each time handset is turned on.
In Locks menu, (2] PIN Entry
» (= Switch On/Off
» (=]

On » (=] » Enter PIN1
» [u]

Secure Remote Lock

Lock lost handset remotely via PC or
another handset. Secure Remote Lock
disables all operations except turning
handset on.
For more about Secure Remote Lock, see
SOFTBANK MOBILE Corp. Website
(P.14-19) or access My SoftBank
(Japanese page) via Yahoo! Keitai.
Accessing My SoftBank
(Japanese Page)

] X=2—UX P
» (u]

My SoftBank » (]

® Follow onscreen instructions.

11-2

é} Changing PIN1 © Changing PIN2
Activation Message to Appear (P.11-6)

Setting Secure Remote Lock



Handset Security

I_

Information, Securi

Application Lock

Restrict access to these functions:

Phone Book || Calendar/Tasks

Yahoo! Keitai | | Mail

Notepad

(w] B (5] Settings » [u] »
Phone Settings % (] »

Locks % [u]
Locks fIl® 15058
PIN Entry 0ff
Change PIN2
Face Recognition off
Function Lock of f
IP Service Setting on
Application Lock off
History Lock off
Show Secret Data off
I =] I
Locks Menu

Application Lock % [u]

Application Lock
M Phone Book
[Calendar/Tasks
[JYahoo! Keitai
CIMail

[INotepad

Available to
prohibit the use
of each function.

| Check

Select item » (8] (M

appears) » ®» Enter

Handset Code » [u]

Temporary Access to Functions
® When accessing functions, enter
Handset Code and press [1].

History Lock

Restrict access to Call Log and sent/

received mail records.

In Locks menu, (3] History

Lock » [u]

History Lock
MCall Log
[JSent/Revd Mse.

e

Available to
prohibit the use
of Call Log and
Sent/Received
Message Log.

Select item » (=] (V]

appears) » » Enter

Handset Code ®» [u]

Temporary Access to Records

® When accessing records, enter Handset

Code and press [u].

[ Check | OKEZ

Show Secret Data

Activate Show Secret Data to access

In Locks menu, [§] Show
Secret Data » [m]

On » [m] ®» Enter
Handset Code » [u]

When Show Secret Data is Active
® Predictive is not available for text entry.

Anoes jespueHq
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Face Recognition

Ainoag Jespuey

11-4

Using Face A it

Capture portraits with mobile camera then
match live image to saved ones to unlock
handset or access functionsf/files. If Face

Recognition fails, Function Lock activates.

. Precautions

® |dentification accuracy is not guaranteed.
SoftBank cannot be held liable for misuse
or any damages associated with the use of
Face Recognition.

® Handset Code is required to cancel Face
Recognition. Changing the code helps
enhance security.

® When capturing/scanning face, remember
these points:
m Make sure your face is clearly visible.
® Face should be lit evenly and brightly.

. Saving User Information
(] & (3] Settings » (=] »
Phone Settings % (u] »
Locks » [u]

Face Recognition % [u]

Face Recognition
Switch On/0ff Off

Conductor Setting Off

Security Level Normal

Report Unregistered

User Registration

I = I
Face Recognition Menu

User Registration » (=]
® Enter Handset Code ® (=]

USETNREETS EratioTI /-

User 1 Unregistered
User 2 Unregistered
User 3 Unregistered
User 4 Unregistered
User 5 Unregistered

—_

User List

Select from User 1 to

User 5% [u]

User 1 I 1
Face Image: Empty.
User Name:

Register Riddle:
Register Answer:

I Edit I

User Registration Menu

User Name: & (m] B
Enter name ® (=]

Register Riddle: » (=]
Enter question » (1]
Register Answer: » [u]
» Enter answer » [u]

Face Image: » (u]

Face Image T
Image 1:Unregister..
Image 2:Unregister...
Image 3:Unregister...
Image 4:Unregister...

N Unregistered
Image 5:Unregister...

EilCapture

é? Changing Accuracy Level
Changing/Deleting Portraits (P.11-6)

Editing/Deleting User Information



: Face Recognition

Select from Image 1to
Image 5 »

® Mobile camera activates.

Frame your face on Display
» (=]

(2] Yes » [m]

® To save more, repeat ) -
» ®» Saved

Precautions for Portrait Capture

® L ook straight into lens and frame whole
face with no expression.

® Do not wear a mask when capturing
portraits, even for use with Low(Mask).

. Activating & Canceling

In Face Recognition menu,
Switch On/Off % [u]

On or Off » [u] ®» Enter
Handset Code » [u]

I_

Face the Display »
Recognition starts

If face matches a saved
portrait, handset unlocks
® |f Face Recognition fails, Function

Lock activates. Press to retry.

Unlocking Handset after Face
Recognition Fails

l When No Matching Portrait is Found
Enter Handset Code » (=]

l When Matching Portrait is Found
Saved question appears.

(w] ® Enter answer » [u]

If You Cannot Remember the Answer

In

b ®» Enter Handset Code # [u]

When No Question or Answer is Saved

In

, Enter Handset Code »

Anoes jespueHq
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Additional Functions

k& Additional Functions

[Locks Menu] P.11-2 [Face Recognition Menu] P.11-4 [User List] P.11-4 [User Registration Menu] P.11-4

Editing/Deleting User Information

Ainoag Jespuey

Changing PIN1

Setting Secure Remote Lock
Activation Message to Appear

[Locks Menu] [¢] PIN Entry » (u]
» (2] Change PIN » [u] » Enter
current PIN1 ® (=] & Enter new
PIN1 ®» (=] ®» Re-enter new PIN1
» (1]

11-6

Changing PIN2

[Locks Menu] (2] Change PIN2 »
[m] ® Enter current PIN2 ®» (=] B
Enter new PIN2 ® (=] & Re-enter
new PIN2 » (=]

l Saving Message
[Locks Menu] [2] Set Lock Message
» [n] » (3] Message » [u] » Enter
Handset Code » [u] » Enter
message ®» (8] B [J] Yes » [u]

l Checking Message
[Locks Menu] [¢] Set Lock
Message » (u] ®» (3] Check
Message » (u]

Face Recognition

M Editing

[User List] (2] Select user » (=] B
Select item ® [u] » Change
portrait or enter information ®» [m]
»
® Edit items in the same way as saving
entries.
M Deleting

[User List] (2] Select user »
» [J] Yes » [u]

Changing/Deleting Portraits

Changing Accuracy Level

[Face Recognition Menu]
Security Level % [u] ® [3] Select
level » [u]

® When set to Low(Mask), handset
recognizes faces with masks.

M Changing
[User Registration Menu] || Face
Image: » (1] ® [§] Select image »
(=] [ Yesw» (u|» [n] » [&]
M Deleting
[User Registration Menu] Face
Image: » (u] » [3] Select image »
» (3] Yes » [u]
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File Backup




b

Wirelessly transfer the following files
between 922SH and compatible devices:

| Phone Book | | Received Msg. |
| Calendar | | Sent Messages |
| Tasks | | Drafts |
| Notepad | | Templates |
| Bookmarks | | Data Folder |

® Copy/forward protected files are not
transferable.

® Some files may not be transferable; some
settings may be lost, or files may not be
saved properly.

dnyoeg aji4 B ANAoOauuo)
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Getting Started [l Transfer Options

. Infrared Precautions %’;igéer Transfer single files

Align Infrared Ports of both devices. All File
T Transfer all files by function
Irss Exchange single image files
TETERT with compatible devices at

high speed

® Some transfer options may be unavailable
depending on file type.
® Transfer Memory Card files one by one.

Authorization Code

® Four-digit code required for infrared
transfers. All File Transfers possible when
codes match. (Authorization Code is
changeable for each transfer.)

® Do not place objects between devices.
® Keep Infrared Ports aligned during transfer.



|
| Infrared I—

Receiving Files . Subsequent Operations

(Long) M One File Transfer
® |nfrared is activated. Yes » (] & Yes » [u]

X S S ® When confirmation for save location
® Handset receives files if sent within )
three minutes. appears, select a location and press (]
 Handset must be in Standby to M All File Transfer (Adding Files)
Yes » (m] ® Enter Handset Code

accept connection requests. nar o
 To cancel infrared, Long Press 0. ® (=] » Enter Authorization Code % !
(a] ® (3] As New Items » [u] 3
Connection request arrives B IrSS Transfer 5
Receive IrSimple R B 505 .YeS » E . g
® Files are saved to Data Folder (Pictures). ;
Calling

av. ‘ nj [’\:()\t\ ng E
ope on, OK? )
w
No g
)
I = \ °

Request Window

Perform subsequent

operations
® To cancel transfer, press [(3].

é@ Overwriting Existing Files ¢ Sending My Details © Sending
Non-Phone Book Files (P.12-5)
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Infrared :

dnyoeg aji4 B ANAO2UUOD

12-4

Sending Files

. One File Transfer
Example: Phone Book Entries

» [] Select entry »
®» (3] Send Entry » [u]

Via Bluetooth
Via Infrared

Via Infrared % (m]
Send via Infrared

Yes ®» [u] & Transfer
starts
® When finished, entry list returns.

Il AvFile Transfer

(m] » (5] Settings » (=] »
Connectivity » [u] »
Infrared » (]

T
Set Via Infrared
Send All On/0ff.

[ o T

Send All % [u]

Yes » (=] ®» Enter
Handset Code » (u]

Send Al l bt A 15058

Appointments/Tasks
Bookmarks

Notepad

Received Messages
Sent Messages
Drafts

[ & T

Select item » (=]

Enter Authorization Code »
(m] ® Transfer starts

® When finished, Send All menu returns.

When Sending Phone Book
® |n -, follow these steps to select

whether to send Phone Book Pictures.
Yes or No » (=]

. Sending JPEG Images at High Speed

(] & 3] Data Folder » (u]

Pictures or DCIM » [u]
For DCIM, select a folder and press [m].

Select image » (Long)

Yesor Now =] »

Transfer starts

® When finished, file list returns.

® Transfers are one-way; end even if
files are not received.



Overwriting Existing Files

[Request Window] [J] Yes » (=] B
Enter Handset Code ® [u] ® Enter
Authorization Code » [u] B
Delete All & Save % (1] » (2] Yes
» [n]
® For Phone Book, My Details except
handset phone number is overwritten
as well.

Sending My Details

(=] » 5] » [=] » (5] Send My
Card W (] & (3] Via Infrared » [u]
» (2] Yes » (] ® Transfer starts

Sending Non-Phone Book Files

In file list, (3 (select file) » (=] B
(=] » (2] Send » [n] & (3] Via
Infrared » [m] ® [J] Yes » (=]
Transfer starts

Infrared

I_
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Bluetooth®
b
Wirelessly transfer files between 922SH . Handsfree Device Precautions . Bluetooth® Connection

and compatible devices (watches,

. ® Place calls from handsfree devices while
handsfree devices, etc.).

handset is in Standby.

[ sender | [ Recipient |

® .

Bluetooth®™ connection may not be ® Handle call operations on the device in use. Search for devices

possible with some Bluetooth® devices. . Bluetooth® Watches

® Handset shall be connected to certified . ® Select devi Activate
Bluetooth® devices that meet the Compatible Bluetooth®™ watches support elect device Bluetooth®
g sBFI)ecifica":i%r; c;tandards developed by these functions: v u
3 uetoot . . - - Request connection
a = Data transfers may fail depending on |_Time Correction ||  Alarm Notice | (Enter
e characteristics or specifications of the n N | [ Wail Not | Authorization Code)
s certified Bluetooth® devices. EWsiiotice Alllatce
‘; m Noise may interfere \_Nlth wireless or | Remote Shutter | | Mode Settings |
- handsfree conversations.
Fll Getting Started [ Quicksilent | [ caller ID Notice |
w "
Hold Calls Operator Notice

] [l Bluetooth® Precautions | - | | P - |
g ) o For details about functions/operations, [ Connection complete |
© ® Bring handsets to within ten meters.

® .
(Bluetooth® connection/transfer rate may see the Bluetooth™ watch guide.

vary depending on conditions.)

® TV audio is supported only on SCMS-T
DRM scheme compliant Bluetooth®
devices.

Authorization Code

® 4 to 16-digit code required for Bluetooth®
connections. Pairing possible when
codes match.

léa -l' Synchronizing Bluetooth® watch with handset ¢ Enabling/disabling
Bluetooth® watch responses (P.13-18)
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| ®
| Bluetooth I—

] i . E-I . EI I II ®
Activating/Canceling Bluetooth® Search for Devices % [u]

. Connecting to Paired Devices

® Found devices are listed after search.
(Long)

® Handset must be in Standby to
accept connection requests.

Connecting to Bluetooth® Devices

. Device Search & Pairing

Activate Bluetooth® on devices to be
paired with.

(m] » (3] Settings » (u] »
Connectivity » [u] »

Bluetooth » [u]

Bluetooth

Switch On/0ff

Search for Devices |On/Off.
Paired Devices

Send All

Setting
My Device Settings
My Device Details

———

Bluetooth Menu

® Press to cancel.
Select device » (=]

If handset is already connected to another
device, choose Yes and press [m].

Enter the same
Authorization Code for
handset and the other
device » (=]

® On the other device, complete code
entry within 30 seconds.

® For handsfree devices, enter
specified Authorization Code.

(=] » Paring complete
® Authorization Codes are not
necessary for paired devices.

In Bluetooth menu,
Paired Devices » [u]

All Paired Devices[H/H I
14 o &
XXXXXX

All Paired Devices List

Select device » (=]

If handset is already connected to another

device, choose Yes and press [m].

® The device is connected and M
(checked) appears. Devices marked
with ¥ reconnect to handset when
placing or receiving calls.

dnyoeg aji4 % ANAO3UU0)

ééi Renaming Paired Devices © Deleting Paired Devices

Disconnecting Devices (P.12-9)

I Setting idle time after which Bluetooth® is canceled (P.13-18)
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Bluetooth®

dnyoeg aji4 B ANAO2UUOD

. Accepting Connection Requests

Follow these steps to accept connection
requests from unpaired devices.

Connection request arrives

Bluetooth [N/ 1|

No

D

J———

Request Window

Yes » [u]

[ e

Enter the same
number as the
target device.

Cance |2

Enter the same
Authorization Code as
sender's » [u]

® Complete code entry within 30 seconds.
® For handsfree devices, enter
specified Authorization Code.

Transferring Files

Follow the steps below to exchange files
with paired devices.

® For transferable files, see P.12-2.

® \When requested, enter Authorization Code.

. Receiving
Connection request arrives

» ] Yes » (u]
Yes » (u]

® When confirmation for save location
appears, select a location and press [m].
® To cancel transfer, press [¥7].

All File Transfer (Adding Files)
In 3, Enter Handset Code » (u] B
(2] As New Items » (u]

. One File Transfer
Example: Phone Book Entries

» [] Select entry »
» (3] Send Entry » [u]

Via Bluetooth » (]

Select device » (u] »
Yes » [u] & Transfer starts

® When finished, entry list returns.
. All File Transfer

In Bluetooth menu, [&] Send
Al [u]

Select device » (u] »
Yes » (m] » Enter Handset
Code » [u]

Select item » (=] B
Transfer starts
® When finished, Send All menu returns.
When Sending Phone Book
® |n ), follow these steps to select

whether to send Phone Book Pictures.
Yes or No » (=]

12-8
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% - Overwriting Existing Files
Non-Phone Book Files (P.12-5)

Sending My Details

Sending

I Cloaking handset to avoid connection requests (P.13-18)



Renaming Paired Devices

Overwriting Existing Files

[Bluetooth Menu] (] Paired
Devices » (u] » [J] Select device
» » (3| Change Name » (]
» Enter name » [u]

Deleting Paired Devices

[Bluetooth Menu] (] Paired
Devices » [u] ® (2] Select device
» (2] & [2] Delete » [u] B [J]
Yes » (u]

® To delete a device connected to
handset, choose Yes and press (1].

[Request Window] [¥] Yes » (=] B
Enter Handset Code » (1] » [Z]
Delete All & Save ®» (»] » [J] Yes
» (=]
® For Phone Book, My Details except
handset phone number is overwritten
as well.

Sending My Details

Disconnecting Devices

(u] » O] » [=] » [§] Send My
Card W (u] » (3] Via Bluetooth %
(=] » 3] Select device » [u] »
Yes » [u] » Transfer starts

[All Paired Devices List] (o] Select
device type ® [{] Select device
with M » [u]

Sending Non-Phone Book Files

In file list, (39 (select file) » =] B
(=] » (2] Send » (=] & (3] Via
Bluetooth » [u] » (3] Select
device » (] » (3] Yes » [u] »
Transfer starts

dnyoeg aji4 ® AlAOBUUO)




Mass Storage
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Connectingtopc......................

Accessing Memory Card from PC

Connect handset to a PC via USB Cable
to access Memory Card from the PC
without removing the card from handset.
If handset is connected to a PC via USB
Cable, disconnect it first.

(m] B (5] Settings » =] »
Connectivity » [u] »
USB Mode » [u]

Mass Storage » [u]
Mass Storage

Callink not
avail during
ation, OK?
No

[ (=]

Yes » [u]

Connect handset to a PC via Utility Software (Japanese)
USB Cable

Supplied CD-ROM contains these utility

» Yes » [u] software programs:
Connection ends Modem Wizard | Use handset as a modem
® Safely remove handset (recognized Transfer files on Memory
as removable hardware device) on Cards formatted for other
the PC, then disconnect USB Cable. Memory Card SoftBank handsets by
Uit L SHARP to Memory Cards

for handset

SoftBank Utility | Transfer files between
Software” handset and PC

Manage WMA files and
transfer them to handset

S! Music Connect’

"Access download page from Utility Software

CD-ROM.

® USB Cable driver is also contained.

® For details, see Utility Software Starter Guide
(Japanese) on Utility Software CD-ROM.

Mobile Data Communication Fees

® Using the Internet by connecting handset
to PC/PDA may incur high charges as
large-volume packet transmissions tend
to occur in a short period of time; check
transmission fees while online.



Back up information to Memory Card, and
restore to handset as needed.

The following folders/entries can be
transferred at once:

[ PhoneBook’ || Drafts’ |
| Calendar’ |[ Templates |
| Tasks’ |[ contents Keys |
|  Bookmarks’ || DataFolder |
| Notepad’ || S! Town |
| Received Msg.” || Mail Groups |
| Sent Messages’ | | User Dictionary |

"Selectable simultaneously via Check
Selection in Options menu.

Precautions

® Not available if battery is low.

® Some items may not be transferable; some
settings may be lost, or files may not
transfer properly.

. Transferring All ltems

Use blank Memory Card for Backup All
Items. Do not use the card to save other
files after Backup All Items; backed up

content may not be restored properly.

. Transferring Selected Items

M Received Msg.

® Transfer deletes Auto Sort Keys.

® Mail Notices are restored as messages,
invalidating complete message retrieval.

® |f spam filter is available on recipient
handset, Spam Folder messages are
saved in spam folder regardless of the
setting. (If unavailable, they are saved as
normal received messages.)

H Sent Messages

Transfer deletes Auto Sort Keys.

M Drafts

If transferred from Drafts, only the first

entered recipient remains or SMS

addressed to multiple recipients may not

be saved.

M Bookmarks

® Yahoo! Keitai, PC Site Browser and
Streaming Bookmarks are all backed up.

® Streaming Bookmarks are saved as Yahoo!
Keitai Bookmarks.

H Contents Keys

Moving Keys to Memory Card creates a

special file. Performing Backup again on

the same Memory Card overwrites that

file. Perform Restore beforehand.

%

dnyoeg aji4 ® AlAOBUUO)
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Backup :
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Handset to Memory Card

Follow these steps to back up selected
items at once.

(] & (3] Settings » (=] »
Connectivity » [u] »
Backup » [u]

Save all backup
Backup Selected |tems|items to memory
Restore All |tems card.

Restore Selected |tems
Settings/Manage

Backup

=

Backup Menu

Backup Selected Items
» (=] » Enter Handset
Code » [n]

Yes » [u]

Select item » (1] (/)

®» Complete selection

® For Phone Book confirmation
appears. Choose Yes or No and
press (1],

] » (2] Yes » [u]

® To cancel, press [¥].
Backup complete ® (=] (=]

Selecting Multiple ltems at Once
In ), » (3] Select option ®» [u]
» From

Selecting/Canceling All ltems
In ), » (3] Check All or
Uncheck All % [u]

Memory Card to Handset

Follow these steps to restore selected items.
Restoring backed up content to handset
overwrites current handset content (with
the exception of Contents Keys).

In Backup menu, (2] Restore

Selected Items » [u] »
Enter Handset Code » (=]

Yes » (u]

Select item » (=] (/)
» Complete selection

o [f no file list appears, skip ahead to

Select file » (=]

® Repeat (=) to complete selection.
(m]
Yes » (u]

® To cancel, press [(¥].
Restore complete » [u] > [u]

Selecting Multiple Items at Once
In ), » (3] Select option » [u]
» From

Selecting/Canceling All ltems
In ©), » (3] Check All or
Uncheck All » [u]

A
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(% Backing up All ltems
ltems ¢ Deleting Backup Files (P.12-13)

Encoding Data for Backup

Restoring All



Backing up All ltems

[Backup Menu] [¥] Backup All

Items » (1] » Enter Handset Code
» (m]® [J] Yes» m] (] Yes >
[=] ®» Backup complete » [u] » [u]

Encoding Data for Backup

[Backup Menu] [2] Settings/
Manage % [u] ® (3] Encode
Settings » [u] ® [3] Select item »
(=] » (3] On » [u]
® Available for Phone Book, Messaging
folders, Calendar and Tasks.

Restoring All Items

[Backup Menu] (2] Restore All

Iltems » (1] » Enter Handset Code
» (u]® [J] Yes» (n] B [3] Yes »
[=] ®» Restore complete » [u] B [u]

Deleting Backup Files

[Backup Menu] (2] Settings/
Manage % [u] % [3] File
Management » [u] » [3] Select
item » [m] B [J] Select file » (=]
(C/M) ®» Complete selection »
» (] Yes » (u]

Backup

dnyoeg aji4 ® AlAOBUUO)
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S! Addressbook Back-up (SAB)
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Back up Phone Book content in SAB; add Phone Book changes
to SAB anytime. Edit SAB online via PC; add SAB changes to
Phone Book anytime. Restore lost or altered Phone Book content
from SAB.

Backup/Restore
LN
I E o Synchronize ana
Phone Server
Book Birthday Notification
Edit on PC

Import from/Export to PC

® SAB requires a separate contract and basic monthly fee.

® Use SAB to add Phone Book content to a new compatible SoftBank
handset; some conditions apply (P.12-15).

® Use a PC to edit SAB online.

® For more about SAB, see the corresponding Website (P.14-19).

® Sync commands (Backup, Restore and Synchronize) all incur
transmission fees.

SAB Sync Commands & Features

Backup/ Backup Export Phone Book content to SAB'
Restore Restore Import SAB content to Phone Book?
Synchronize Synchronize Phone Book and SAB®
Synchronize | Sync from Client | Add Phone Book changes to SAB*
Sync from Server | Add SAB changes to Phone Book®
Import from PC | Upload PC address book info to SAB
Edit on PC
Export to PC Export SAB content to PC address
book
Birthday SAB sends reminders via SMS to
Notification handset
Email Address | Send new handset mail address to
Send e 7 o
. 6 Notification specified addresses
Notice “DisasterM
|sas“er 85898 | Send emergency message board
Board" Message update to specified addresses
Notification® P P
o Tomodachi Always accept messages from
e Email Filter® mail addresses saved in SAB

"Any existing SAB content is deleted.

2Any existing Phone Book content is deleted.

3If the same entry item is edited in Phone Book and SAB, SAB
content is referenced.

“Unrelated SAB changes remain.

SUnrelated Phone Book changes remain.

8Access this function via handset or a PC.

"Backup resets notification setting; handset address is sent to all addresses.

8Backup resets notification setting; updates are not sent to any address.

9Export Phone Book content to SAB beforehand.



Service Usage Outline

Complete Contract
Visit a SoftBank Shop, dial 157 from a SoftBank
handset for SoftBank Customer Center, General
Information or access My SoftBank via Yahoo! Keitai.

¥

Receive User ID & Password

After subscription, User ID and Password arrive via SMS.
® User ID and Password are required to use SAB via a PC.

¥

Use SAB

Export Phone Book content to SAB.

IS! Addressbook Back-up (SAB)I—

. Precautions

H Unsynchronizable ltems

SAB restoration cancels these Phone Book settings:
m Picture, Tone/Video, Vibration

H Unintentional Phone Book or SAB Content Deletion

® \When no Phone Book content exists, selecting Synchronize, Sync
from Client or Backup deletes all SAB content.

® \When no SAB content exists, selecting Synchronize, Sync from
Server or Restore deletes all Phone Book content.

H Phone Book ¢ SAB Content Capacity Disparities

When the number of savable items varies between Phone

Book and SAB entries, Synchronization reflects lower limit.

H Contract Termination
SAB content is deleted upon contract termination.
H SAB Transfers to New Handsets
® SAB-Compatible 3G Handsets
SAB remains as last saved and is fully accessible.
® Other 3G Handsets
SAB remains as last saved and is accessible via PC.

® V3/V4/V5/V6/V8 Series
Service contract is terminated and SAB content is deleted.

& Confirming User ID & Password (P.12-17)

dnyoeg aji4 ® AlAOBUUO)
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—]s! Addressbook Back-up (SAB)|

Backup (Phone Book — SAB) (w] & Backup complete Synchronizing Phone Book

Any existing SAB content is deleted. Canc-eling EGKUP & Synchronize Options:
» (0] Yes» -
(m] » Phone » [u] B e Sggihargglzsighone
S! Addressbook Backup w (m]  BGESCIENCTA Rl I -LTTS) TP
. one Boo
S!_Addressbook Any existing Phone Book content is deleted. Sync from Client changes to SAB
Backup or
g St te Svmc Book via Server o In S! Addressbook menu, Sync from Server | Ad9 SAB changes
3 reflect changes. Start Sync » EI » — -
=1 Restore % E' If this is your first us.e of SAB (new
s handset), Synchronization is performed
'; = Yes » (u] » Enter via Synchronize regardless of selection.
= S! Addressbook Menu Handset Code  [u] In S! Addressbook menu
o ® Restore starts; when completed, . 2
g Start S.Vnc » E’ » details appear. Start Sync » ‘EI »
e Backup » (=] Select option » (=]
g (=] » Restore complete
Yes » (=] ®» Enter cancaling R Yes » (u] » Enter
Handset Code » [u] a"":f s;:;e’ B Handset Code » [u]
® Backup starts; when completed, : ® Synchronization starts; when
details appear. completed, details appear.
(=] ®» Synchronization
complete
Canceling Synchronization
» (2] Yes » [u]
S
é? Auto Synchronization ¢ Opening Log (P.12-17)
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IS! Addressbook Back-up (SAB)I—

l Changing Auto Sync Command
[S! Addressbook Menu] [7] Set

Confirming User ID & Password

Auto Sync » (u] » Enter Handset
e X=a—YX > [E]> Code » (8] » (3] Set On/Off » [u]
My SoftBank % (=] % » (2] On» [u] » [3] Set Sync

English % [u] ® (2] Password Mode % (1] ® [£] Select command
confirmation for S! Address Book » (=]

» (=] ® Follow onscreen
instructions Opening Log

Auto Synchronization
[S! Addressbook Menu] (2] Sync

B Activating I;Ilsé’ory » (u] B (3] Select record
[S! Addressbook Menu] (3] Set

Auto Sync % [u] & Enter Handset

Code » (n] » 5] Set On/Off » (u]

» (2] Onw» [u]
H Changing Auto Sync Frequency

[S! Addressbook Menu] (] Set
Auto Sync % (1] ® Enter Handset
Code » [m] & (3] Set On/Off » (m]
» [J] on» [u] > [3] Set
Frequency » [u] ® [J] Select
frequency ®» (=] » Enter/select
date/time/day of the week » (u]
® For After Editing Ph.Book(10 min.),
omit steps for date, time, etc.

dnyoeg aji4 ® AlAOBUUO)
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Phone Settings
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- X Phone Settings
| Mode |

(] » 3] Settings » (=] ® (3] Phone Settings » (=] ® (3] Mode Settings » (u]

Selecting a handset mode

(4] Select mode » [u]

Customizing handset modes

Select mode » » (2] Select item » [m] » Adjust settings
® Not available for Normal mode.

Date & Time

(m] » 3] Settings » (] » (2] Phone Settings % (=] ® [J] Date & Time » [u]

Setting the date and time

Set Date/Time » [u] » Enter the year ® Enter the month » Enter the day
® Enter the time » [u]

Correcting Clock manually

(2] Time Correction % (=] & (3] Manual » (=] ® (3] Yes » [u]

Activating Daylight Saving

Daylight Saving % (u] % (3] On » (=]

Changing Time Zone

Set Time Zone » (=] ® (o] Select area » [u]

Changing time format to 12 hour

(2] Time Format % (u] & (3] 12 Hour % (]

Changing date format

Date Format » [u] ® (7] Select option » (=]

Starting the Calendar week on Monday

Calendar Format % [u] » (3] Monday-Sunday » (u]




- X Display & Key Settings Il

Switching interface between Japanese and English | Language or 53Z:%#F % (u] » (2] English or A& » (u]

Display Image (m] » [3] Settings » [m] » (3] Phone Settings % (u] ® 3| Display % (u]

System Graphics % [u] » [{] Select item ®» (u] & (3] Preset Animation (or
Pattern 1to Pattern 3) » (]

System Graphics % [u] ® [J] Select item » [u] ® [3] Select folder » [u] »
Showing Data Folder images for incoming calls, etc. Select image » [u] ® [u] ®» [{] Specify display area » (]

® Some images may be usable without specifying display area.

System Graphics % [u] » [3] Select item » (8] » [3] Customized Screen
» [u]

Showing preloaded images for incoming calls, etc.

Showing Customized Screen for incoming calls, etc.
® Not available for Power On or Power Off.

Display lllumination (m] » [3] Settings » [m] » (3] Phone Settings % [u] ® 3| Display & (u]

Changing Display/Keypad Backlight illumination time Backlight % (] » (3] Time Out % [m] ® [2] Select time » [u]

Changing display transition effects Display Effects % [u] # [J] Select option » [u]
Changing Display Brightness Backlight  [u] ® (3] Brightness % [u] ® [3] Adjust level » [u]
Canceling/activating Light Sensor Backlight » (u] & (3] Brightness » [u] » (/) » (m]

ﬁ uolneziwolsn) Jespuey

Changing inactivity time after which Display turns off Display Saving % (=] & (7] Select period » (]
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Display & Key I

E uonezIwoIsn) jJaspueH

18-4

- X Display & Key Settings F1

(=] » (3 Settings ® [u] ® (2] Phone Settings » (u] » (J] Display » [u]

Changing inactivity time after which External Display
turns off

(8] External Display % (u] ® (3] Duration % (=] & (2] Select time » [u]

Hiding new received messages

(2] External Display % (u] » (3] Messages » (] ® (3] Not Display » (u]

Hiding caller's number/name

External Display » (u] ® [J] Caller Display W [u] » (3] Off » (u]

Changing number entry view

External Display % (u] ® (3] Dial Number ® (u] ® (3] Grid » (=]

Additional Display Settings

(=] » (3 Settings ® [m] ® (2] Phone Settings » (u] » (J] Display » [u]

Changing Clock/Calendar

Standby Display » (»] ® [J] Clock/Calendar » [m] ® (] Select type » (u]

Hiding indicators in Standby

Standby Display % (u] & (2] Show Indicators » [u] ® (3] Status Area » (]
» (2] off » (u]

Showing Softkeys in Standby

Standby Display » (u] ® (3] Show Indicators » [u] ® [J] Softkey Area »
(m] » [3] On » [u]

Handset Keys

(] & 5] Settings ® (m] » (2] Phone Settings » (]

Disabling Keypad light illumination

(] Set Key Light » [u] ® (3] Off » [u]




Handset Response

- I Ringtone & Sound Settings

(m] & (34 Settings » (=] ® (3] Phone Settings » [»] ® (2] Sounds & Alerts » [u]

Changing ringtone volume

Volume » (m] ® [] Select item » (=] & [J] Adjust level » [u]

Changing Event Light illumination option

Event Light % [u] & [] Select item » [u] & (3] Switch On/Off % [u] »
On, Link to Sound or Off % [u]

Changing Event Light color

Event Light » [u] ® 3] Select item ® [u] » [3] Light Color % (=] »
Select color » (=]

Answering calls with other keys

Any Key Answer » (u] & (2] On » [u]

® Answer calls with any key except (3], (=], 7, [=2], J or Side Keys.

System Sound

(m] & (54 Settings » (=] ® (3] Phone Settings » [»] ® (2] Sounds & Alerts » [u]

Changing Keypad Tones

System Sounds % (8] ® 3] Keypad Tones » [u] ® [{] Select tone » [u]

Disabling Keypad Tones

System Sounds % (8] ® (3] Keypad Tones » [»] & (3] Off & (u]

Changing S! Circle Talk tone

System Sounds % (u] & [3] S! Circle Talk » (=] ® [] Select tone » (u]

Changing other System Sounds

System Sounds » (8] ® [] Select item » (5] ® ] Tone » (=] » [J] Select
folder » (=] ® (3] Select tone/file » [u]
® For files with limited usage period, choose Yes and press ().

Additional Sound Setting

(] » [$] Settings » [m] » (3] Phone Settings » (u]

Disabling Speakers when using Headphones

| 2] Ringer Output » (8] ® [3] Earphone » [u]

Ringtones & Sounds
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Text Entry & Phone Book

- I Text Entry & Phone Book Settings
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Text Entry

[Text Entry Window] » (2] Input/Conversion » [u]

Disabling suggestions based on entered characters

(2] Predictive » (] & (3] Off & [u]

Disabling suggestions based on entered words

Previous Usage % (u] & (3] Off » [u]

Hiding emoticons in suggestion list

EmoticonWordLink % [u] & [3] Off » [u]

Lowering type priorities in suggestion list

(2] Set Low Priority ® (] ® (2] Select type ®» [u] (M appears) »

Using Keypad to enter words/phrases from suggestion list

Select Candidate » (] & (3] Enable 1-9, 0, #, # % [u]

Phone Book

(=] » (3] Phone » [u] » ] Ph.Book Settings » [u]

Switching reference Phone Book

(2] Select Phone Book % (m] » (2] USIM Memory or Both % (u]

Changing default storage media for new entries

Save New Entry % [u] & [] USIM Memory or Ask Each Time » (u]

Hiding confirmation after calls with unsaved numbers

New Number Prompt ® (8] » (3] Incoming Call or Outgoing Call % [u] »
(] off w [u]

Prioritizing mail address display in entry search window

Set Preferred » (m] & [(] Email Address » (m]




- I Advanced Call Settings

(m] » (34 Settings » (=] & (2] Call/Video Call » (]

Setting handset to beep once each minute during Voice Calls

Minute Minder » [u] % (3] On » (=]

Showing Call Cost after each call

Disp. Time/Call % [u] & 3] Display Call Cost % (] & (3] On » [u]

Hiding Call Time during calls

Disp. Time/Call % (] » (3] Call Time Counter % (u] % [3] Off % (u]

Activating auto Voice Call answer when handset is closed

Handset Close % (=] » (3] Answer » [u]

Video Call

(m] » [3] Settings » [m] ® (3] Call/Video Call % (] & 3] Video Call % (]

Changing quality of Incoming Images

Incoming Picture % (] % 2] Select quality » [u]

Changing quality of Outgoing Images

Outgoing Picture % [u] ® 3] Select quality » [u]

Canceling Loudspeaker for Video Calls

Loudspeaker % [u] » (3] Off » [u]

Packet Transmission

(m] & 3 Settings » (] » (3] Call/Video Call % (=] » (3] Call Time & Cost » (]

Checking the most recent packet transmission volume

Data Counter ® [u] ® (2] Last Data » (u]

Checking all packet transmission volume

Data Counter ® (m] & (3] All Data » (u]

Calling
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General Settings

- X Advanced Messaging Settings Il

» (3] Settings » [u] » (3] General Settings % (u]

Changing message window scroll unit

(2] Scroll Unit & [u] » (2] Select unit # (=]

Changing message list view

Message List View » [u] » [7] Select option » (=]

Showing complete sent/received message addresses

Address View » [u] & (2] Show All » [u]

Changing view for Received Msg. folder

(2] Received Msg. View » (=] ® 2] Select option » (=]

Changing view for Sent Messages folder

Sent Msg.View » [u] » (7] Select option » (=]

Canceling automatic deletion of oldest received messages

Auto Delete » (] ® [J] Received Msg. » (u] » (2] Off » [u]

Canceling automatic deletion of oldest sent messages

(2] Auto Delete » [u] ®» [J] Sent Messages » (u] » (3] Off » [u]

Sending/Composing

® For Received Msg. View and Sent Msg.View, Folder View by Account is selectable when a PC Mail Account exists.

» ({] Settings #» [u] ® (2] General Settings ® [»] ® (2] Send/Compose » (u]

Requesting Delivery Report for all messages

[¢] Delivery Report » [u] ®» (3] On » (]

Disabling automatic resend of unsent messages

Auto Resend » (=] & (3] Off » (u]

Hiding progress bar while sending messages

Sending Status » (] ® [§] Off(Background) » (]

» (3] Settings » (»] ® (3] General Settings % [u] » (2] Receive » (u]

Disabling Animation View

Animation View » (=] & (3] Off  [u]

E uonezIwoIsn) jJaspueH

Muting ringer, etc. for messages sorted into Secret folders

Message Notice % [u] » [3] Secret Folder % [u] # [J] No Response » [u]
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Feeling Mail

- X Advanced Messaging Settings F]

Messaging

I_

» (] Settings » [u] » [2] General Settings » (u] » (7] Receive % [u]

Hiding subject, sender, etc. above Information window

Link to Feeling % (u] & 3] Idle Screen Info. » (] ® [J] Off % (u]

Disabling Small Light illumination

5nk to Feeling » [»] ® [J] Light % [u] & [3] Switch On/Off » [u] » [3] Off
» (=

Changing Small Light color

Link to Feeling » (u] » (3] Light % [u] & 3] Light Color % [u] ® 3] Select
item » (=] » [J] Select color » (=]

Changing handset vibration pattern

Link to Feeling » (u] ® (3] Vibration Pattern % [u] ® (3] Select option » (=]

Disabling tone/video for incoming Feeling Mail

LinI|(Et|‘o Feeling % [u] » (3] Ringtone » [u] & [J] Switch On/Off » [u] »
Off »

Changing tone/video for incoming Feeling Mail

Link to Feeling » (u] » (3] Ringtone » [u] ® (2] Assign Tone » (] »
Select item » (=] B (3] Select folder » (=] # [ Select tone/file ®» (=]

Changing tone/video duration for incoming Feeling Mail

Link [t:IO Feeling » (u] » (3] Ringtone ® [u] & (2] Duration » [u] % Enter
time » (=

3D Pictogram

» (] Settings » [u] ® (3] General Settings » (] » (7] Receive » [u]

Enabling 3D Pictogram for read/unread messages

3D Pictogram » (u] & [3] Display Effect » [u] ® [J] Always » [u]

Disabling 3D Pictogram for all received messages

3D Pictogram » (u] » [3] Display Effect » [»] # (3] Disable #» (=]

Changing background color

3D Pictogram » [u] » (3] Background Color % [u] ® (3] Select color » [u]

Changing animation speed

3D Pictogram % [u] ® (3] Display Speed » [u] ® [J] Select speed » [u]
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- X Advanced Messaging Settings E]

» [ Settings » (u] & (2] S! Mail Settings » [u]

Disabling automatic S! Mail retrieval in Japan

Message DL(Japan) % (8] » (2] Manual » [u]

Enabling automatic S! Mail retrieval abroad

Message DL(Abroad) » (] » (5] Auto (All) » [u]
® When set to Auto (All), complete S! Mail messages including attachments are
retrieved; may incur high charges. Use Manual whenever possible.

Disabling image auto-resize

Picture Appearance % (u] » (2] Normal » (u]

Disabling image auto-open

Auto Play File % (u] & [J] Pictures » [u] & (3] Off » [u]

Enabling sound auto-play

Auto Play File % (u] ® [J] Sounds % (] & [J] On » [u]

® Settings in Picture Appearance and Auto Play File apply to PC Mail as well.

» (] Settings % (»] ® [2] PC Mail Settings » [u]

Retrieving complete PC Mail messages

PC Mail DL % [u] & (3] PC Mail DL % (u] & [3] All Contents » [u]

Retrieving new messages automatically

Check New Mail % (u] & [3] Check New Mail % (=] % (2] On » (u] B
Select account ® (m] (M appears) » » (]

Changing interval between automatic message retrieval

Check New Mail % (=] & (3] Interval # [u] ® (2] Select interval » [u]

Disabling automatic word wrap

Word wrap » (=] » (3] Off & (u]

® Setting Check New Mail to On may incur high charges; checking for new messages may incur transmission fees even when none exists.
Remember this, especially when using handset outside Japan.
® Other functions may slow while handset is checking for new messages.

» (] Settings % (u] & [2] SMS Settings » [u]

Changing Server sent message storage limit

| (2] Expiry Time » [a] ® [%] Select option # [u]




- X Advanced Internet Settings

Yahoo! Keitai

(] » (3 Yahoo! Keitai ® (] ® (5] Browser Settings » (1]

Changing character size

Font Size » (m] ® (3] Select size » [u]

Changing scroll unit

Scroll Unit % [u] » [3] Select unit » [u]

Activating pointer navigation

Cursor Settings » (=] ® (2] Cursor Mode Settings » (=] & (2] Normal
Mode » [u]

Changing pointer speed

Cursor Settings % [u] ® [J] Speed Settings » (] % [3] Select speed » [u]

Disabling automatic image download

Downloads » (=] & (2] Images » (=] & (3] Do not Show » [u]

Disabling automatic sound playback

Downloads % (8] ® (3] Sounds » (8] » (2] Do not Play » (u]

Clearing cache (temporarily saved information)

Memory Operation % (u] & (2] Delete Cache % [u] ® (3] Yes » (]

Clearing cookies

Memory Operation % (=] & 2] Delete Cookies » (] » ({] Yes » [u]

Clearing authentication information

Memory Operation % (u] » (3] Delete Auth Info W (] % (3] Yes » (u]

Using Memory Card as primary download storage

Download to % (] » (] Prefer Card  [u]
® Some files may be saved to handset regardless of this setting.

Resetting browser settings and stored information
(Bookmarks, Saved Pages, etc.)

Initialized Browser % (] % Enter Handset Code ® (=] ® 3] Yes » (]

Restoring default handset settings

Reset Settings » (=] ®» Enter Handset Code » (u] ® [(] Yes » (]

PC Site Browser

(m] & (3 Yahoo! Keitai W [m] # (2] PC Site Browser ® [m] ® (3] PC Site Browser Settings % (=]

Hiding navigation map for continuous scroll

Scroll Settings % (8] % (2] Page Navigation » [u] ® [J] Off » [u]

Changing scroll unit (PC Site Browser)

Scroll Settings % (=] % (2] Scroll Unit % (=] ® 3] Select unit » (]

Hiding PC Site Browser activation/change confirmation

Warning Message ® [u] » (3] PC Site Browser or Yahoo! Keitai » [u] »
Ooff » (u]

Deleting all RSS feeds

Memory Operation % (u] & (2] Delete RSS Feed List % (=] ® Enter
Handset Code ® (=] B (3] Yes » (u]

® Yahoo! Keitai settings above are also available in PC Site Browser Settings.

Yahoo! Keitai & PC Site Browser
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Digital TV

- X Advanced TV Settings I
_ (=] » (5] TV (8] & 5] Digital TV =] » [=] » £ Image » (=]

Canceling/activating Light Sensor [¢] Brightness Sensor % (»] ® =] On or Off % (u]
Adjusting Brightness automatically for current image Control by Scene » [u] » (o] On » (u]
Adjusting Display Brightness Brightness % [u] ® [o] Adjust level » [u]
Adijusting Display Contrast (2] Contrast # [u] ® (o] Adjust level » (]
Adjusting black level Blackness » [u] » (o] Adjust level » [u]
Adjusting color density Color » (u] » [ Adjust level » (1]

Adijusting color tone (2] Tint & (] » (o] Adjust level » [u]

Adjusting Sharpness Sharpness » (] ® (o] Adjust level » [u]
Restoring default Image settings Reset® (u] ® (2] Yes » [u]

® Image settings apply to the current AV mode.
519 5TV > ()9 01 Digal TV (5 (519 € Tone . ¢

Selecting sound option | 4 Select option » [u]

® Tone setting applies to the current AV mode.

Data Broadcast (=] » (3] TV [m] B [3] Settings & (=]

E uonezIwoIsn) jJaspueH

Recording content without text data | (2] Broadcast Data % [u] ® %] Set Recording » (] % [2] Image Only # [u]

(m] & 3] TV (=] & (3] Digital TV (=] » (] Subtitle/Sound » (=]

Selecting subtitle display option | Display Subtitle % (] % [ Select option » [u]
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Digital TV

- X Advanced TV Settings F1

I_

(] > (2 TV [u] & (3] Settings » (=]

Showing calls or S! Circle Talk requests while watching TV

Calls & Alarms % [m] ® [] Select item ® (=] ® (3] Notice a Call » [u]

Disabling Time Shift recording automatic activation

Set Call Time Shift % [u] & [J] Off » (u]

(m] > 5] TV » (=] & [J] Settings » (=] » (3] TV Alarm & (u]

Changing TV Alarm Time

| [2] Alarm Time ® (] ® [2] Select time #» [u]

Reception Area & Channel

(m] » 5] TV & (=] & [J] Digital TV » (=] » » (5] Set Channels » [u]

Renaming Areas

Change Area (] ® (2] Select Area » ®» (3] Change Area Name »
(=] ®» Enter name #» (=]

Updating all channels in the Area

Change Area ™ [u] » [J] Select Area ® (3] Channel Update » [u] %
Update All % (=] & (3] Yes » [u]

Assigning key function to

Channel Key Setting % [u] » (5] Select function » [u]

Reassigning channels to other keys

CH Switch % (u] ® 2] Select channel » » (] Move » (=] » [2] Select
target key » [u]

Deleting channels

‘%H Switch % [u] ® [J] Select channel » » (3] Delete » (u] ® (3] Yes
»>

Additional TV Settings

(m] » (3] TV o [m] & [2] Settings » [u]

Listening to audio from Speakers

Sound Output % (8] » (2] Loudspeaker % [u]

Switching audio output to wireless device

B Sound Output % [u] ®» (§] Bluetooth Device % (u]

Recording programs to handset

Save Recording to % (8] % (2] Phone Memory » (]

Setting TV to end automatically after a period of time

Auto Exit » [m] ® (3] Auto Exit Time % (u] # [J] Select time » [u]

Disabling auto power off when handset is closed

Auto Exit % [u] & (3] Close Action » (u] » Watch TV » [u]
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Camera

- X Advanced Camera Settings
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Photo/Video Camera

(m] » (3] Camera ® (] (For Video Camera, then press [(37])

Changing save location

» (0] Settings » (u] ®» 3] Save Pictures to or Save Videos to » [u] »

Select location or Ask Each Time » [u]

® Ask Each Time is available for video recording when Record Time/Size is set to
For Message.

Activating automatic saving

(=] & [ Settings » (u] » (3] Auto Save » (8] » (3] On » [u]

Selecting image quality

» (3 Picture Quality or Video Quality » [u] # [ Select quality » (=]

Photo Camera

(] & 5] Camera » (]

Changing shutter click sound

» 3] Settings » (] ® (] Shutter Sound % (=] # [-J] Select pattern » [u]
® Shutter click sounds for Continuous Shoot, Panorama Picture and Scanner are

unique and fixed.

Disabling remote shutter control via Bluetooth® watches

» (3] Settings » (u] ® ] Set Remote Shutter » (] » [] Off % (u]
® Available when a Bluetooth® watch is registered.

[(w] & (3] Cameraw (u] » (]

Recording video without sound

» (3] Microphone » (u] ® [ Off % (u]

Enlarging Viewfinder size

» (] Display Size » (u] ® [ Enlarge » (u]




Media Playback

- X Advanced Media Player & S! Application Settings

(=] » [3 Entertainment » [u] » (2] Media Player % (u]

Switching audio output to wireless device

| Settings W [u] » B Sound Output » (=] ® [J] Bluetooth Device » (u]

Operational Settings

(m] » [5] Entertainment W [u] » (3] S! Appli % [u] » (7] Settings » [u]

Adjusting S! Application sound volume

Application Volume » [u] % [3] Adjust level » [u]

Canceling surround effect

Surround » (=] ® ({] Off » [u]

Showing incoming transmission notice

Calls & Alarms % (u] » [J] Select item » (=] % [3] Show Call Notice » [u]

Pausing S! Application for incoming mail

Calls & Alarms % [u] » (2] Incoming Message » (8] » (2] Message
Priority % [u]

Setting handset to show notice at Alarm Time

Calls & Alarms % [u] & [3] Alarm % (=] & (3] Alarm Notice » (u]

Showing incoming S! Appli Request notice

Calls & Alarms » [u] » (2] Start Demand » (=] ® (J] Start Notice % [u]

Changing Screensaver Activation Time

Screensaver % [m] » (3] Activation Time % (u] % Enter time » [u]

Reset Settings

® When an S! Application started from Screensaver is active, a message appears for incoming transmissions regardless of settings.

(=] » [34 Entertainment & [u] » (3] S! Appli % [u] » (0] Settings » (]

Restoring default S! Application settings

Set to Default % [u] % Enter Handset Code » (=] ® (3] Yes » [u]

Restoring default S! Appli Library

Memory All Clear » (8] % Enter Handset Code » [u] ® [J] Yes » (u]
® Near Chat access restriction will be canceled.

® Memory All Clear deletes all downloaded S! Applications.

Media Player & S! Applicati
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- I Advanced Handy Extras Settings

[(m] & (3 Tools » (u] & (3] PIM Tools ®» (=] » (3] Alarms » [u]

Sounding Alarm Time tone even in Manner mode

(2] Settings # [u] ® (2] For Manner Mode » [u] ® (3] Ring » (u] ® [3] Yes # [u]

Activating Alarm based on World Clock time

Settings % (] & (3] Link to World Clk % (=] & [J] On » (]

Wakeup TV

(] & 5] Tools » [u] » [3] PIM Tools » (m] ® (3] Wakeup TV & (u]

Sounding Alarm Time tone even in Manner mode

(2] For Manner Mode % [u] ® (3] Ring ® (=] ® (2] Yes » (]

(] » [34 Tools » (u] & (3] Timer/Clock Tools # (u] & (3] Hour Minder » [u]

Sounding Hour Minder Time tone even in Manner mode

édvanced » (u] & (3] For Manner Mode: » (=] & [J] Ring % [u] ® [J] Yes
»

Activating Hour Minder based on World Clock time

(2] Advanced » (u] & (3] Link to World Clk: % (u] & (3] On w» [u]

S! Information Channel

(w] & 3 Entertainment #» (m] & 3] S! Information Channel/Weather » (u]

Hiding Weather Indicator in Standby

WeaE,ther Icon » (] & [J] Settings » (=] ® (3] Standby Setting % [u] »
Ooff »

Canceling Weather Indicator automatic updates

él/eather Icon » [u] ® [J] Settings » [u] » (J] Icon Update » (=] » [J] Off
»>




S! Friend's Status & S! Circle Talk

- X Advanced Communication Service Settings

(m] » 3 Settings » (=] » (3] Phone Settings » [u] » (3] Locks » [u]

Disabling S! Friend's Status & S! Circle Talk

| IP Service Setting » (u] ® [J] Off » [u] ® Enter Handset Code » [u]

S! Friend's Status

(m] & (34 Communication & [m] ® (3] S! Friend's Status » (]

Rejecting requests from unsaved numbers

DIP Settings % (m] » (2] Request Reply % (m] ® (2] Confirm if Registered
» =
® Rejection notice is sent to rejected numbers automatically.

Rejecting all requests

» (0] Settings » [u] » (2] Request Reply % [u] » (3] Always Ignore » [u]
® Rejection notice is sent to all requesters automatically.

Rejecting incoming images

» (1] Settings » (m] » (3] Receiving Image » (u] ® [J] Reject » (u]

S! Circle Talk

Cal » (=]

Canceling Loudspeaker

| Loudspeaker W [u] » (3] Off » [u]

Communication Services
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- X Advanced Connectivity Settings
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Bluetooth®

(] & 3] Settings ® (u] » (2] Connectivity » [u] & (3] Bluetooth » (=]

Cloaking handset to avoid connection requests

(2] My Device Settings » (=] ® (2] Visibility » (] » (3] Hide My Phone » (u]

Setting idle time after which Bluetooth® is canceled

My Device Settings % (] & [3] Bluetooth Timeout % [u] % [3] Select time
» (=]

Synchronizing Bluetooth® watch with handset

(2] Setting Watch » (u] » (5] Set BT-Watch Time » [u] » (3] Yes » [u]
® Connect handset to a Bluetooth® watch beforehand.

Enabling/disabling Bluetooth® watch responses

Setting Watch » [u] & [2] Notification » (u] » (7] Select item » (] B
Permit or Prohibit % [u]

PC Connection

® Setting Watch settings are available when a Bluetooth® watch is registered.

(] & 3] Settings ® [u] » (2] Connectivity » (] & (3] USB Charge & (u]

Disabling USB Charge

(2] Disable » [u]

(m] » (5 Settings » (=] » (2] Network Settings » (u]

Retrieving Network Information

Retrieve NW Info & (u] B Yes » [u]

Hiding Location Information

(2] Location Info % (=] & (3] Datum On/Off % [u] » (3] Off % (=] & Enter
Handset Code #» (=]

Changing Location Information confirmation option

Location Info w (] » [J] Location Property % [m] ® (2] Select option » [u]
» Enter Handset Code » [u]




- I Reset Settings

Restoring Default Settings (w] » (5] Settings » (u] ® (3] Phone Settings » (u] ® (2| Master Reset % [u]

Reset Settings » (=] » Enter Handset Code » (8] ® [J] Yes » [u] »

Restoring default handset settings Yes » (u]

® Some default settings may not be restored.

Reset All % [u] % Enter Handset Code ® (8] % (3] Yes ® (=] & [J] Yes » [u]

® Files and records deleted by Reset All cannot be restored. Reset All deletes all
downloaded S! Applications.

® Handset Code returns to the default setting.

Clearing all Phone Book entries, Data Folder files, etc.

® A confirmation may appear before entering Handset Code; end the current function to proceed.
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USIM Card

H xipuaddy

14-2

USIM Card is an IC card containing
customer and authentication information,
including the handset number. USIM Card
must be inserted to use this handset.
Save Phone Book entries on USIM Card
Phone Book to use them on other
SoftBank handsets. Depending on the
USIM Card in use, some entry items may
not be supported, and some limits
(character entry, etc.) may be lower.

Precautions

IC Chip

® Do not insert USIM Card into any other IC
card device. SoftBank is not liable for
resulting damages.

® Keep the USIM Card IC chip clean;
malfunction may result. Use a dry, soft
cloth to clean the USIM Card.

® Do not attach labels to USIM Card.
Malfunction may result.

Important

® USIM Card is the property of SoftBank.

® USIM Card will be reissued for a fee if
lost or damaged.

® Return USIM Card to SoftBank upon
subscription termination.

® Returned USIM Cards are recycled.

® USIM Card specifications may change
without prior notice.

® Back up USIM Card files. SoftBank is not
liable for lost files.

o |f your USIM Card or handset (with USIM
Card inserted) is lost or stolen, suspend
your service immediately. For details,
contact SoftBank Customer Center,
General Information (P.14-36).

There are two Security Codes for USIM
Card; both are 9999 by default.

PIN1 Security Code to prevent
unauthorized use of handset
PIN2 Required to clear Call Costs
and to set Max Cost, etc.
PIN Lock

® Entering incorrect PIN three consecutive
times activates PIN1 Lock or PIN2 Lock,
limiting handset use.
Canceling PIN Lock
® Contact SoftBank Customer Center,
General Information (P.14-36) for your
Personal Unblocking Key (PUK Code)
and follow these steps.
Enter PUK Code ® [u] & Enter new
PIN » (=] & Re-enter new PIN ® (=]
m Write down PUK code.
USIM Lock
® Entering incorrect PUK Code
ten consecutive times locks USIM Card,
disabling handset. To learn how to unlock
USIM Card, contact SoftBank Customer
Center, General Information (P.14-36).



USIM Card

® Do not apply excessive force to insert/remove USIM Card.
® USIM Card must be inserted to use this handset.

or Handset Upgrade/Replacement

o Remove battery (P.14-4) Take care not to lose removed USIM Card. e Some downloaded files may be
. . . Remove battery (P.14-4 inaccessible. In addition, S! Applications,
SI'_de in _USIM Card with IC o y ( ) BookSurfing®, S! Town and Near Chat may
chip facing down Gently slide out USIM Card be disabled after USIM Card replacement.

as shown

&l 7
P

® Reinstall battery (P.14-4).

® Reinstall battery (P.14-4).
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Battery
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Battery Installation

About Battery

® Charge battery at least once every
six months; an uncharged battery may
become unusable or affect files/settings.

® Depending on usage, bulges may appear near
end of battery life; this does not affect safety.

® Replace battery if operating time shortens
noticeably.

® Clean device charging terminals with a dry
cotton swab.

Lithium-ion Battery
® This product requires a
lithium-ion battery.
Lithium-ion batteries are a
recyclable resource. %
® To recycle a used -
Iithium¥ion battery, take it Li-ion 00
to any shop displaying the symbol
shown above.
= To avoid fire or electric shock, do not
short-circuit or disassemble battery.

o~y

Inserting & Removing

Remove cover

® Press down and slide cover then lift
as shown.

Insert battery

® With logo side up, fit tabs into battery
cavity slots.

Close cover

® Position and slide the cover gently as
shown until it stops.

® |f cover does not fit properly, remove
it completely and retry.

Removing
® Turn handset power off and lift battery as

shown.




Software Update

Check for firmware updates and download
as required.

Precautions

® Handset is disabled until update is
complete. Update may take up to
approximately 30 minutes.

® Update failure may disable handset. To
reduce failure risk, make sure signal is
strong and stable, and charge battery
beforehand.

® Update will not start if other functions are
in use. Before updating software (or
before scheduled update time), end all
active functions/applications.

® Disconnect USB Cable beforehand to
reduce failure risk.

® Always back up important information.
SoftBank cannot be held liable for
damages from lost information, etc.

Updating Software

Packet transmission fees do not apply to
updates (including checking, downloading
and rewriting).

(] & (3] Settings » (=] »
Phone Settings » [u]

Software Update » [u]
Software Update » [u]

Update software in a place where signal
conditions are strong/stable. All incoming
and outgoing signals will be disabled for
the duration of this update.

Continue?

ElYes Nokgd

® Follow onscreen instructions.

Setting Update Period (Japanese)
In ©), (2] Update Period » (u]
® Follow onscreen instructions.
Update Result
In ©), (2] Update Result » (u]

. Scheduled Update

Confirmation appears at scheduled
update time. Press [®] or wait a while for
update to start.

. When Updated

A message appears and handset reboots.

After reboot, completion message
appears and Information window opens.

Update Result
While Information window appears,
Update Result % [u]
Reboot Failure
® |f handset does not return to Standby
after update, turn power off, reinsert
battery, then restart it. If it still does not
restart, contact SoftBank Customer
Center, Customer Assistance (P.14-36).

Software Update

ﬁ xipuaddy
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Troubleshooting

Troubleshooting

H General

Problem

Possible Cause

Solution

Problem

Possible Cause

Solution

Handset won't
turn on

Was pressed long
enough?

Press longer.

Battery strength
indicator flashes
when not charging

Ambient temperature
may be outside 5°C to
35°C.

Use within an ambient
temperature of 5°C - 35°C.

Battery may need to be
charged or replaced.

Charge battery or install a
charged battery.

Battery may not be
properly installed.

Install battery properly (P.14-4).

Saved entry/folder

Handset won't
respond

Is Switch On/Offin
PIN Entry On?

If On, PIN1 is required. Enter
PIN1 according to onscreen
prompt.

Keypad won't

Keypad Lock may be
active (3 appears).

Cancel Keypad Lock (P.1-12).

does not appear Entry/folder may be set | Activate Show Secret Data
on handset to Secret. (P-11-3).
Cannot use Show Secret Data may
Predictive be active. Cancel Show Secret Data.
Handset/AC Charger
may warm while
charging. Unless handset/AC Charger is
Handset/AC too hot to touch, warmth is
Charger feels Har)dset may warm considered normal. Always
during extended 5 "
warm avoid prolonged skin contact to

periods of use.

Handset may warm
during Video Calls.

prevent burn injuries.

Cannot access
Memory Card files

Memory Card may not
be properly formatted.

Use 922SH-formatted Memory
Cards.

respond i
P Fuqctlon Lock may be Cancel Function Lock (P.11-2).
active (B, appears).
:E’:e':fss:n d Handset may have Handset failed to recognize
PP been dropped or USIM Card temporarily. This is
handset returns to subjected to shocks not a malfunction
Standby ) : '
Turn power off and check that
> USIM Card is properly
g Uz"\gr(l:airr?sg?g ant be inserted, then restart handset.
g properly : If the message still appears,
o Insert USIM Card USIM may be damaged.
X
appears The correct USIM Card g/lalflsgre thte go_l;_rﬁct‘ US";A "
m may ot be inserted. ard is inserted. The inserte
USIM Card may not be valid.

Cannot receive/
accept connection
requests even
when Bluetooth®
Infrared is On

Handset may not be in
Standby.

Return to Standby and retry.

Keypad Lock/Function
Lock may be active.

Cancel Keypad Lock/Function
Lock.

Software Update may
be in progress.

Wait until update is complete.

There may be debris
on IC chip/terminals.

Clean relevant parts with a dry
cloth and re-insert.

14-6

Cannot use
Sensor Key

Sensor Key does not
respond when
illumination is off.

Press @ to turn illumination on.

Sensor Key may be
covered with sticker,
film, etc.

Remove the cover.




M Charger/Battery

H Charger/Battery (continued)

Troubleshooting

I_

Problem

Possible Cause

Solution

Problem

Possible Cause

Solution

Battery charges
quickly

Remaining charge
shortens charging time.

This is normal.

Battery may be
terminally exhausted or
defective. (Small Light
flashes red.)

Replace battery with a new one.

Battery charges
slowly

Charging slows during
Video Calls.

End the call to charge faster.

Battery may be
charging via USB.

Use AC Charger.

Battery won't
charge

AC Charger may not be
properly connected to
handset.

Make sure connector is
securely inserted and retry.

Battery Time
seems shorter

High power consuming
operations are in use.

Keep handset closed in Standby;
reduce TV, S! Application,
Media Player and Camera use,
and limit transmissions/external
connections.

Using handset in poor

Avoid prolonged use of handset

AC Charger may not be
firmly plugged in to AC
outlet.

Remove plug from outlet,
re-insert and retry.

than usual conditions may shorten | out-of-range or in poor signal

Battery Time. conditions.
B Lower Brightness, select shorter
Power hungry settings Display Saving/Backlight time,
may be active.
etc.
M Calling
Problem Possible Cause Solution

Battery may not be
properly installed.

Install battery properly (P.14-4).

Battery, AC Charger, or
Charging Terminals, or
Device Port may be

obstructed by dust, etc.

Clean terminals, connector and
Port with a cotton swab and
retry.

Charger may not be
supported.

Use specified AC Charger only;
others may damage battery.

Cannot place call

Keypad Lock may be
active (33 appears).

Cancel Keypad Lock (P.1-12).

Function Lock may be
active (B, appears).

Cancel Function Lock (P.11-2).

Offline Mode may be
active (# appears).

Cancel Offline Mode (P.1-15).

Call won't connect
and there's a
beeping tone

Did you include the
area code or the first 0?

Dial the number including the
area code or 0.

Handset may be
out-of-range ([l
appears).

Move to a place where signal is
strong and retry.

Call is choppy or
cut off

Network signal may be
weak.

Move to a place where signal is
strong and retry.

Battery may need to be
charged or replaced.

Charge battery or install a
charged battery.

Clicking noise is
heard during call

Handset may be
moving into another
service area.

Noise is heard when Network
signal switches. This is normal.
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H Calling (continued)

M Other Functions

Problem Possible Cause Solution Problem Possible Cause Solution
Earpiece Volume may Increase Earpiece Volume TV, mobile .
Cannot hear be low. (P.3-12). camera, etc. Battery may need to be | Charge battery or install a

other party's

Sound output may be

Set Transfer Audio (P.3-13) to

voice set Fo use handsfree To Phone.
device.
Answer Phone and Caller Voice
are disabled when less than
Cannot use Memory may be full. 12 seconds remain or
Answer Phone or 20 messages are recorded.
Caller Voice Delete messages (P.3-5).

Is the call a Video Call?

Answer Phone and Caller Voice
are not available for Video Calls.

Cannot save
phone number for
Call Forwarding

Does the number start
with 1, 00, 0120 or
0990?

Public service numbers,
international call numbers
starting with 00, toll-free
numbers and fee-based service
numbers cannot be saved.

M Messaging

Problem

Possible Cause

Solution

Cannot receive

Does B appear?

Memory is full. Delete
messages (P.4-22).

messages - -

g Doss appear? Move to a place where signal is
strong.

Recipient must be subscribed to

S! Mail, Super Mail or Long Mail.

S! Mail is not Recipient handset may The maximum size of messages/

delivered as sent

not be S! Mail-compatible.

attachments handsets can
receive varies by make and
model. Confirm compatibility
with recipient handsets.

Still images are
not delivered as
sent

Recipient handset may
not be JPEG-compatible.

Convert JPEG files to PNG
(P.7-14).

Video clips are
not delivered as
sent

Recipient handset may
not support the file
format.

Send video clips to S! Mail- or
VGS-compatible SoftBank
handsets supporting MPEG-4.

won't activate

charged or replaced.

charged battery.

Viewfinder image is
blurry/out-of-focus

Lens cover may need to
be cleaned.

Clean dust/smudges from lens
cover (P.1-2) with a soft cloth.

Handset movement
may blur images.

Hold handset steady when
releasing shutter.

Portrait/Macro Selector
(P.1-2) may be misset.

Slide to & for close-up shots or
to [&] for other shots.

Cannot watch TV

Network Information may
need to be retrieved.

Retrieve Network Information
(P.13-18).

Subscription may be
terminated.

TV is disabled upon
subscription termination.
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SoftBank 922SH

H Handset Materials

Parts

Materials & Finishi

Parts

Materials & Finishing

Weight Approximately 132 g
Continuous Approximately 250 minutes (3G)
Talk Time Approximately 270 minutes (GSM)
. Approximately 340 hours (3G)
gg::clir;auo'll'li?ne Approximately 310 hours (GSM)
Y (handset closed)
Continuous
Video Call Approximately 110 minutes
Talk Time
AC Charger: Approximately
Charging Time | 140 minutes
(power off) In-Car Charger: Approximately
140 minutes
Dimensions Approximately 56 x 116 x 17 mm
(handset closed, without
(W x HxD) )
protruding parts)
Maximum 0.25 W (3G)
Output 2.0 W (GSM)

® Above values calculated with battery installed.

® Continuous Talk Time is an average
measured with a new, fully charged battery,
with stable signals.

® Continuous Standby Time is an average
measured with a new, fully charged battery,
with handset closed without calls or
operations, in Standby with stable signals.

® Talk Time/Standby Time may vary by
environment, status, settings, etc.

® Display employs precision technology,
however, some pixels may appear brighter/
darker.

Housing (External
Display side, Speaker
area, Keypad side,
battery side, right hinge),
Battery Cover, hinge
ornament (sides), screw
cover (battery side)

ABS resin/Acrylic UV
curing painting (sealer:
acrylic painting)

Lens cover, screw cover
(Display side)

Acrylic resin

Portrait/Macro Selector,
handset stop bar

ABS resin

Housing (left hinge)

Magnesium alloy/Acrylic
baking finish (sealer:
epoxy baking finish)

Memory Card Slot
Cover, External Device
Port Cover, Headphone
Port Cover

Elastomeric resin, PC
resin/Acrylic UV curing
painting (sealer: acrylic
painting)

External Display
ornament

PMMA

Infrared Port

ABS resin (infrared
grade)

Display window

Tempered glass with
protective film

Antenna (for TV
reception)

ABS resin/Brass/PA/
Elastomer/SUS

Display stop pads

Urethane resin

Start Key, Power On/Off
Key, Multi Job/Manner
Key, Page Up Key, Page
Down Key, Mail Key,
Shortcuts & Help Key,
TV & Hiragana/
Katakana Key, Camera
& Alphanumerics Key,
Dictionary & Pictogram/
Symbol Key, Memo &
A/a Key, Multi Selector,
Yahoo! Keitai Key,
Clear/Back Key, Letter
Keys, Backspace Key,
Shift Keys, Function
Key, Side Keys

PC resin/UV painting

Charging Terminals

SUS/Gold plating
(sealer: nickel)

Screw (all pieces)

SWCH16A/Ni plating

USIM pin

Copper alloy/Gold
plating (sealer: nickel)

Center Key, Front Keys,
Mobile Light cover,

battery

PC resin

Accessories

H Battery
Voltage 3.7V
Battery Type Lithium-ion
Capacity 820 mAh
Dimensions Approximately 35.3 x 55 x 4 mm
(WxHxD) (without protruding parts)

l Headphones (with Microphone) (Black)

g Approximately 16 &

Code Length

Approximately 1.65 m




Basic Operations

Answer Phone/
Caller Voice

20 messages or 90 seconds

| Specifications

I_

H PC Mail Settings

PC Mail Account 3 accounts
] Wallpaper/Standby Window Auto Answer List | 10 numbers Account Account Name |20 characters
Standby Window | 3 tags (100 characters each) Messaging User Name 128 characters
- Password 32 characters
M Text Entry Set Receiving —
- - - 10 MB or ReceivingServer | 128 characters
o 250 entries (5 per reading) Received Msg. 3.000 messages Port Number 1 to 65535
User Dictionary Word: 15 characters J 9 Sender N 20 ch :
Reading: 8 hiragana Drafts Set Sending erl1 er Name characters
Acquire Dictionary |5 dictionaries Sent Mail Address _ | 128 characters
Paste List 10 text strings Memory Messages |5 MB PC Mail DL Individual Address: 20 addresses
Unsent
gﬁgt::;r:rl;leDeleted 64 characters Messages Yahoo! Keitai & PC Site Browser
100 MB (shared with
H Phone Book Templates | Data Folder and E— Yahoo! Keitai | 300 KB per page
Entry 1,000 entries S! Appli Library) PC Site Browser | 1 MB per file
Name/Reading | Last/First: 32 characters each S! Mail Subject | 512 single-byte characters History 300 pages
i i Approximately URL Entry Log | 10 URLs
1
'I:’nht.:n:dl;l‘umber : n:(;nbers (?;dlins e‘ach) " SRz 30,000 single-byte characters Bookmarks/
Catl ress 120 rttasses'( characters each) SMS Message | 160 single-byte alphanumerics Saved Pages 100 pages
ategory D tal ?;g(:jnésgo h " Auto Resend |2 times Tab 3 tabs at one time
T, ool ry,°32e'ch ot Attachment | 20 files or 300 KB Input Memory | 20 entries
Others: 64 characters each Send Reservation | 10 messages Streaming History | 10 URLs
Office 32 characters per item Speed Dial/Mail | 100 numbers/addresses RSS Feed 30 entries (30 KB per entry)
Homepage 1,024 characters Signature 256 single-byte characters Diaital TV
Note 256 characters Recipient 20 numbers/addresses igita
Mail Groups 20 Groups (20 members each) Folder 20 folders (20 Auto Sort Keys each) recorded Fim |1 SDB-T mobile Video profile
Group name: 16 characters Memory ??3 messages per (SD-Video standard)
older -
. 80 minutes on
M Data Folder Chat Folder — 10 foldors Recoraing Memory Card |80 minutes o
100 MB (shared with Templates (20 members each) ime :
Memory P SJle) Approximately
folder and S! Appli Library) 1 sound or Flash® file, or 40 images/ ple) Handset 30 minutes
Calli Graphic Mail | My Pictggrams (with 1 sound or Marker 99 Markers (10 per file)
alling Flash® file) == - :
Split File 99 portions per file
Srled N " 3D Pictogram | 150 characters Time Shift
g ialed Numbers: 30 records . 30 minutes
Dialed Numbers Dialed Frequency: 10 records :utf)sReply 20 numbers/addresses Recordm_g '
Received Calls 30 records _.ml pam Individual: 20 entries Reservation 5 entries (4 hours each on

es

List

1 GB Memory Card)

xipuaddy
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Camera & Imaging

H Mobile Camera

Effective
Pixels

External Camera | 2.0 Megapixels

Internal Camera | 110 Kilopixels

Auto Shut-off
Time

Approximately 3 minutes

H Photo Camera

M Video Camera c . 52 x 52 dots or larger
i orrection | JoF NG i
Zoom 1x - 9.5x (SubQCIF) Picture images
SD VIDEO 640 x 480 (VGA) Editor Rotate
320 x 240 (QVGA) File Format
640 x 480 (VGA) Merge JPEG images between
DTy R 5 W 48 x H 64 dots and
| 400x240 (Wide)  Composite | Panorama | \y 540y 1 300 dots
Record Size | Extended | 320 x 240 (QVGA) Split Picture
(W x H dots) | Video 240 x 176 (HQVGA)
176 x 144 (QCIF) Media Player
128 x 96 (SubQCIF)
For 176 x 144 (QCIF) WMA (.wma), AAC (.mp4/.3gp/
Message | 128 x 96 (SubQCIF) Supported SmD4i)L‘1ds|§csliar{?1§;dC) (Secure
File Format | 3GP/ASF AT (Some files may not play depending
SD VIDEO | Capacity-based on sampling frequency and bit rate)
Recording Extended | 30 minutes on . .
Time per Video Memory Card S! Applications
Shot For
295 KB - -
Message 100 items or 100 MB (shared with
. MOLXXX.ASF, videoXXX.3gp Memory Templates folder and other folders in
FileName | yx: 3 digits) Data Folder)
Recording . ' Remote )
Distance 1.5 m in good light Control Approximately 5 m

M Editing Images

Zoom 1x - 20x
1600 x 1200
oM (UXGA)
Wide 1600 x 900
1280 x 960

1.2M (Quad-VGA)
Picture Size
(W x H dots) Wallpaper | 854 x 480

VGA 640 x 480

" 320 x 240
Mail L (QVGA)
. 160 x 120

Mail S (QQVGA)
Scanner
Image Size I:;eseo )E(SA;%())( 1200, 1488 x 480,
(W x H dots)
File Format JPEG/PNG

Approximately 1280 files with
MSmoLy default settings
File Name ImageXXX.jpg (XXX: 3 digits)
Shooting .
Distance Macro: 10 cm
Other Use 40 KB or smaller

transparent PNG files as Frames

Wallpaper (854 x 480)
Power On/Off (854 x 480)
. Incoming Call (320 x 320)
(F\*zs;zﬁ dots) | Alarm (480 x 208
VGA (640 x 480)
QVGA (240 x 320)
Picture Cut
Editor Retouch 52 x 52 dots or larger
JPEG/PNG images
Paste 16 characters
Stamp
Face Arrange
Frame




I_

| Specifications
Handy Extras Dictionary |Japanese-Japanese: 17 characters Output Bluetooth® Power Class 2
(search English-Japanese: 34 characters Range Within 10 m
text] J -English: 17 ch 1 S -
300 entries, Subject: 32 characters b Xty - apanese =Ng’s cnaracters Device Search | 16 devices
Calendar’/ | Description: 128 characters Preset holidays are based on Japanese calendar as Pairing 32 devices
Tasks Location: 16 characters of February 2008. =
- ommunication services inti i
Notepad 500 entries (8,192 characters each) ;"I\r"lt'"g C JPEG/ PNG images
1 emor ar
Expenses | 5 o iies (999,999.99 yen each) W S! Loop y
Memo S! L Li i Backup File -
For Approximately !LooplList |5items s yymmddXX (XX: 2 digits/alphabets)
Voice Message |3 minutes per file M S! Friend's Status ;
Recorder [ Extended |99 hours 59 minutes Member 30 members M S! Addressbook Back-up
Voice 59 seconds Name: 7 characters Log 10 Backup/Restore/
Alarms 5 entries, Subject: 9 characters My Status Comment: 15 characters Synchronization records
Wakeup TV Auto Approximately 30 minutes Status Label: 4 characters
P TV | shut-off | APProximately 30 mind Status Temy Template name: 12 characters Network Settings
World Clock | City name: 16 characters H S! Circle Talk
Calculator |999,999,999,999 — r o 5 Networks
23 hours 59 minutes 59.9 seconds in rarticiy members Add Network | Country/Network code: 3 digits
Stopwatch |0.1-second increments Speak Time | 30 seconds each Name: 25 single-byte characters
Lap time: 4 records Member List | 30 entries (10 members per Group)
Reference URLs
1(_:;;:1::down 60 minutes in 1-second increments Connecti ity & File Backup _
StQuick | SPeca fiem M Infrared ,\Sn%';fg'é';rp hitp://mb.softbank jp/mb/en/
News List | Goneral: 4 items Infrared IrMC 1.1 From PC (Japanese)
PDF (.pdf) Transfer Range | Within 20 cm microSD™ http://k-tai.sharp.co.jp/
Document guppo{ted m@cmsogz 5\;(02|CZ g’ds)) IrSS Transfer | Receive 2 MB or smaller JPEG images Memory Card | peripherals/sd_support.html
; ormats icrosoft * Yord (.doc Compatibility From Handset (Japanese)
Viewer : ! ® p
pew Microsoft® PowerPoint® (.ppt) M Bluetooth hitp://shweb.sharp.co.jp/
File Size |10 MB Communication | 5 o e specification Ver. 2.0 S! Addressbook | http:/mb.softbank.jp/mb/en/
Scan UPC/JAN |50 codes System Back-up service/advanced/sab/
parcods Headset Profile From Handset (Japanese)
(Continuous | QR Code |16 codes Hands-Free Profile ‘ SVG-T hitp://shweb.sharp.co.jplsvgt/
Mode) Dial-up Networking Profile index_pdo.html
Create QR | Equivalent of 513 digits, Supported Object Push Profile = e b
Code 311 alphanumerics or 131 kanji Profiles File Transfer Profile Association for | From PC , !
Scan Text | 256 characters Basic Imaging Profile Promotion of http://www.dpa.or.jp/english/
- Advanced Audio Distribution Profile Digital From Handset (Japanese)
e-Books Copy text strings of up to 20 characters Broadcasting

Audio/Video Remote Control Profile

http://www.dpa.or.jp/1seg/k/

ﬁ xipuaddy
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Memory Card Structure & Contents

Memory Card Structure

Contents (Location when Viewed on Handset)

DCIM XXXSHARP Still images in DCIM
Local Contents SD Local Contents
Mail Messaging folder backups (Received Msg., Sent Messages and Drafts)
Book e-Book files in Data Folder (Books)
Bookmarks Yahoo! Keitai Bookmarks
Character PNG files in Data Folder (Character)
Custom Screens Customized Screens files in Data Folder (Customized Screen)
Flash(R) Flash® Wallpaper files in Data Folder (Flash®)
Flash(R) Ringtones Flash® ringtones in Data Folder (Flash® Ringtones)
Games and More S! Applications
Hot Status Template Template files in Data Folder (Status Templates)
PRIVATE MYFOLDER | My ltems Message Templates Graphic Mail templates in Templates folder
Music Music files in Data Folder (Music)
Other Documents Other files in Data Folder (Other Documents)
Pictograms GIF files in Data Folder (My Pictograms)
Pictures Still images in Data Folder (Pictures)
Sounds & Ringtones Melodies and other sound files in Data Folder (Ring Songs-Tones)
Videos Video files in Data Folder (Videos)
Virtual Space S! Town files
WMAudio WMA files for Media Player (WMA)
SH_Folder Application management files
Utility Backup files (Phone Book), etc.
SHARP MOBILE Backup files (User Dictionary), etc.
SD_AUDIO SD-Audio files for Media Player (SD AUDIO)
SD_VIDEO | PRLOO1 ASF video files saved to SD VIDEO




Menu List

b

Communication

Ml Settings: General Settings

Ml Settings: S! Mail Settings

Function Refer to Function Refer to
Function Refer to Delivery Report P.13-8 M ge DL(Japan) P.13-10
S! Town P.10-2 Reply to Settings - Message DL(Abroad) P.13-10
S! Loop P.10-2 Send/ Auto Reply P.4-13 Signature Settings P.4-8
S! Friend's Status P.10-3 Compose Set Quick Reply P.4-13 Picture Appearance P.13-10
S! Circle Talk P.10-7 Auto Resend P.4-2 Auto Play File P.13-10
Near chat P.10-10 Sending Status P.13-8 Send File Settings -
M Notice P.13-8 B Setti . H :
. 2 ettings: PC Mail Settings
Messaging Receive Link to Feeling P.13-9 9 _—— 9 —
1\
— — © 3D Pictogram P.13-9 A unction Pi Z:) J
Y unction Pi ‘:’1‘° Animation View P.13-8 = Mafl DE°°""‘ s
eceived 17sg- = Anti Spam Measures P.4-16 al - .
Create Message P.4-4 Check New Mail P.13-10
Retri New M P.4-12 Report Spam - Word P.13-10
i ;:e"e ew 7s9. i Scroll Unit P.13-8 orewrap s
Drafts P.4-22 M List View P.138 M Settings: SMS Settings
Templates P.4-9 "
Address View P.13-8 Function Refer to
Sent Messages P.4-14 " -
Received Msg. View P.13-8 Expiry Time P.13-10
Unsent Messages P.4-23 "
Sent Msg.View P.13-8 M Center R >
Chat Folder P.4-17 . = T
- Received Msg. P.13-8 Char-code - h=}
Server Mail Box P.4-12 Auto Delete o
Sent Messages P.13-8 3
Create New SMS P.4-7 Qo
Address Settings P.A-3 ol
General Settings P.13-8 m
S! Mail Settings P.13-10
Settings PC Mail Settings P.4-20
SMS Settings P.13-10
Speed Dial/Mail P.4-8
Set Mail Group P.4-18

Memory Status
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Menu List :
Function Refer to Function Refer to
Yahoo! Keitai P.5-3 Reservation List P.6-10
Function Refer to Font Size P.13-11 Settings P.13-12
Pictures P.2-20 Scroll Settings P.13-11 H Settin gs
DCIM P.2-20 Cursor Settings P.13-11 .
Ring Songs-Tones P.2-20 Downloads P13-11 function Heforito
S Appli P.8-10 Memory Operation | P.13-11 Alarm -
Music P.2-20 ;?ovsvi:r Security Settings - TV Alarm \Ifi'b::t'on
Videos P.2-20 Settings Download to P.13-11 Algrm Time P33
Books P.2-20 Initialized Browser P.13-11 - .
Customized Screen P.2-9 Reset Settings P.13-11 Duration _ -
Status Templates P.2-20 Warning Message P.13-11 Set Recordujg P13-12
Flash® P.2-20 Zoom Factor P.5-9 Ima.ge Locahon. -
Other Documents P.2-20 Zoom Area P.5-9 g;ct::dcast E:;::’i::""edw" -
Homory Status — M Browser Settings Manufacture Number | -
Function Refer to Delete StationData -
Font Size P.13-11 Screen Display Setting P.6-4
Function Refer to Scroll Unit P.13-11 Full Screen | Display Pict -
Yahoo! Keitai P.5-3 Cursor Settings P.13-11 Setting Enlarge Point -
Bookmarks P.5-7 Downloads P.13-11 Sound Output P.13-13
Saved Pages P.5-7 Memory Operation P.13-11 Sound Output P.13-13
Enter URL P.5-3 Security Settings - Set Call Time Shift P.13-13
History P.5-3 Download to P.13-11 Calls & Alarms P.13-13
PC Site Browser P.5-4 Initialized Browser P.13-11 TV Reserve Prior -
Browser Settings P.13-11 Reset Settings P.13-11 Save Recording to P.13-13
= Close Action P.13-13
Function Refer to
Homepage P.5-4 Function Refer to
Bookmarks P.5-7 Digital TV P.6-4
Saved Pages P.5-7 TV Player P.6-8
Enter URL P.5-4 TV-Image Folder P.6-6
History P.5-4 TV Link -
RSS Feed P.5-8 TV Listing P.6-5




Entertainment

H S! Appli: Settings

Menu List

I_

Function Refer to
Function Refer to Application Volume P.13-15 M Photo Camera
Media Player P.8-2 . Switch On/Off - Function Refer to
— Backlight -
S! Appli Library P.8-10 Blink - Exposure P.7-4
! Appli Demand History P.8-10 Vibration - Add Frame P.7-7
- PP Settings P.13-15 Synchronization - Continuous Shoot P.7-7
Information - Communication - Modes Camera Effects P.7-7
' oui S! Quick News List P.9-28 Calls & Alarms P.13-15 Panorama/Scanner P.7-8
ﬁé\?vls"(:k S! Loop List P.9-38 Switch On/Off P.8-11 SoloTravelingPhoto | P.7-6
Settings P.9-38 Screensaver | Activation Time P.13-15 Barcode/Scan P.9-24
S! Information Channel/Weather P.9-29 Stop Auto Start - Data Folder P.7-4
BookSurfing P.9-30 Surround P.13-15 Picture Size P.7-13
e-Book Viewer P.9-30 Set to Default P.13-15 Scene P.7-13
H Media Player Memory All Clear P.13-15 Picture Quality P.13-14
Etnciion Refer to H S! Information Channel/Weather Self-timer i _ P.7-6
Last Played Musi P.8-12 Functi Refer t Display Indicators | -
MasM ayed Tusie P.8-9 T Hcton P: :; 9 Shutter Sound P.13-14
S; Alljl;II((:) P.8-5 i f s ew P-9-29 Settings Save Pictures to P.13-14
= istory - 9 Auto Save P13-14
Music WMA P.8-5 Registration/Cancel P.9-29 "
D load Musi P.8-3 Get Latest Content: P.9-39 Panorama Settings -
ownloa usic — et Latest Lontents = Set Remote Shutter P.13-14
Music Search P.8-3 S! Info. Ch. Notif. -
Internal Camera P.7-13
Settings P.8-12 Weather P.9-39
Last Played Video | P.8-12 Weather Manual Update P.9-29 Help P93
Flay - Icon e’ o - Mobile Light P.7-13
My Videos P.8-7 Settings P.13-16
Videos SD VIDEO P.8-7
Download Videos P.8-4
Settings P.8-12
Streaming P.5-10
. Sound Output P.13-15
Settings Delete All WMA P86

ﬁ xipuaddy
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M Video Camera

Tools

Function Refer to
Exposure P74 H PIM Tools M Phone Settings
Display Size P.13-14 Function Refer to Function Refer to
Data Folder P.7-5 Calendar P.9-4 Mode Settings P.13-2
Record Time/Size P.7-13 Alarms P.9-9 Display P.13-3
Microphone P.13-14 Wakeup TV P.9-11 Customized Screen P.2-9
Video Quality P.13-14 Tasks P.9-7 Sounds & Alerts P.2-10
Self-timer P.7-6 Calculator P.9-13 Date & Time P.13-2
Save Videos to P.13-14 Expenses Memo P.9-14 Set Key Light P.13-4
Settings Auto Save P.13-14 B Timer/Clock Tools S8R (Language) P.13-3
Video Encode - - Add New Entry P.2-16
Internal Camera P.7-13 Function Reforito gse‘r Saved Word List P.2-26
Help P.9-3 Stopwatch _ P.9-15 eHonaNY 1 cquire Dictionary | P.2-16
Mobile Light P.7-13 Countdown Timer P.9-16 Ringer Output P13-5
World Clock P.9-17 -
. Earpiece Volume P.3-12
Hour Minder P.9-18 Change Menu P24
M Doc./Rec. Tools Locks P.11-2
Function Refer to Software Update P.14-5
Dictionary P.9-19 M Reset Settings P.13-19
Search P.9-20 Reset Reset All P.13-19
Document Viewer P.9-21
Notepad P.9-22
Scratch Pad P.1-14
) Record Time P.9-35
\F,lzlt‘:r der Ring Songs-Tones P.9-23
Save Recording to P.9-35
Scan Barcode P.9-24
Open Barcode P.9-36
Barcode/ Create QR Code P.9-25
Scan Scan Card P.9-26
Scan Text P.9-27
Scanned Results P.9-36
Phone Help P.9-3




I_

: Menu List
Phone Settings: Display Phone Settings: Date & Time [l Connectivity
Function Refer to Function Refer to Function Refer to
Wallpaper P.2-8 Set Date/Time P.13-2 Bluetooth P.12-6
System Graphics P.13-3 Time Correction P.13-2 Infrared Switch On/Off P.12-3
Display Effects P.13-3 Daylight Saving P.13-2 Send All P.12-4
Font Settings P.2-5 Set Time Zone P.13-2 USB Mode Mass Storage P.12-10
Clock/Calendar P.13-4 Clock/Calendar P.13-4 MTP Mode P.8-4
Standby Standby Window P.2-6 World Clock P.9-17 USB Charge P.13-18
Display Show Indicators P.13-4 Alarms P.9-9 Memory Card P.2-23
Show Operator Name | - Set Holiday - Backup All ltems P.12-13
Vivid Mode - Time Format P.13-2 Backup Selected P12-12
Greeting Message - Date Format P.13-2 ltems
Duration P.13-4 Calendar Format P.13-2 Backup Restore All ltems P.12-13
N . Restore Selected
Message , P13-4 Phone Settings: Locks ltems P12-12
External Display Date&Time |- Functi Refer t Settings/M P12-13
Display Clock Type " unction efer to ettings/Manage .12-
Caller Display P.13-4 PIN Entry p.11-2 Connectivity: Bluetooth
" Change PIN2 P.11-6 -
Dial Number P.13-4 — Function Refer to
- Face Recognition P.11-4 -
. Time Out P.13-3 - Switch On/Off P.12-7
Backlight " Function Lock P.11-2 -
Brightness P.13-3 - - Search for Devices P.12-7
" - IP Service Setting P.13-17 - -
Display Saving P.13-3 —— Paired Devices P.12-7 >
Dial Number R Application Lock P.11-3 Send Al P12-8 o]
History Lock P.11-3 ~cttine Waton ians B
Phone Settings: Sounds & Alerts Show Secret Data P11-3 etting Watc Y Ta— = E__
Function Refer to Set Lock M g P.11-6 Visibili YTRT x
Volume P.13-5 Chng Handset Code P.1-16 . 2 ”zo ot = m
Ringtone/videos P.2-10 "S"g’n?:;"s"e :“';' ; ':t” -
System Sounds P.13-5 S'a: s Il:e: hd |ntg -
Vibration P.2-10 = ‘:p 'theTc_""es P T
Event Light P13-5 TS uetooth Timeou s
Status Light - y Device Detals -
Any Key Answer P.13-5

Surround
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Menu List I
Connectivity: Memory Card Function Refer to _
Function Refer to Int'l Prefix -
Number of Copies P.7-12 Int'l Calling | Country Codes - Function Refer to
DPOF Settings P.7-14 Auto Add Code - Phone Book P.2-17
Check Settings P.7-12 Disp. Time/ | Display Call Cost P.13-7 Add New Entry P.2-17
Reset Settings - Call Call Time Counter P.13-7 Information P.1-8
SD Local Contents - Outgoing Calls - Call Log P.3-8
Format Card P.2-24 Call Barring Incoming Calls - Play Messages P.3-5
Memory Status P.2-20 Rejected Numbers P.3-15 Call Voicemail P.3-11
B Call/Video Call Change NW Password | P.3-15 Category Control P.2-27
= Minute Minder P.13-7 My Details P.1-13
Eunction Heferity Handset Close P37 Speed Dial/Mail P37
Call Time & Call Timers P.3-9 Auto Answer - Mail Groups P.4-18
Cost Data Counter P13-7 Call Waiting P.3-14 S! Addressbook Backup P.12-14
e = Il Network Settings Sort Entries P.2-19
Switch On/Off P35 - Select Phone Book | P.13-6
:::",1‘,:.- Answe.r Time - Function Refer to gzifi;:o: Save New Entry P13-6
Outgoing Message - Select Netw.ork - g New Number Prompt | P.13-6
Volume - Select Service - Set Preferred P136
Voicemail P.3-10 Offline Mode P.1-15 Copy All "
V¢_)icemai|/ Diverts P.3-10 Retrieve NW Info P.13-18 Man_age Memory Status P2-17
Divert Cancel All P.3-11 URL Setting - Entries
Location Delete All P.2-28
Status P.3-14 Info Datum On/Off P.13-18
Camera Picture - Location Property P.13-18
Incoming Picture P.13-7 Network Info -
Outgoing Picture P.13-7 External Device -
) Hold Guidance Pict -
Video Call -
Backlight -
Loudspeaker P.3-13
Mute Microphone -
Remote Monitor P.3-12
Show My Number P.3-15
Missed Calls P.3-11




b

Numbers

3D Pictogram
3D Pictogram (settings) ...

A
AC Charger 1-10
A ries v
After-Sales Services.......c.oummrnrssernssenns 14-35
Alarms 9-9
Canceling.... ....9-10

Deleting....
Editing entries .
For Manner Mode..
Link to World Clk
Animation View.
Answer Phone...... -12
Antenna (for TV reception) ..
Anti Spam Measures .....
Any Key Answer

Application Lock 11-3

Auto Reply 4-13

Auto Resend 4-2,13-8

Auto Retry 4-2
B

Backlight 13-3

Backup

Backup
Deleting files
Encode..... .

12-12

Restore .... .
Battery 1-10, 14-4
Battery Cover 1-2
Bluetooth® 12-6

Change Name ...12-9

....12-9

Deleting Paired Devices..

Disconnecting Devices.. .12-9
My Device Settings . 3-18
Printing images ... 7-12
Receiving files.. .12-8
Sending files.. 7-13, 12-8, 12-9
Setting Watch...
Bookmarks
Deleting titles....
Editing Titles..
BookSurfing®

c

Calculator
Copying Calculation Results
Exchange Rate....
Money Converter..

Calendar
Calendar Settings....
Deleting Schedules .
Editing Schedules ...
Opening Schedules.
Saving Schedules ...

Call Barring
Black List...

Deleting records.........ccoceeveneecieneernennens 3-13
Call Time & Cost 3-9
Data Counter....
Resetting........
Call Time Counter.
Call Waiting ..
Call Waiting (;
Caller ID

Calling

Camera
Auto Save
Capturing Still Images.. .74
Mobile Light.... 7-13

Picture Quality ...
Portrait/Macro Selector
Recording Video....
Save Pictures to .
Save Videos to
Self-timer........
Switching Active Camera
Video Quality..
Center Access C
Change NW Password...
Change PIN
Character Code List...
Charging
Charging Terminals ........cocueeruevsrsensarsensenns
Chat Folder
Delete Folder........ccoooiiiinieneeniiicnnee
Deleting All Messages..
Reset
Clock/Calendar
Communication Services........couerurrerans
Composite
Conference Call ......coccererrvenresnscssesnssnnans
Conference Call (opening another line)
Countdown Timer ...
Customer Service ...
Customized Screen (Japanese).
Web Access

Data Broadcast (Japanese)
Returning to Initial Window
Set Recording .

Data Folder 2-20
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Change List View.
Files (attaching)...
Files (moving/copying)...
Files (opening)..
Files (sorting).
Files (using)
Files/folders (deleting) ...
Files/folders (renaming).
Folders (adding) .........
Selecting Multiple Files..
Set Secret (folders)..
Slide Show...............
Unset Secret (folders)....
Date & Time
Calendar Format .
Date Format .....
Time Format..
Daylight Saving ..
Delivery Report
Dialing from Call Log Records.
Dictionary
Digital TV (— TV)
Adding Reception Areas....
Area Setup ..........
Areas (settings)
Auto Exit
Calls & Alarms..
Change Area .
Image ............
Sound Output...
Set Channels....
Sound Output ...
Subtitle/Sound..
Switching Reception Areas ..

-.4-9,13-8
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TV Alarm ... . 13-13
Display 12,1-5,1-8

Display (settings) ........cccverrserserssersnssnnsans 13-3
Backlight
Clock/Calendar ...

14-28

Display Saving...
Show Indicators.
System Graphics ...
Display Call Cost
Display Effects
Display Positions
Display Saving
Document Viewer
Download Dictionary .
DPOF
Add Date
Check Settings
For All Pictures

Index Print
E

Earpiece 1-2
Earpiece VoIUME .......cccceververrernnnsinnsannans 3-12
e-Book Library 9-39
e-Book Viewer 9-30
e-Books (Japanese) .........ucerencsecninnnsnnas 9-30

Copying Text...

Downloading

Reading.......
Emergency Calls .
English
Event Light
Expenses Memo

Changing Amount..

Changing Category of Saved Entry........ 9-33
External Camera 1-2
External Device Port .........cceevrerersnnesnnenns 1-2
External Display 1-2

Face Recognition
Feeling Mail (creating) ..
Feeling Mail (receiving)
Font Size
Format Card

Front Keys 1-4
Function Key 1-3
Function Lock 11-2

G

General Notes
Graphic Mail
Creating from templates ...
Font Color/Size & Effect.
Guide Usage Notes ..

Handset Closed
Handset Code
Handset Keys
Handset mail address ........coeerenuerurcensnns
Handset Menus
Handset Open
Handset Parts
Handset Power On/Off .
Handset Responses.

Ring Time......

Ringtones ..

Vibration ....
Handy Extras
Headphone Port
Headphone
Headphones (answering calls)....
Headphones (with Microphone)..
History Lock
Hold
Hour Minder

Assign Tone/Video..

For Manner Mode

Link to World Clk..

Vibration

Indicators 1-5
Camera (Viewfinder).........cccoevvicinnnnne. 7-3




Display
External Display ...
Messaging (message list) ...
Music Playback Window .
Video Playback Window..
Information Window
Infrared
Receiving files....

Sending files ... 12-4,12-5
Infrared Port 1-2
Internal Antenna 1-2
Internal Camera 1-2
International calls 3-3
International calls (placing) ........cccveeeueunees 3-3
Internet

Accessing
Basic Operations
Browser Settings...
Deleting History
Handling Information....
Saving pages/Bookmarks
Switch Browser

URL ENHY LOG orrrrromerssomessseesosoeerion 59
Int'l Call 3-4
IP Service Setting ...

IrSS Transfer ... 7-13,12-2
Keypad Lock 1-12
L
Language 13-3
Large Font Menu 2-5
Light Sensor.........ccecvvereresesnns 1-2,13-3, 13-12
Link to Feeling 13-9
Link to World CIK ........ccceununmninmnnnennsnsnnnnns 13-16

Location Info
Datum On/Off
Location Property..

Locks

1- 16 11-2

Loudspeaker ........cc.cerurenerens 3-13, 13-7, 13-17
M
Mail Groups 4-18
Changing members...........ccccocveiiinnenenns 4-24
Deleting .

Edit Name .
Main Menu
Manner mode
Mass Storage
M Reset

Format Card..

Reset All

Reset Settings.......ccccoevveievieenccicee
Media Player

Delete All WMA ...

Playlists

Sound Output
Memory All Clear (S! Applications)
Memory Card

Format Card.........cccevevveeneneninieneniennn

Opening files ........ccovvvieiiiiiiiceccies
Memory Card Structure & Contents......14-20

Menu List 14-21
CaMETA ..ttt 14-23
Communication ... ..14-21
Data Folder ... 14-22

14-23
..14-21

..14-26
14-24
14-24

Entertainment

Settings ..

...14-22

Yahoo! Keitai ..........cccceevvvininiiiniiinns 14-22
Menu Operations 2-2
Message List View .......ccccceeicininccicnnncnns 13-8
M ge Notice 13-8

Messages (creating/sending) ...
3D Pictogram ...
Date & Time

: Index
Drafts
Edit & Send .
Editing/resending
Messaging Settings.. .49

Pict Setting.............
Preview Message ..
Recipients (adding)
Recipients (selecting/entering).. ..4-8
Save to Drafts........
Set Auto Play File..
Set Sent Cancel
Signature Settings.
Speed Dial/Mail ..
Templates
Within the Network ..........ccocevieiiiiiniene
ges (deleting)
Messages (forwarding)..
Messages (protecting)...
Messages (receiving/checking).
Copying Text...
Mail List..........
Opening New Mail Out of Standby ...
Retrieving New S! Mail Manually..
Save to Data Folder
Save to Phone Book.
Scroll Unit
Using Linked Info
View Mail Address....

. 4- 10 4-21
.. 4-13
4-12
.. 412
.. 4-12
4-12
4-13
.. 13-8
.. 4-12
4-22

Viewing on External Display... 412

M ges (sorting) 4-16
Anti Spam Measures.... .
Classify...............

Move to Folder ..
Messaging (— SMS S! Mail, PC Mall) ...... 4-2
Changing Font Size.. .
Folders (adding) ...
Folders (deleting) .
Folders (renaming)...
General Settings
Selecting Multiple Messages..

138
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Set Secret..

Window Description....
Microphone
Minute Minder 13-7
Missed Call Notification ......c..cccceurreriennens 3-11
Mode Settings
Mobile Light
MTP Mode
Multi Job
Multi Party
Music (deleting)
Music (downloading)
Music (playing)

Last Played Music ...

Playback Mode .

Sound Effects
My Details

Sending via Bluetooth®..

Sending via Infrared

Near Chat (Japanese) .........cccouevureursansns
Network P: ord
Notepad
Call Notepad
Edit Text/Change Category ..
o
Offline Mode 1-15
Optional Service 3-10
Optional Services (checking status)...... 3-14
P
Pen Light 9-2
PC (connecting handset)..........eceurunnnns 12-10
PC Mail 4-19
PC Mail Settings.......ccvveerermrscssrsensunsensnnns 4-20
PC Site Browser 5-4

Jumping to Specific Locations ...
Switching View
Warning Message..
Zoom Factor ..........
Zooming Specific Areas...
Phone Book
Category Control ..........cccccevvririciccnnnne
Changing Light Color/Vibration Pattern..2-27

Create Message .... 2-28
Deleting entries ..2-28
Editing entries ...2-28

New Number Prompt... 13-6

Opening from Other Functions .. 2-19
Personal Ringtone ..2-18
Picture ..2-27

13-6

Save New Entry.

Saving Other Information. 2-27
Secret ...2-18
Select Phone Book... ...13-6
Phone Book search.... .. 2-19
Phone Help 9-3
Picture Editor 7-9
PIN 14-2
PIN Entry 11-2
PIN Lock 14-2

Playlist: 8-9, 8-13
Portrait/Macro Selector. .
Printing (Bluetooth®)

Q
QR Code 9-25
Quick Operations .........coeeeseversursessnnsnsnnannns 2-2
Quick Reply 4-13
R
Received Msg. VieW.......cccceurernrenernnacnnnns 13-8
Record Caller Voice 3-13
Reference URLS ........ccccucervmicerneccercannee 14-19
Reject (calls) 3-12
Remote Monitor ........ccccuvveeesersensersessenanns 3-12

Reply
Quick ReplY .....ccvvviiiiiiciccce
Quoting Original Message Text...
Rep. with View................

Reset (— Master Reset)..

Reset All

Reset Settings

Retrieve NW Info.

Romaji Input Table ...

S

S! Addressbook Back-up.
Confirming User ID & Password .
Set Auto Sync...
Sync History

S! Applications
Activation Time (Screensaver)..............
Application Volume .
Calls & Alarms...
Deleting ........
Downloading.
Surround
Screensaver..

S! Circle Talk
Accepting requests ..........ccccovveieiiiiiens
Editing Member List....
Initiating ...............
IP Service Setting
Loudspeaker
Registering Members ...

S! Friend's Status.....
Editing member list.
IP Service Setting...
Opening Member Status...
Registering Members .
Request Reply .....
Status Notif. List...
Status Update.........ccceeveveeneeienienceens

S! Information Channel (Japanese)........
Get Latest Contents..........ccccoevvuriinnnne.




S! Information Channel page Options.....9-39

Weather ICoN........cocveerieerccceeee 9-29
S! Loop (Japanese) ........ccueevmsucsecsssnsnianns 10-2
S! Mail

Attaching Files ...
Auto Play File
Feeling Mail
Graphic Mail
Message DL....
Picture Appearance ..
S! Mail (sending)
S! Music Connect (Japanese)....
S! Quick News (Japanese)...
Automatic Update
Deleting items ....
S! Loop List........
S! Town (Japanese)
Safety Precautions
SAR
Saved Pages
Deleting pages ...
Editing Titles
Scan Barcode
Open Barcode
Scanning during Text Entry .
Using scan results
Scan Card
Using scan results...........ccccovvveinieennne
Scan Text
Scanning during Text Entry .....................
Using scan results .
Schedules (— Calendar)..
Scratch Pad
Screenshots (capturing) .......cccccveeeiinnieninns
Search
Security Codes
Sending Status
Sensor Key
Sent Msg.View
Set as Wallpaper

Set Date/Time 13-2
Set Key Light 13-4
Set Sent Cancel 4-8
Set Time Zone......cccccrecerceeescnerns 9-17, 13-2
Set to Default (S! Applications)............. 13-15
Shortcuts 2-2
CuStoMIZING ..cvevviiirieieieiecee 2-25
Show My ID 3-12
Show My Number.. .
Show Secret Data .
Side Keys
Signature Settings
Simple Menu
Slide W paper
Small Light
SMS
Expiry Time ...
SMS (sending) 4-7
Softkeys 1-8

Software Update ...
Sounds & Alerts
Speakers
Speed Dial/Mail ..
Specifications
Specifications (by function)..
Basic Operations
Calling
Camera & Imaging ..
Communication Services ..
Connectivity & File Backup ..
Digital TV
Handy Extras.
Media Player .
Messaging
Network Settings.
S! Applications ...
Yahoo! Keitai & PC Site Browser....
Standby
Standby Window (Japanese)
Calendar/Tag Panel

1.8, 1-11

Display Panel
Display Window..
Member Panel....
News Panel ....
Shortcut Panel
Using Tags .....
Status Templates ....
Still images (capturing)........ccoeeverneriennens
Add Frame..........
Camera Effects...
Continuous Shoot
Panorama Picture..
Picture Size.....

Shutter Sound ....
Solo Traveling Photo®..............cccoeeeinne. 7-6
Still images (capturing & sending).... 7-4, 7-8
Still images (editing)
Additional editing options
Changing sizes...
Face Arrange
Merge Panorama...........ccccceeeevinincancnnne 7-11
Stopwatch
Strap Eyelet
Streaming
Swap Calls
System Graphics ....
System Sounds....
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Deleting Tasks....
Editing Tasks ..
Opening Tasks ...

Text (editing)

Text Entry
Call Notepad ..
Emoticons

14-31



Index I

E xipuaddy

14-32

Hiragana........ccoceveviviieniieenicesese 2-12
Hiragana to Katakana/Alphanumeric
Conversion
Input/Conversion .
Inserting Line Breaks..
Inserting Phone Book Entry Items..
Inserting Spaces..
Katakana..............
Mail & Web Extensions..
One-Hiragana Conversion....
Phonetic Conversion ..
Reset History...........
Toggling Entry Modes.
Symbols & Pictograms ..
Undo Conversion or Recover Deleted Characters... 2-26
Using Character Codes...............
When Target Word is Not Listed..
Time Correction
Troubleshooting .........ccucceineciinsniininiannnns
TV (watching)
Changing Audiovisual Setting..
Channels (saving)
Data Broadcast (Japanese)..
Program Info..................
TV Listing (Japanese)....
Using Wireless Headphones ...
TV-Image Folder
TV Player
TV programs (recording/playing).
Marker
Memory Remaining....
Playback Pattern .
Playing Split Files ....
Recorded programs (deleting).
Recorded programs (renaming)
TV Timers (recording/watching) ..
Save Recording to.......
Set Call Timer Shift ....
Setting Timer via Program Info....
Timer entries (editing/deleting)....

Timer log records (opening/deleting)...... 6-13

Wakeup TV ..o 9-11
U

USB Cable v

USB Charge ......cocvvemsersesursurnesesanns 1-10, 13-18

User Dictionary 2-16

Editing/deleting entries ..........cccoeennne. 2-26

USIM Card 14-2

USIM PINs (— PIN)..
Utility Software

Vv
Vibration 2-10
Video (deleting) 8-8
Video (downloading).......coeserrercnessenssensans 8-4
Video (playing) 8-7
Display Size

Last Played Video..
Playback Mode
Sound Effects ....
Video (recording)
Display Size....
Microphone
Record Time/Size
Video (recording & sending)..

Video Calling 3-6
Incoming Picture.........ccccoceviiiinincennne. 13-7
Loudspeaker

Outgoing Picture
Remote Monitor.
Video Calls (answering)
Video Calls (placing)........cccevurennsessesansansnnas 3-6
Voice Calling 3-3
Voice Calls (answering) -
Voice Calls (placing) .
Voice Calls (placing while abroad) ........... 3-4
Voice Recorder 9-23
Record Time
Save and Send ..

Save Recording to ........cccoevvveiiiiicnnn. 9-35
Voicemail 3-10
Volume (ringtones).........cccvenrersuersersunsnnns 13-5

w
Wakeup TV 9-11
Wallpaper 2-8
Warranty 14-35
Weather Indicator.........ccccevenimnininninnians 9-29
Icon Update

Manual Update .
Standby Setting
Weather

World Clock.
Adding Custom Time Zone
Opening World Clock in Standby ...

Y
Yahoo! Keitai 5-3

Accessing Secret Files/Entries
Data Folder
Messaging folders
Phone Book.........
Schedules/tasks ..

Accessing the Internet
From message text.
From scan results
Media Player
PC Site Browser ..
Yahoo! Keitai

Browsing/Viewing
Document Viewer ..........cccocovieiiiicnnens 9-21

PC Site Browser ..

S! Information Channel..

S! Quick News

Yahoo! Keitai.........coceveevenircriniiciicieeee
Calculating




Calculator
Expenses Memo ...
Canceling

Answer Phone.
Call Forwarding ..
Download Dictionary ....
Function Lock..
Hour Minder
Keypad Lock....
Large Font Menu...
Manner mode..
Offline Mode....
S! Information Channel ...
Secret folders..
Simple Menu....
Speed Dial entries.
Voicemail
Changing
Font Size
Font Weight.
Handset Code.....
Handset mail address ..
Network Password

... 2-29, 4-23

Changing Ringtones
Feeling Mail
From Data Folder ..
Phone Book .......
Ringtone/videos .

Composing/Sending Messages
Feeling Mail
From Call Log records..
From Internet pages
From message text....
From Phone Book .....
From received messages
From scan results
From Scratch Pad
From sent messages....

Graphic Mai

Copying
Calculation results...........ccocevviiiiininenns 9-33
Data Folder files
From text entry window .
Scan results .....
Text (e-Books) ..
Text (Internet pages) ..
Text (Messaging)........
Text (S! Information Channel pages)....... 9-39

Exchanging Files
Bluetooth®.
Infrared......
IrSS Transfer .
Mass Storage....

Hiding Files/Entries
Data Folder
Messaging folders...
Phone Book
Schedules/tasks

Inserting/Removing

Memory Card
USIM Card ....
Locking/Restricting
Application LOCK ........ccecereeiirieriereenens 11-3
Call Log .11-3
Face Recognition
Function Lock......
Incoming/outgoing calls.
Keypad Lock
Mail records...
Phone Book
PIN Entry
Managing Schedules
Calendar........ocveeerinieneeeeeee e 9-4

Measuring Time
Countdown Timer-..
Stopwatch

Notifying Phone Number
Opening My Details.........ccccceveviriinennne 1-13
Via Bluetooth®.... .

Via Infrared

Operations with Handset Closed
Answering calls .........ccoceeviriereieniecieniees
Dialing from Call Log records....
Dialing from Phone Book ...
Entering Phone Numbers
Opening My Details
Playing Answer Phone messages....
Using Speed Dial ............
Viewing new messages...

Placing Calls
From Call Log records..
From Internet pages.
From message text
From Phone Book ....
From scan results
International calls ..
Speed Dial
Video Calls
Voice Calls.
While abroad..
With handset closed.

Playing
Answer Phone messages/Caller Voice ....

Files (Scan Barcode)....
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Recorded TV programs...
Recorded TV programs from Timer log ...
Split files (TV). .
Streams....
Video....
Voice files
Voicemail messages.
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Rejecting
Calls from public phones.........c.ccceeveuee
Calls from specific numbers ...
Calls from unsaved numbers...
Calls with undisplayable Caller ID ..
Calls without Caller ID
Neat Chat requests ...........cccceeercinee.
Resetting/Formatting
All settings .
Handset
Memory Card..........cccocoiviiiiiiiiicces 2-24
Saving

Captured still images..
Draft messages
Edited still images
Files (Internet)
Files (S! Information Channel pages)..... 9-39
Graphic Mail templates..
Mail attachments .
Notepad entries ...
Phone Book entries.....
Recorded video ...
Scan results...
TV channels
Saving Phone Book Entries
Add New Entry
From Call Log records
From message text.....
From received messages ..
From scan results..........ccccoeevecenenennnnne.
Scanning
Business cards.....

Searching
Bluetooth® devices ..
Messages
Music to download...
Music to play

Phone Book
Text (Internet pages).
Text (Web/Mail Search) ...
Video to play...
Web Search....
Sending via Mail
Data Folder files ....
QR Codes....
Scan results.

Voice files ....
Setting Wallpaper
From Data Folder
From Phone Settings
From scan results
Showing in Standby
Clock/Calendar ..
S! Applications
Standby Window
Wallpaper .
World CIOCK ..o 9-17
Using as Alarm Clock
Alarm
Hour Minder....
Wakeup TV ..o
Using Away from Home
Alarm ...
Camera.
Dictionary ...
Digital TV.
Hour Minder.
Pen Light.
Phone Help
Voice Recorder ..




W Warranty

Warranty is provided when you purchase handset.

® Check the name of distributor and date of purchase.

® Read through contents and keep in a safe place.

® The warranty term is described in the warranty.

H After-Sales Services

See P.14-6 "Troubleshooting" before contacting SoftBank for

service or repairs.

If you cannot find solutions or solve problems, contact SoftBank

Customer Center, Customer Assistance (P.14-36) in your

subscription area and provide a detailed description of the

problem.

® Repairs within warranty are performed under terms and conditions
described.

® QOut of warranty, possible repairs are performed upon request at
subscriber expense.

For other services, contact the distributor, the nearest SoftBank
Shop or SoftBank Customer Center, General Information
(P-14-36). Replacement parts are available for 6 years after
termination of production.

® SoftBank is not liable for any damages resulting from use of this
product.

® SoftBank is not liable for any damages resulting from accidental
loss/alteration of handset data. Keep a copy of Phone Book
entries, etc. in a separate place.

® Disassembling or modifying handset may violate the Radio Law.
Modified handset will not be repaired.

Warranty & Service
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Customer Service

For SoftBank handset or service information, call General Information. For repairs, call Customer Assistance.

SoftBank Customer Center SoftBank Global Call Center
From a SoftBank handset, dial toll free at 157 From outside Japan, dial +81-3-5351-3491
for General Information or 113 for Customer Assistance (International charges apply.)

Call these numbers toll free from landlines.

Subscription Area Service Center Phone Number
Hokkaido, Aomori, Akita, Iwate, Yamagata, Miyagi, Fukushima, Niigata, Tokyo, General Information @0088-240-157
Kanagawa, Chiba, Saitama, Ibaraki, Tochigi, Gunma, Yamanashi, Nagano,
Toyama, Ishikawa, Fukui Customer Assistance @0088-240-113
o ) ) General Information @0088-241-157
Aichi, Gifu, Mie, Shizuoka
Customer Assistance @0088-241-113
General Information @0088-242-157
Osaka, Hyogo, Kyoto, Nara, Shiga, Wakayama
Customer Assistance @0088-242-113
Hiroshima, Okayama, Yamaguchi, Tottori, Shimane, Tokushima, Kagawa, Ehime, General Information ®0088-250-157
Kochi, Fukuoka, Saga, Nagasaki, Oita, Kumamoto, Miyazaki, Kagoshima, Okinawa Customer Assistance @®0088-250-113




SoftBank 922SH Instruction Guide

May 2008, First Edition
SOFTBANK MOBILE Corp.

For additional information, please visit a SoftBank Shop.

Model: SoftBank 922SH
Manufacturer: SHARP CORPORATION

Please help the mobile industry maintain high environmental standards. Recycle your old
handsets, batteries and charger units (all manufacturers and brands). Before you recycle,
please remember these important points:
AL U Dl R T=0 ® Handsets, batteries and chargers submitted for recycling cannot b_e returned. ‘
BRREPHSOUS(2LITEE, ® Always erase all data recorded on old handsets (Phone Book entries, call records, mail, etc.) before
recycling.

i Mind your mobile manners when carrying a handset.
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